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1. Welcome 

The WhatCounts email publishing platform enables the rapid creation, deployment and 
measurement of personalized, targeted email.  WhatCounts is a web-based platform and 
was designed for ease of learning and use. 

This document was created to help train you in using the WhatCounts system.  It is 
broken down into the following sections: 

Lists In this section you’ll learn how to create and maintain lists 
of subscribers. 

Content Templates enable flexible content management and in this 
section you’ll learn how to create, edit, and use them. 

Subscribers Although you’ll learn a little bit about them in the “Lists” 
section, here you’ll learn how to import subscribers into the 
system, edit subscriber records, and even examine events 
associated with subscribers.  You’ll also learn how to export 
subscribers out of the system. 

Running and Testing 
Lists 

This section is designed to help you learn how to thoroughly 
test and launch a campaign using WhatCounts. 

Advanced Features Advanced features of the product include the ability to track 
open rates and click-through activity, create custom fields 
for your subscribers, segment your lists based upon special 
conditions you specify, and schedule the deployment of 
campaigns automatically. 

Throughout this guide you will find descriptions and step-by-step instructions designed 
to teach you how to use the specific features of the WhatCounts platform. 
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2. Lists 

Lists are collections of one or more subscribers.  Suppose your company maintained a 
list of all its customers and wanted to send them monthly newsletters.  With the 
WhatCounts platform you can create a list called “Customer Newsletter” and associate 
the email addresses of all your customers (or subscribers) to this list. 

A Super List is a collection of lists.  The Super List includes the separate list properties 
and subscribers for each list.  This allows you to run one large campaign to a wider 
audience without the necessity of running each list separately.   

The features discussed in this section can be reached through the Lists dropdown menu.   

 
Figure 1: Lists menu 

Creating a List 

List creation and editing is managed through a simple tabbed interface.  The tabs to 
manage list properties include: 

• Name & Addressing 

• Formatting 

• Options 

• Tracking 

• Advanced 

To create a new list, go to Lists > Management > Create New List.  Enter a List 
Name and set the List Type to Normal, then click Create. 

To edit an existing list, go to Lists > Management > View Lists and select a list to 
view. 
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Name & Addressing 

The Name & Addressing tab allows you to specify the addresses, template, and 
description you want associated with the list.  When you update the information on this 
screen you will receive a warning if you do not have a template associated with your list.  
This warning can be safely ignored. 

Name Give your list a name that will make it easy to identify 
according to use.  For a list of customers you might 
name it “Customers”. 

Template Templates hold the content of your email messages.  
This listbox allows you to associate one with your list. 

From Address How do you want your messages to appear to your 
recipients?  The “from” address determines what they 
will see in the inbox. 

WhatCounts supports a format which allows you to 
specify a decorative (display) version as well as the 
actual email address. 

For example, if you want your customers to see your 
messages appearing to come from “MyMail” you might 
enter a value similar to: 

“MyMail” <info@siteurl.com> 

Note: The display portion must be in quotes with the 
actual email address enclosed in angle brackets. 

Reply-To Address This field works exactly like the “from” address field.  It 
is designed to allow you to specify where messages will 
go should your recipients (or their mail servers) decide 
to reply. 

Bounce Address A bounce mailbox can be inserted into this field to 
automate processing email that cannot be delivered.  If 
you have a bounce address for your realm, enter it here. 

Description Just like the “name” field, the description allows you to 
identify the purpose of the list.  This is an optional field, 
but is useful if you have multiple people in your 
organization using WhatCounts. 

Admin Email Is there someone in your organization responsible for 
administering your email systems and software?  If so, 
use this optional field to specify their address.  

If another email address is not specified, the “Admin 
Email” is also used as the “from” address for 
cancellation and subscription request completion notices 
sent to subscribers. 

Folder Select to which Folder the List is assigned. 

Groups Select to which Group or Groups the List belongs. 
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Some customers opt to use the bounce address as the Reply-To and From Addresses as 
well.  This is based on your preferences.  When a bounce mailbox is created, a customer 
service email address will also be setup for that box with an email address that you have 
supplied.  Any replies received at the bounce address that are not identified by the 
bounce server will be forwarded to the customer service email address.   

For example, when a subscriber replies to the email with “Unsubscribe” or “Out of 
Office”, the bounce engine will track and discard those messages automatically.  Any 
other valid replies will be forwarded to the customer service address.  

An example of using the bounce address for all three address fields would look 
something like the following: 

 
Figure 2: Using the Bounce Mailbox address as the Reply To address 

Formatting 

The Formatting tab allows you to activate format “sniffing”, select whether AOL 
recipients will receive special content, and enable wrapping for your content. 

Automatically create a 
merged HTML/Plain-text 
(multipart) message 

Multipart messages contain both plain-text and HTML.  
They are useful to send when you are not sure the 
recipient’s mail client can display HTML.  If HTML cannot 
be displayed, the plain-text content you have prepared 
will appear instead.  Of course, your recipients will only 
receive one email. 
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Force the use of the AOL 
template for AOL.com 
subscribers 

This option was initially created for AOL versions 4.0 
and 5.0.  Those versions of AOL could render very little 
HTML.  At that time, it was necessary to prepare special 
content for AOL users.  This is less necessary now as all 
versions of AOL since 6.0 are fully capable of rendering 
the same HTML as other email clients like Outlook.   

If, for some reason, you wanted to send special content 
only to AOL users, select this box.  Doing so tells 
WhatCounts to deliver the AOL version of your template 
to all AOL.com subscribers on your list. 

If you have not prepared special AOL content and have 
this box checked, your plain-text content will be sent to 
anyone on your list with an AOL.com email address. 

Automatically wrap 
plain-text and AOL 
content 

Plain-text email can look awkward if the lines within the 
message do not have breaks in them. 

Enabling this feature tells WhatCounts to automatically 
wrap your plain-text content at approximately the 65 
character length. 

Wrapping only takes place on word boundaries. 

Automatically wrap 
HTML (removes 
unnecessary spaces) 

Enabling this feature will wrap HTML content.  Although 
you will not be able to visually detect any difference, the 
size of your email message may become smaller thanks 
to wrapping.  Because HTML often contains extra white 
space, the wrap HTML feature attempts to remove this 
extra information without effecting how the content is 
viewed. 

Options 

WhatCounts makes operating confirmed (double) opt-in lists easy and the options tab 
lets you specify whether your list will require subscribers to confirm their sign-ups and 
cancellations.  This is also the place where you will specify landing pages for when 
people run your sign-up forms.  Creating these forms will be discussed later in this 
document. 

Customer Confirmations 

For each Customer Confirmation option, you can also control the template sent to your 
subscribers, the from address, and the format of the message (plain-text, HTML, or 
Multipart MIME).  If you do not make any selections, a plain-text WhatCounts default 
confirmation message will be sent. 

Require list cancel 
requests to be confirmed 

Similar to confirming sign-ups, you have the option of 
requesting users to confirm their intentions to cancel 
their subscription to your list. 
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Require list sign-ups to 
be confirmed 

A double opt-in list is one in which a positive 
confirmation is required before subscribers can join your 
list.  Enabling this all but guarantees that the email 
addresses assigned to your list will be legitimate. 

Double opt-in lists are also a sign of permission oriented 
email.  They remove most of the obstacles facing email 
publishers when challenged with proving They are not 
spamming people with unwanted email. 

Courtesy Email 

As with Confirmations, you can control the template, from address, and format of the 
Courtesy message. 

Send for new sign-ups After someone confirms their intention to join a list, you 
can have a mail message automatically sent to them.  It 
is an opportunity for you to send them a “thank you” 
message or present an “up-sell” opportunity.  If you are 
publishing a series of content pieces it might be where 
you send them their first installment. 

To send your own content, select one of your templates 
from the drop-down list. 

If you do not have special content prepared but want to 
send subscribers a confirmation of joining your list, you 
can have the WhatCounts platform automatically 
generate a “thank you” message by selecting “Auto 
Generated” from the drop-down. 

Send after cancellation This feature behaves just like the previous one, but is 
triggered when subscribers leave your list.  This is a 
perfect opportunity for you to communicate one last 
time with your recipients.  It might even be a chance for 
you to push one additional “up-sell” opportunity in front 
of them or attempt to have them sign-up again. 

External Links 

After pressing a sign-up 
link 

When subscribers fill out subscriptions forms that add 
them to your list, you can specify a web page where 
they will be directed after submitting their information.  
This is called a Landing Page.  Enter a fully qualified 
URL of the page where you would like users to be sent.  
If you leave this field blank, a default WhatCounts page 
will be generated automatically. 

After pressing a cancel 
link 

This behaves just like the previous field, but is 
designed to direct users to a landing page after they 
have cancelled their subscription.  Enter a fully 
qualified URL of the page where you would like users 
sent. 



WhatCounts User Manual 

 - 7 - 

Copyright © 2005 WhatCounts, Inc..  his document contains proprietary information that constitutes trade secrets and is not to be shared, copied, 
disclosed, or otherwise compromised without the prior written consent of the management of WhatCounts, Inc. 

Tracking 

Tracking is important because it gives you the chance to see how your list is performing.  
Are you interested in knowing how many people are opening your HTML messages, or 
what links within your messages are being clicked on?  If so, you will want to enable 
these tracking features. 

Note: Both tracking options are enabled by default when a new 
list is created. 

Track when HTML 
readers open email 

This checkbox inserts a special tracking tag into your 
HTML content.  The number of people opening your 
message can then be recorded. 

Note: Outlook’s preview pane will cause the tracking tag 
to be activated just as it would if the message were 
actually opened. 

Track click-throughs This checkbox tells WhatCounts to replace all links 
within your content with special WhatCounts links.  
These links allow us to track the number of times each 
link in your email is selected.  All links go to servers at 
WhatCounts where the information is recorded.  Users 
are then redirected to the locations you originally 
intended them to visit.  This process is invisible to 
users. 

Although opens can only be tracked in HTML, click-throughs are tracked in all formats. 

Advanced 

Advanced list features are discussed here because you will inevitably be exposed to this 
part of the platform’s interface.  However, these features should not be used until you 
are extremely familiar with the platform and understand all of the features related to 
tracking, scheduled publishing, custom fields, and campaigns. 

Base URL When your list is sent with tracking enabled, all links are 
replaced with ones that carry the whatcounts.com 
domain name.  Since links are hidden in HTML, the only 
time the WhatCounts domain would be readily visible to 
users would be in plain-text. 

If a Base URL has been defined in your Realm 
properties, you can set it for your list by selecting it 
from this field.  This allows all tracking links in your 
messages to carry your company’s domain-name 
branding. 
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Your organization can setup a DNS host alias to the 
WhatCounts tracking system (such as 
tracking.<yourcompanysite>.com).  Your Realm 
administrator can add the Base URL to your Realm 
properties by going to ADMIN > VIEW CUSTOMERS 
and adding the alias to the Base URLs text area. 

For more information on this feature, please see the 
Online Help topic entitled “DNS:  Configuring your DNS 
to point to the WhatCounts servers.”  This topic can be 
accessed by logging into WhatCounts and going to 
CUSTOMER CENTER > ONLINE HELP. 

Forward-to-a-Friend 
(FTAF) 

Customize the FTAF feature to match the “look and feel” 
of your email.  Create html pages for any or all of the 
following aspects of FTAF, and then enter the URL of 
those pages here. 

For more information on this feature, please see the 
Online Help topic entitled “FTAF: Forward to a Friend.”  
For more information, see Content: Forward to a Friend. 

Blogs If you have a blog defined for your Realm, you can 
publish your campaign directly to your blog at the same 
time you are publishing to your subscribers. 

To send a copy of your email message to your blog, 
select the Blogs checkbox and select which blog you 
would like to publish to from the Publish into blog list 
box.  You can also select to use a template other than 
the default template defined in your Blog properties 
from the Use Template list box.   

De-dupe Control The De-dupe on send checkbox allows you to send the 
campaign to only one version of an email address per 
list.   

In general, when you import subscribers, duplicates will 
not be created unless you have set the import to create 
duplicates on purpose and each instance of the email 
address has a different first name.  For example, you 
may have several subscription records where the email 
address is the same but the first name is different, such 
as the case with a family email address: 

- myfamily@family.com, Mom 

- myfamily@family.com, Dad 

- myfamily@family.com, Child 

The De-dupe option allows you to send a message to 
the first subscriber with the duplicated email address so 
only one version of your message will be received at the 
subscribers’ mailbox. 

This option is set on a per list basis, and can be changed 
between campaigns. 
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Workflow If the “Approval is required before sending” box is 
checked, one individual in the given list of email 
addresses must approve the email before it is sent out.  
You can also select the format in which you would like 
the Workflow message sent:  HTML, Multipart MIME, or 
plain-text. 

This feature is especially beneficial when content is 
being pulled from an outside source and needs to have a 
final approval before it is sent to an entire list.   

Sticky Campaigns Every time your list is run, a campaign is created and 
tracking information is associated with that newly 
created campaign.  If you want to keep tracking 
information related to your list activity using one 
campaign, mark this checkbox.  This feature is useful for 
lists that publish the same content regularly using a 
schedule. 

Set Data Use these fields to set or increment a numeric value 
associated with each subscriber sent an email when this 
list is run.  The drop-down list of custom fields will only 
show numeric fields. 

Creating a Super List 

Before you create a Super List, you must first have at least one normal List created.  To 
create a new Super List: 

1. Go to Lists > Management > Create New List. 

2. Enter a List Name and set the List Type to Group, then click Create to display 
the Edit Super List page. 

 
Figure 3: Edit Super List page 
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3. In the Edit Super List page, fill out the form fields: 

a. Name:  Enter a descriptive name for the Super List.  You may wish to add 
some type of information to the name to differentiate it from normal Lists.  
For instance, you may precede the Super List name with the text “super_” 

b. Template:  Select the template that contains the content you wish to send to 
every list’s subscribers. 

c. Description: Just like the Name field, the description allows you to identify 
the purpose of the list.  This is an optional field, but is useful if you have 
multiple Super Lists that contain the same Lists. 

d. Admin Email:  Enter an optional email address for a list administrator.  If 
another email address is not specified, the “Admin Email” is also used as the 
“From” address for cancellation and subscription request completion notices. 

e. Folder: Select a folder if you would like to assign the Super List to a one. 

f. Groups: Select a group if you would like to assign the Super List to a one. 

4. To add a List to the Super List: 

a. Select a list from the Available Lists. 

b.  Click the double arrow button  to move the list to the Member Lists. 

5. To remove a List from the Super List: 

a. Select a list from the Member Lists. 

b. Click the double arrow button  to move the list to the Available Lists. 

6. Click Create to save your work. 

To edit an existing list, go to Lists > Management > View Lists and select a list to 
view. 
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Creating HTML Sign-up Forms 

Now that you have a list set up, how do you get subscribers into it?  Importing is one 
approach.  Another is to have a subscription form your potential recipients will fill out 
using their web browser. 

 
Figure 4: Creating Forms using the HTML Wizard 

WhatCounts has an HTML wizard that will create a subscription form for your list 
automatically.  Select “Create Forms (HTML Wizard)” from the Lists drop-down, select 
the name of the list for which you’d like to generate a form, and then click on the HTML 
Wizard button. 

To create a subscription form, select Subscription Form from the Generate drop-
down. 

If you’d like your recipients to receive your content in HTML select the radio button 
labeled HTML.  If you’d like to give them a choice between plain-text and HTML, mark 
the checkbox labeled Show Plain-text and HTML choices. 

After a user submits their information you can have them directed to a landing page of 
your choice by entering a URL (including http ://) in the “Goto URL” text box.  This 
value overrides the one set on the Options tab in List. 
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When you press the “Continue” button, you’ll be able to select Subscriber Data and 
Custom Data to include in your form.  Although these are not required fields (unless you 
add script to make them so) keep in mind that people are more likely to fill out a form if 
it does not require a lot of personal information. 

Pressing the “Continue” button again will bring you to a screen containing the HTML that 
represents your new subscription form. 

Here’s how you can test your new form: 

1. Create a new file with an *.html extension in notepad or a similar utility, or copy 
the code into an existing HTML document. 

2. Open the page containing the form HTML in your browser. 

3. Fill out the form.  When you click SUBSCRIBE, you will be redirected to the page 
you entered in Goto URL.  (If you did not enter a Goto URL, you’ll be sent to the 
URL entered on the Options tab of your List, or the default WhatCounts landing 
page.) 

4. Visit the View Lists page in WhatCounts.  If your list doesn’t require confirmations 
you should see a new subscriber.  If the “Require list sign-ups to be confirmed” 
option was checked in Edit List, look for an email message asking for your 
confirmation.  Once you confirm you should see a new subscriber on your list. 

If your list is brand new and you’re testing the subscription form created by the wizard, 
you should see the number or count of subscribers increase as you add new names 
through the form.  The exception to this rule is that if your list requires confirmations, 
you will not see changes in the number of subscribers until your subscribers-to-be 
confirm their intentions. 

More advanced form techniques, like multiple list subscription forms, can be found in the 
Online Help library which can be reached through the Customer Center drop-down of 
WhatCounts. 
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3. Content 

While Lists keep track of who’ll be receiving your messages, Content keeps track of what 
will be delivered.  WhatCounts has a flexible template system that allows you to create 
as many different templates as you like.  Each one can contain formatting for plain-text, 
HTML and AOL content. 

Creating templates starts in the Content menu. 

 
Figure 5: Content menu 

Creating a New Template 

To create a Template, you must enter a subject for the resulting email message as well 
as the content to be sent.  The Edit/Create Template page allows you to name a 
Template and define the content.  It also provides some advanced settings to enhance 
the formatting and manage the Template. 

To create a new Template: 

1. Go to Content > Templates > Create New Template.  This will display the 
Edit/Create Template page. 

2. In the Edit/Create Template page, you can type, paste, or import content.  To 
create the Template, fill out the form fields. 
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Figure 6: Edit/Create Template page 

5. Enter a descriptive Name for your template.  This will not be seen by email 
recipients, but it is useful to differentiate one template from another. 

6. Enter a Subject to appear as the subject of the email message delivered to 
recipients. 

7. Move your cursor to the Template field and begin typing plain-text content. 

8. To enter HTML content, press the HTML button.  That button will now have an 
outline around it to indicate that it is selected.  Enter some HTML content for your 
message. 

9. If you would like to enter AOL specific content, select the AOL button.  For 
information about formatting email especially for AOL, visit: 
http://postmaster.info.aol.com 

10. Click the Create button to save your work. 

Advanced settings and controls: 

Content is UTF-8   
Optional charset 
designation 

Unicode formatting used if you are creating templates in 
languages other than English. 

Wrap text (for editing 
only) 

Check this box to wrap the text in your template 
window to the visible space.  This will not alter your 
template at all and is simply for viewing. 

Content Encoding Select a type of content encoding for formatting in 
languages other than English and UTF-8. 

Let child realms use this 
template 

Select this option if you have created a template in a 
parent realm, and you would like the template to be 
accessible in your child realms. 
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Importing Content 

If you have content already created in a .txt or HTML file, use the Template Import tool 

by clicking Import .  This will display the Template Import dialog. 

To import content from the web: 

1. Select the URL option. 

2. Enter in a fully qualified URL in the URL textbox.  For example:  
http://www.domain.com/file.html. 

3. If your HTML document contains relative URLs, select Fix relative URLs.  The 
WhatCounts import engine will attempt to replace any relative URLs in your 
document with fully qualified URLs.   

4. Select a formatting option beneath Import into.  For example, if you are 
importing HTML, select HTML. 

5. Click Import to import the contents of the file into the Template textbox for the 
Template.  You can also click Cancel to cancel the import and return to the 
Template. 

Note:  Relative URLs are shortened and do not contain either full 
folder or protocol information, such as 
../images/wc_logo_fp.gif.  A fully qualified URL contains 
complete folder and protocol information, such as 
http://www.siteurl.com/images/wc_logo_fp.gif.  Fully 
qualified URLs are necessary to insure that all images are 
properly displayed in your HTML email. 

To import content from your own computer, follow the same steps as above except 
select the File option instead.  Then press the Browse button to search for and select 
your file. 

Creating Content with the WYSIWYG Editor 

For those who are not familiar with HTML, WhatCounts has integrated WYSIWYG (What 
You See Is What You Get) editing functionality.  This will enable you to design and 
format your emails visually, and the simple interface requires no knowledge of HTML. 
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Figure 7: Edit/Create Template page with WYSIWYG editor enabled 

Accessing the Editor 

WYSIWYG can be enabled at any time while you are editing a template by clicking on the 
WYSIWYG icon in the Edit/Create Template page.   

 
A green checkmark on the button indicates that WYSIWYG is currently 
disabled.  Click this button to enable WYSIWYG to edit the current template. 

 

 

A red X on the button indicates that WYSIWYG is currently enabled.  Click 
this button to disable WYSIWYG for the current template only. 

If you prefer to have WYSIWYG always enabled, set this in your WhatCounts user 
profile.  To do this, go to Customer Center > My Profile and select Enable advanced 
WYSIWYG template editor.  Click Update to save the change.   
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Using the Editor 

To use the WYSIWYG editor, open or create a new template.  The Edit/Create 
Template page will display, and the Plain-Text button will be selected.  To view the 
WYSIWYG editor, click the HTML button and wait for the Java applet to load. 

 

Figure 8: The WYSIWYG editor 

Note: The WYSIWYG Editor requires Java support in your browser.  
If a Security Warning appears, click Yes or Always to 
enable the Java applet. 

When the editor loads, the WYSIWYG tab will be selected.  You can begin entering your 
content into the area provided.  Using the buttons at the top, you can add bullets and 
tables to your email, as well as change the appearance and format of the text.   

The WYSWYG Editor allows you to perform the following actions on the content: 

Action Button Description 

Copy 
 

Use to copy text.  Same as CTRL + C.  

Cut 
 

Use to cut text.  Same as CTRL + X. 

Paste 
 

Use with the copy and cut functionality to paste text.  
Same as CTRL + V. 

Insert List 
 

Use to insert bullet points into the template. 
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Increase 
Indent  

Use to indent text. 

Decrease 
Indent  

Use to decrease any indents. 

Undo 
 

Use to undo the last action.  Click again to undo the 
action before that. 

Redo  Use to redo the last undo action.  Click again to redo the 
action before that. 

Insert 
Horizontal 
Rule 

 Use to insert a horizontal line. 

Insert Table 
 

Use to insert a table by specifying the desired  table 
properties. 

Load Images 
 

Use to insert an image 

Insert Link 
 

Use to insert a link by typing in the text you want 
hyperlinked and the URL the link should go to. 

Bold  Use to bold or un-bold text.  Same as CTRL + B. 

Underline  Use to underline or un-underline text. Same as CTRL + U. 

Italicize  Use to italicize or un-italicize text.  Same as CTRL + I. 

Foreground 
Color  

Use to change the color of a highlighted portion of text. 

Align Left 
 

Use to align text to the left. 

Align Center 
 

Use to align text to the center. 

Align Right 
 

Use to align text to the right. 

Font Type 

 

Select the type of font to use for the content.  Select 
from Arial, Sans Serif, Serif, Times New Roman, or 
Verdana. 

Font Size 

 

Select the size of the font to use.  Select from 8, 9, 10, 
11, 12, 14, 16, 18, 20, 22, 24, 26, or 28. 

As you add content and objects, the HTML code will automatically be generated by the 
editor.  You can view and modify the code by clicking the Code tab. 

Note:  Tables and bullets cannot be cut or copied.  Only the text in 
the tables or next to the bullets will be cut or copied. 
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Inserting Links 

To insert a hyperlink into your content, click the Insert Link  button.  An Insert 
Link dialog box will display.   

 
Figure 9: Inserting a Hyperlink with the WYSIWYG editor 

Enter the text you would like to hyperlink in the Text field.  Enter the URL in the Link 
field.  Click Insert to insert the hyperlinked text or Cancel to close the dialog box.   

To hyperlink an email address, precede the email address in the Link field with the 
command “mailto:”.  For example: mailto:support@siteurl.com. 

Note:  If you do not see the Insert Link button, click on the 
dotted line to the left of the Copy button and drag it away 
from the template window.  This will detach the toolbar so 
all the buttons will be available.  Click the red X in the upper 
right corner will reattach the toolbar to the editor. 

Inserting Tables 

To insert a table into your content, click the Insert Table  button.  An Insert Table 
dialog box will display with tabs to define the table and cell sizes, set border and 
background colors, and preview the table.   

Enter your desired settings, and then click the Preview tab to view your table before 
inserting it into your content. 

Note:  Border color may not be visible in the Preview tab or 
WYSIWYG editor.  Click the Preview button to see your 
exact table.  Keep in mind that the template must be saved 
before using Preview. 
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Figure 10: Inserting a Table with the WYSIWYG editor 

Click Insert to insert the table, or click Cancel to close the dialog box without adding 
the table to your content. 

You can set the following information in the Insert Table dialog box: 

Tab Option Description 

Rows Define the number of rows to insert. 

Columns Define the number of columns to insert. 

Cell spacing Define the distance between the cells. 

Table 

Cell padding Define the distance between the content and the wall of 
a cell. 

Border width Define the width of the table border. 

Table width Define the width of the table. 

Table height Define the height of the table. 

Size 

Units Define whether the table measurements should be in 
pixels or percent. 

Border Select the color of the table border. Color 

Background Select the color of the table background. 

Creating Content as Wire-Frames 

Wire-frame templates allow you to create a generic template containing customizable 
fields that can be defined at “run-time”.  In other words, you will be prompted to define 
the customizable parts of your template when you run your list.  This can be ideal if you 
are sending the same email to different cities for an event, but want to include each 
city’s unique information in that email.   
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Wire-frame templates use tags that use the following format, where <details> is a fillin 
field that you have defined: 

%%fillin “details”%% 

For example, using the following tag in your template would prompt you to enter a city 
name when you run the list: 

%%fillin “city”%% 

When the template is run you will be asked a value for city. 

 
Figure 11: Prompt to define Wire-Frame fillin fields 

Note:  Wire-frame templates and fillin fields can only be used with 
the Run Wizard.  It will not work with Run List (Deploy 
Campaign). 

The following attributes can also be used in the template tag to define how the fillin will 
be prompted: 

Attribute Description 

type Displays the fillin selection/or entry.  Options include: 

Text (default) 
TextArea 
Radio 
Checkbox 
Listbox 

default_value Displays the default option selected when using a radio, 
checkbox, or listbox type. 

values Displays the values for radio, checkbox, or listbox types.  
These values must be comma separated. 

selected_index Helps determine the default value selection. 

For example, the following tag defines the field name as “state” and will display several 
radio buttons with values of “CA”, “WA” and “OR”, with the default radio button on “CA”: 

%%fillin “name=state&type=radio&values=CA,WA,OR&default_value=CA”%% 
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Reviewing URLs 

WhatCounts will detect the URLs included in your content to perform real-time click-
through tracking.  To review the URLs within your content, click the View URLs icon or 
link.  This will display a list of the fully qualified URLs found in the Template.   

Each URL includes columns to indicate in what format the URL was found and if the URL 
will be excluded from tracking.  A green check  icon will appear in the Plain, HTML, 
AOL and WAP columns to indicate the formats, and a red X  icon will appear in the 
Exclude column if the URL will not be tracked because of a Tracking Exclusion setting.  
Click the View All Exclusions link to see a list of all tracking exclusions. 

Excluding URLs from Tracking 

If click-through tracking is enabled, WhatCounts will automatically track all the URLs it 
encounters in your content.  To exclude one or more URLs from tracking you can view 
your URLs through the template editor and then select them individually. 

To exclude a URL: 

1. Select Content > Templates > View. 

2. Select the template you want to use. 

3. Click View URLs. 

4. Select the URL you would like to exclude.  This will display the URL Excludes 
page.  This page shows content associated with the specified link.  Links that 
point to pages containing frames will not be displayed. 

5. To exclude the specified URL, click Exclude this URL located near the upper 
right-hand corner of the page.  This will return you to the URLs list and your 
selected URL will show a  icon in the Exclude column.   

To re-enable the link, select the URL again and then click Remove this exclusion. 

You can also view or add to the list of excluded URLs by selecting Content > 
Templates > Tracking Exclusions. 

Excluding URLs from tracking may be helpful or necessary if the URL contains 
personalized information unique to each recipient.  For example, a link to an unsubscribe 
resource managed by your own company.  Another reason to exclude tracking for a URL 
is if want your link to be displayed as is.  For example, http://www.yahoo.com instead of 
http://whatcounts.com/t?ctl=39D9AB:83EE7B 
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Reviewing Tags 

WhatCounts provides special tags to allow personalization of content when the email 
message is sent.  To review the Tags within your content, click the View Tags icon or 
link.  This will display a list of the Tags found in the Template.  Each Tag includes 
columns to indicate in what format the Tag was found.  A green check  icon will 
appear in the Plain, HTML, AOL and WAP columns to indicate the formats in which the 
Tag was found. 

Analyzing Content 

You can help prevent your messages from being targeted as spam by running a content 
analysis when you create or update your template.  This will review the content of your 
proposed email against a list of commonly filtered terms. 

To run the content analysis: 

1. Create and save a template. 

2. Preview the template either from the Template list or from the Edit/Create 
Template page. 

3. In the Template Preview page, click the Content Analysis link.  

4. Choose the type of content you would like to analyze (Plain Text, HTML, AOL).  

5. Select the List and Template. 

6. Select the Timeout threshold.  This will allow the analysis to stop if it takes too 
much time. 

7. Click Scan Message to analyze the content. 

You can also run the Content Analysis by going to Content > Templates > Content 
Analysis. 

When the analysis is complete, the results page will display the name of the list and 
template, the format of the content, a preview of the message, and the result of the 
analysis.   
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Figure 12: Content Analysis results 

The Result will display a summary of whether or not the message will pass most 
content filters.  The Score is how the content rates against a common filter.  Each item 
that the filter finds adds to the score.  A lower score means the content is less likely to 
be caught by a spam filter.  A score of 5.0 or above means it is highly likely that the 
content will be marked as spam.  Most messages average 2.5 in the Content Analysis 
score.   

The Analysis will detail what items in the message are likely to be caught.  HTML 
messages are more likely to score higher than plain-text, especially when there are 
hyperlinks with words such as 'click here', the entire message is made up of only 
images, or a large amount of text is in all caps.  The analysis will point out things that 
you can change in order to lower the spam score. 

Previewing Content 

To get a preliminary feel for how the content will look, use Preview to view your 
content.  The preview of the content will be displayed in a new browser window.   

 
Figure 13: Template Preview page 
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The preview window provides links to view the Plain-Text, HTML, and AOL content, as 
well as an option to analyze the content for items that may be caught by SPAM filters.  
For more information about the Content Analysis link, see Advanced Content 
Management: Content Analysis. 

Although it will render a good approximation, the browser will not behave exactly like an 
email client.  Make sure you thoroughly test your content before deploying any 
campaign.  Also keep in mind that the preview is rendered by your Internet browser and 
will not be an exact representation of how it may look through various email clients. 

If you have created or made changes to a template, you must first save your template 
by clicking Create or Update for the preview to reflect these changes. 

To preview the current content from the Edit/Create Template page, click the 
Preview button.  

To preview the content from the Templates list, go to Content > Templates > View, 
and then click the preview icon next to the Template in the list. 

Personalization 

Content inside WhatCounts templates can be personalized using special replacement 
tags.  For example, if you would like to display a subscriber’s first name, insert the tag 
%%$first%% where you’d like their name to appear. 

All tags in WhatCounts start with “%%” and end in “%%”.  Field names, such as “first” also 
start with a dollar sign.  If you had a custom field with the name “age” you could insert 
it into your content by placing the tag “%%$age%%” anywhere you wanted that information 
displayed. 

For a full listing of tags that can be used in a template, please see Appendix A at the end 
of this document. 

Simple Logic 

The WhatCounts template language also supports a simple logic control system.  With it 
you can evaluate your template data.  For example, suppose you wanted to print out a 
message within your content whenever a recipient’s state is Washington.  You might add 
the following to your template: 

%%if state = “WA” then print “Hello to our Washington neighbors.”%% 
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You can also include an “else” clause.  For example: 

%%if state = “WA” then print “Hello Washington neighbor” else print 
“Hello”%% 

You can also use simple logic to print an alternate field if one is empty for a certain 
subscriber.  For example: 

%%if first != “” then printdata first else printdata email%% 

Note: If you are printing a field, such as “email”, use “printdata” 
in your logic.  If you are just printing alternate text, such as 
“Hello friend”, use “print.” 

Special URL Encoding 

Click-through tracking of URLs is usually completely automatic with WhatCounts.  
However, there are some URLs that might not be properly detected within your plain-
text content.  For these you'll want to perform some special URL encoding, which is 
described below.  

Unlike HTML, URLs in plain-text are not encapsulated by <a href> and </a> tags.  
Because of the lack of well-defined separators, the WhatCounts URL parser queues off 
characters like the comma and semi-colon in plain-text.  These are characters you would 
fully expect to see following a URL when mixed within normal sentences.  

Since there could be a problem if your plain-text URLs contain these characters, we 
recommend the replacement of certain characters within your plain-text URLs.  Here's a 
table of some common characters and their HEXADECIMAL equivalents.  

Character HEX 

space   %20 

ampersand & %26 

plus + %2B 

comma , %2C 

period . %2E 

forward slash / %2F 

colon : %3A 

semi-colon ; %3B 

question ? %3F 
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Replacing characters like commas and semi-colons in your URLs is easy.  For example:  

http://www.siteurl.com?page=,4&flag=1  

becomes  

http://www.siteurl.com?page=%2C4&flag=1  

Web browsers and servers all know how to translate these characters, so it's safe to use 
HEX equivalent codes anywhere you like.  

FTAF:  Forward to a Friend 

Recipients of your HTML email can forward the message onto colleagues and friends with 
the "Forward To A Friend" (FTAF) feature.  Forwarding email through this mechanism 
has several advantages over regular email forwarding including: 

• Easy to use  

• Not affected by background image or color settings in the original email  

• Custom messages or subscription forms can be added  

• Forms and landing pages can be branded 

• Viral activity can be tracked 

Using FTAF 

The FTAF feature has several options.  However, to experiment with it in its simplest 
form, include a tag, like the one below, in your HTML content: 

<a href= 
"http://whatcounts.com/bin/ftaf?id=%%SUBSCRIBER_ID_TAG%%">FTAF</a> 

Replace the word "FTAF" above with your own message like "Forward to a friend" or 
"Email this to a friend."  You can also use an image. 

Note: If your organization has already established a DNS alias 
that points to the WhatCounts servers for link tracking, you 
can substitute your base URL in for "whatcounts.com". 
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Branding FTAF 

If you would prefer not to use the WhatCounts branded pages for FTAF, everything can 
be customized to have the "look and feel" of your organization. 

Custom Form 

The FTAF Form is the first step in the Forward to a Friend process.  This form can be 
included in the email, or on an external page that is accessed via a link in your message. 

In order to forward a campaign message, only the email address of the friend is 
required.  However, your form can be much more complex -- including information like 
the friend's first name, last name, or a personal message from the subscriber. 

The following input fields are required in your Custom Form code: 

Field 
Name 

Type Required Value Function 

id hidden %%SUBSCRIBER_ID_TAG%% Automatically generates the ID of the 
original subscriber, allowing us to track 
who forwarded your message. 

goto hidden %%GOTO%% The landing page the subscriber will see 
after the form has been submitted. 

email text  The email address of the friend who will 
receive the message. 

 

Custom Forms also support the following optional fields: 

Field 
Name 

Type Req’d 
Value 

Function 

subject text or 
hidden 

 The subject of the forwarded message.  If not included, 
the subject line of the original message will be used. 

message 

 

text or 
textarea 

 Allows inclusion of a message from the subscriber to the 
friend. 

email_# text  Where # is a number from 1 to 32 when forwarding to 
multiple friends. 

first 

 

text  The first name of the friend which can be used for 
personalization. 

last 

 

text  The last name of the friend which can be used for 
personalization. 

multi hidden 1 Used to enable forwarding to multiple friends. 
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Example Code for one Friend:  

Following is code that can be used to forward a campaign message to one address: 

<form action="http://whatcounts.com/bin/ftaf" method="post">  

<input type="hidden" name="cmd" value="send">  

<input type="hidden" name="id" value="%%SUBSCRIBER_ID_TAG%%">  

<input type="hidden" name="goto" value="%%GOTO%%"> 

<table> 

 <tr> 

  <td>Subject:</td> 

  <td><input type="text" name="subject" size="30"  

value="A friend wanted you to see this"></td> 

 </tr> 

 <tr> 

  <td>Send to:</td> 

  <td><input type="text" name="email" size="30"></td> 

 </tr> 

 <tr> 

  <td valign="top">Message:</td> 

  <td><textarea name="message" cols="30" rows="4"></textarea></td> 

 </tr> 

 <tr> 

  <td colspan="2" align="right"><input type="submit"  

name="submit" value="Send"></td> 

 </tr> 

</table> 

</form> 

 

 
Figure 14:  Custom FTAF form for a single recipient 
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Example Code for several Friends:  

The following code comprises an FTAF form that can be used to forward to multiple 
friends.  This code includes input for only two friends.  More of the following inputs can 
be added to create a form that can forward to a maximum of 32 friends. 

    <tr> 

      <td align="right">Friend #1: </td> 

      <td><input type="text" name="email_1"></td> 

      <td><input type="text" name="first_1"></td> 

    </tr> 

In order to add more inputs, simply increment the value after email_ and first_ and 
add that to your form code. 

<form action="http://whatcounts.com/bin/ftaf" method="post">  

  <input type="hidden" name="cmd" value="send">  

  <input type="hidden" name="id" value="%%SUBSCRIBER_ID_TAG%%">  

  <input type="hidden" name="goto" value="%%GOTO%%"> 

  <input type="hidden" name="multi_extended" value="1"> 

  <table border="0"> 

    <tr><td colspan="3">Forward your message to a Friend</td></tr> 

    <tr> 

      <td align="right">Subject:</td> 

      <td colspan="2"><input type="text" name="subject"  

value="A friend wanted you to see this" size="30"></td> 

    </tr> 

    <tr> 

   <td align="left">&nbsp;</td> 

      <td align="center">Email</td> 

      <td>First Name</td> 

    </tr> 

    <tr> 

      <td align="right">Friend #1: </td> 

      <td><input type="text" name="email_1"></td> 

      <td><input type="text" name="first_1"></td> 

    </tr> 

    <tr> 

      <td align="right">Friend #2: </td> 

      <td><input type="text" name="email_2"></td> 

      <td><input type="text" name="first_2"></td> 

    </tr> 

    <tr> 
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      <td valign="top">Message:</td> 

      <td colspan="2"> 

        <textarea name="message" cols="30" rows="4"></textarea> 

      </td> 

    </tr> 

    <tr> 

      <td colspan="3" align="right"> 

        <input type="submit" name="submit" value="Send"> 

      </td> 

    </tr> 

  </table> 

</form> 

 

 
Figure 15:  Custom FTAF form for a multiple recipients 

Envelope 

The Envelope is an HTML page into which the content of the original message is poured.  
The friend will receive the original campaign surrounded by this Envelope. 

In addition to controlling things like the background color, the Envelope is used to add a 
personal message from the subscriber to the friend.  Other information -- like a special 
offer or a subscription form -- can also be added to the Envelope. 

To add a subscription form to your envelope, you'll first need to go through the CREATE 
FORMS (HTML WIZARD) under the LISTS drop-down in WhatCounts.  Copy the 
subscription form code from the wizard into the HTML page you are using as your 
Envelope.  You may need to edit the code to fit in with the HTML used in your Envelope.  
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Note: If you will be using the code in email, change the method of 
the subscription form from "post" to "get".  

The Envelope requires at least the following tag: 

Tag Function 

%%BODY%% The body of the original message. 

The following optional tags can be used to personalize the message: 

Tag Function 

%%$message%% If included in your Custom Form, this tag will enable the 
subscriber to include a personal message to their friend. 

%%$first%% First name of the friend. 

%%$sender_first%% First name of the sender or subscriber. 

%%$sender_last%% Last name of the sender or subscriber. 

%%$sender_email%% Email address of the sender or subscriber. 

Wherever the %%BODY%% tag is placed in the Envelope is where the original HTML content 
(email) will appear.  Wherever %%$message%% appears in your Envelope is where the 
personal note designed to accompany the content will be displayed.  Make sure you 
have included a message input in your Custom Form to use it in your Envelope. 

The last three tags listed in the chart above are all taken from the subscriber's record.  
If you use something like %%$sender_first%% in your Envelope, you need to make sure 
that all of your subscriber records include a first name. If they don't, you may want to 
include some logic that will display alternate text in case the first name field in a 
subscriber record is blank.  For instance, instead of: 

"Your friend, %%$sender_first%%, thought you'd be interested in this." 

You may want to use:  

"Your friend, %%$sender_first%%%%if sender_first = "" then printdata 
sender_email%%, thought you'd be interested in this." 

The second example will use the email address of the original subscriber if his or her 
first name is not included in the subscriber record. 

Note: Although the code is split for purposes of formatting this 
document, logic statements must always be on the same 
line in your template or HTML file.  Make sure that the 
opening and closing percent signs (%%) in a logic statement 
are not on separate lines. 
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Example Code:  

In order to work, an envelope only has to contain is a %%BODY%% tag.  However, if that's 
all you were going to include, you wouldn't need to create a custom Envelope at all.  The 
default Envelope used by WhatCounts includes code to pull in the message from the 
subscriber to the friend as well as the content from the original campaign.  It looks 
something like this: 

<table> 

  <tr><td>%%$message%%</td></tr> 

</table>  

%%BODY%%  

An Envelope with a message and subscription form would look similar to this: 

<table> 

  <tr>  

    <td><p>%%$message%%</p></td>  

  </tr> 

  <tr>  

    <td><hr></td>  

  </tr> 

  <tr>  

    <td> 

   <p>Enter your email address and Subscribe!</p> 

   <form action="http://www.whatcounts.com/bin/listctrl" method="get"> 

     <input type=hidden name="slid" value="[INSERT SLID VALUE HERE]"> 

     <input type=hidden name="cmd" value="subscribe"> 

     <input type=hidden name="goto" value=""> 

     <p>E-Mail: <input type=text name=email size=25> 

        <input type=radio name=format value="plain">Plain-text 

        <input type=radio name=format value="html" CHECKED>HTML</p> 

     <input type=submit value="Subscribe"> 

   </form> 

    </td>  

  </tr> 

  <tr>  

    <td><hr></td>  

  </tr> 

</table> 

%%BODY%% 
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Forwarding Different Content Using the Envelope 

There may be situations in which you would like the content forwarded on to the friend 
to be different than the original campaign message the subscriber received.  One 
example would be if you had an FTAF link in an email to allow subscribers to tell their 
friends about a sweepstakes.  In order to send different content, simply leave the 
%%BODY%% tag out of your Envelope and enter in the HTML exactly as you would like the 
friend to see it. 

Landing Page 

After a recipient fills out the FTAF form, they're automatically directed to a confirmation 
page.  If you would like to display your own confirmation landing page, you can specify 
it by creating a simple HTML "thank you" page, and entering the URL in the "Landing 
Page" text box on the ADVANCED tab of your list.  No special code is necessary for this 
page.  

Example Code: 

An example FTAF Landing Page may display a message using the following code:   

<p>Thank You!  Your message had been forwarded to your friend!</p> 

Error Landing Page 

If an error occurs during the FTAF process, the subscriber will most likely be sent to an 
Error Landing page.  As with the regular landing page, no special code is necessary for 
this page.  

Example Code: 

An example FTAF Error Page may display a message using the following code:   

<p>An error has occurred attempting to forward your message to a friend.  
Please go <a href=“javascript:history.go(-1)”>back</a> and try again.</p> 

What Goes Where? 

Any custom pages you create for the FTAF process can either be uploaded to your 
website or the Media Manager.  In order to define what HTML pages will be used for 
FTAF, you need to enter the locations of these pages on the ADVANCED tab for your list.  
Make sure all of the URLs you enter include the full location of the page, including 
http://. 
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Figure 16: FTAF Options on the Advanced Tab of a List 

FTAF Anonymous 

FTAF Anonymous is used in situations where the individual forwarding on your message 
is either not a subscriber, or you would like to start the process outside of an email 
campaign.  You can create eCards on your site and allow visitors to forward them on to 
friends using FTAF Anonymous. 

Using FTAF Anonymous 

In order to use FTAF Anonymous, you must set up a special list to be used only for this 
purpose.  The default template associated with this list will be the content that is sent to 
the Friend.  It is not necessary to enter “from” or “reply-to” addresses for your list as 
the email address entered by the sender will be used for those fields. 

Using a Custom Form 

The FTAF Anonymous Custom Form is very similar to that used by non-Anonymous 
FTAF.  The only difference is that we do not have a "subscriber", so the 
SUBSCRIBER_ID_TAG input is not used.  Instead, we must specify the list set up for this 
process.  The SUBSCRIBER_ID_TAG input is replaced by a SLID (Special List ID) input in an 
FTAF Anonymous form. 
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The following input fields are required in your FTAF Anonymous Custom Form: 

Field 
Name 

Type Required 
Value 

Function 

slid hidden [Pulled from 
the “Create 
Forms (HTML 
Wizard)”] 

Used to indicate the list, and therefore template, 
to be sent to the friend. 

goto hidden %%GOTO%% The landing page that will be displayed after the 
form has been submitted. 

email text  The email address of the individual who is 
sending the message. 

email_1 text  The email address of the individual who will 
receive the message. 

In addition, the "Allow anonymous requests" checkbox must be enabled in your list. 

 
Figure 17: Checkbox to enable FTAF Anonymous 

The following optional tags can also be used: 

Field 
Name 

Type Required 
Value 

Function 

message text or 
textarea 

 If included in your custom form, this tag will 
enable the subscriber to include a personal 
message to their friend in the envelope of the 
forwarded message. 

email_# text  Where # is a number from 1 to 32 when multiple 
email addresses are allowed. 

first text  First name of the sender. 
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last text  Last name of the sender. 

first_# text  First name of the friend where # is a number 
from 1 to 32 when forwarding to multiple friends. 

last_# text  Last name of the friend where # is a number 
from 1 to 32 when forwarding to multiple friends. 

multi hidden 1 Used to enable forwarding to multiple friends. 

Example Code for one Friend:  

An example FTAF Anonymous Custom form may use the following code to forward to 
one email address. 

<form action="http://whatcounts.com/bin/ftaf_anon" method="post">  

  <input type="hidden" name="cmd" value="send">  

  <input type="hidden" name="slid" value="[INSERT VALUE HERE]">  

  <input type="hidden" name="goto" value="%%GOTO%%"> 

  <table> 

    <tr> 

      <td>Your email address:</td> 

      <td><input type="text" name="email" size="30"></td> 

    </tr> 

    <tr> 

      <td>Your friend's email address:</td> 

      <td><input type="text" name="email_1" size="30"></td> 

    </tr> 

    <tr> 

      <td>Subject:</td> 

      <td><input type="text" name="subject" size="30"  

value="A friend wanted you to see this"></td> 

    </tr> 

    <tr> 

      <td valign="top">Message:</td> 

      <td><textarea name="message" cols="30" rows="4"></textarea></td> 

    </tr> 

    <tr> 

      <td colspan="2" align="right"><input type="submit"  

name="submit" value="Send"></td> 

    </tr> 

  </table> 

</form> 
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Example Code for several Friends:  

Following is code from an example FTAF Anonymous Custom form that can be used to 
forward to multiple friends.  This code includes input for only two friends.  More of the 
following inputs can be added to create a form that can forward to a maximum of 32 
friends. 

    <tr> 

      <td align="right">Friend #1: </td> 

      <td><input type="text" name="email_1"></td> 

      <td><input type="text" name="first_1"></td> 

    </tr> 

In order to add more inputs, simply increment the value after email_ and first_. 

<form action="http://whatcounts.com/bin/ftaf_anon" method="post">  

  <input type="hidden" name="cmd" value="send">  

  <input type="hidden" name="slid" value="[INSERT VALUE HERE]">  

  <input type="hidden" name="goto" value="%%GOTO%%"> 

  <input type="hidden" name="multi_extended" value="1"> 

  <table border="0"> 

    <tr><td colspan="3">Forward your message to a Friend</td></tr> 

    <tr> 

<td align="right">Subject:</td> 

<td colspan="2"><input type="text" name="subject"  

value="A friend wanted you to see this" size="30"></td> 

    </tr> 

    <tr> 

<td align="left">&nbsp;</td> 

<td align="center">Email</td> 

<td>First Name</td> 

    </tr> 

    <tr> 

<td align="right">Friend #1: </td> 

<td><input type="text" name="email_1"></td> 

<td><input type="text" name="first_1"></td> 

    </tr> 

    <tr> 

<td align="right">Friend #2: </td> 

<td><input type="text" name="email_2"></td> 

<td><input type="text" name="first_2"></td> 

    </tr> 

<tr> 
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<td valign="top">Message:</td> 

<td colspan="2"> 

<textarea name="message" cols="30" rows="4"></textarea> 

</td> 

    </tr> 

    <tr> 

<td colspan="3" align="right"> 

<input type="submit" name="submit" value="Send"> 

</td> 

    </tr> 

  </table> 

</form> 

Envelope, Landing Page, and Error Landing Page 

Just like with FTAF, the Envelope, Landing Page, and Error Landing Page can all be 
branding in FTAF Anonymous.  The process and code is the same regardless of whether 
or not FTAF is an Anonymous or non-Anonymous event. 

PowerURLs™ 

The WhatCounts PowerURL™ feature provides more flexible tracking by allowing you to 
track a single URL as if it were several different URLs.  This is helpful if you have a URL 
in multiple places in your email message.  If you simply use the same URL in every 
location, the tracking data will be lumped together.  However, by using PowerURLs, you 
can track the clicks for the URL in each location as if they were separate, distinct URLs.   

PowerURLs are not limited to use in your email campaigns only but can also be used in 
your web pages to track clicks on your site.  Just enter the URL into your HTML code and 
then check the stats in the PowerURLs page. 

 
Figure 18: PowerURLs List page 
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Creating a PowerURL 

To create a PowerURL: 

1. Go to Content > PowerURLs to display the PowerURLs list page.   

2. Click Add New PowerURL to display the Edit/Create PowerURL form.  To 
create the PowerURL, fill out the form fields. 

 
Figure 19: Edit/Create PowerURL form 

a. Code: Enter a short, yet descriptive code to be used to identify the URL in the 
PowerURL. 

b. Group/Campaign: Enter a description that will help you identify how or 
where the PowerURL will be used, such as the name of the email campaign in 
which it will appear.   

c. Active: Select to activate the PowerURL and collect click-through data.  If the 
PowerURL is not active, no click-through data will be tracked, and any clicks 
will be routed to the Error Page.  

d. URL: Enter the URL to be tracked. 

e. Error Page: Enter a URL for a page to redirect to when the PowerURL is 
inactive or some other error occurs. 

3. If you would like to create multiple links to the same URL: 

a. Select Create Multiple Entries. 

b. Enter the total number of PowerURLs to create, where the maximum is 100 
entries. 

c. Enter the number at which to start the sequence.  This will append a number 
to the end of the code to differentiate each related PowerURL. 

4. Click Create to save the PowerURL, or click Cancel to cancel and return to the 
PowerURLs list page. 
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Editing and Deleting a PowerURL 

To access the PowerURL settings: 

1. Go to Content > PowerURLs to view the list of PowerURLs.   

2. Click the PowerURL code, group or URL in the list.  This will open the 
Edit/Create PowerURL page, displaying the settings that have been defined. 

a. To edit the PowerURL, make your changes and then click Update to save the 
changes. 

b. To delete the PowerURL, click Delete. 

Warning: Deleting a PowerURL will remove it and all the information 
associated with it from the database.  If users still have 
access to the link, they will receive an error when it is 
clicked, but it will no longer be the error page that you have 
designated in the PowerURL settings, since this information 
will no longer exist. 

Testing the PowerURL 

Before using the PowerURL, you should test it to make sure it will redirect to the 
expected URL. 

To test the PowerURL, click the  button next to the URL on the PowerURLs list page.  
You can also the test the PowerURL by clicking the try link next to one of the Public 
URLs on the Edit/Create PowerURL form. 

Testing the PowerURL will cause a click-through to be recorded, so you may wish to 
clear your statistics before using the PowerURL publicly.  To do this, see Clearing 
Statistics below. 

Using PowerURLs 

After you have created and tested your PowerURLs, you can get the PowerURL by 
accessing the PowerURL settings from the list page, and then viewing the Public URLs.   

The Public URLs lists three options that you can use to access the PowerURL.  All three 
work exactly the same and can be used interchangeably.  Simply copy the PowerURL 
and enter it into your template or HTML code.  For example: 

<a href=“http://whatcounts.com/p?r=whatcounts&c=wc1”>Click here</a> 
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When the campaign is sent, or the webpage goes live, each click on the link will be 
tracked and the statistics recorded. 

You can also create the URL for the PowerURL manually by writing it in one of the three 
following formats, where <realm_name> is your realm, and <code> is the code you 
assigned to the PowerURL: 

http://whatcounts.com/purl?r=<realm_name>&c=<code> 

http://whatcounts.com/powerurl?r=<realm_name>&c=<code> 

http://whatcounts.com/p?r=<realm_name>&c=<code> 

Viewing PowerURL Statistics 

Once the PowerURL has been place in its content and activated, you can begin viewing 
the results.  To view the statistics, click the  button from the Stats column in the 
PowerURLs list page.  This will display the total number of clicks as well as a bar chart 
showing the number of clicks per day.   

Clearing Statistics 

If you have collected erroneous statistics, such as during testing of the PowerURL, you 
can clear the statistics.  To do this: 

1. Go to Content > PowerURLs to view the list of PowerURLs.   

2. Click the PowerURL code, group or URL in the list.  This will open the 
Edit/Create PowerURL page, displaying the settings that have been defined. 

3. Click Clear Data to delete the current statistics.  

Media Manager 

In most cases, files for your email campaigns will be hosted on your servers.  This may 
include images or supplementary files you would like subscribers to access or download.  
However, because of bandwidth concerns or difficulty in uploading files to your own 
server, you may prefer to have WhatCounts host those files for you.  You can do this 
with the Media Manager. 

The Media Manager allows you to upload files to the WhatCounts media server.  Once 
the files are uploaded, you can use the path designated at the top of the Media Manager 
window to access the file in your email, such as an image display or a linked for users to 
download.  To upload files to the Media Manager: 

1. Go to Content > Media Manager. 

2. Next to the File name text box, click Browse to find and select the file. 
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3. Click the Upload File icon  to upload the selected file. 

4. After the file is uploaded, note the path at the top of the Media Manager.  You 
can create a link to the file you have just uploaded by using that path. 

For example, let’s say your realm name was “whatcounts” and you used the Media 
Manager to upload a file called “header.gif”.  You could use that image in an email by 
inserting the following URL into an image tag: 

http://media.whatcounts.com/whatcounts/header.gif 

You can also use the Media Manager to create folders to better manage your files.  To 
create a folder, enter a name into the Folder name text box and click the Create 
Folder icon .  To upload a file into that folder, first select the folder before beginning 
the Upload File process. 

Display Message Feature 

Did you ever wish you could place a link in your plain text content that would redirect 
readers to the HTML version of your e-mail message?  This is possible using the 
display_msg feature.  

If you're still wondering what the application of this new program is, consider the fact 
that a number of your subscribers may still be getting the plain-text version of your 
message. Instead of putting links into your plain text copy that directs them to some 
generic web page on your site, you can now direct them to a page that automatically 
recreates the HTML version of your message.  

This is different from directing them to some generic web page because the page 
created and rendered by display_msg is the same page your HTML readers receive - 
complete with personalized information.  

It's worth mentioning that this feature acts like an archive for your HTML content. Every 
time you run a list, the HTML version of your template is archived and permanently 
associated with a unique campaign.  So, whether you change or delete your templates, 
your readers will always be able to view your original HTML content for any campaign.  

There are security ramifications to consider since, in effect, a web page is now being 
created that anyone on the Internet can see that could, potentially, reveal personal 
information about your subscribers.  However, we believe these risks are low for the 
following reasons:  

• The ID tag created is an encrypted tag that's not sequential in nature (so it's 
difficult for someone to create a program that sits in a loop and attempts to 
display content)  

• You control the amount of information displayed.  In other words, you control 
which tags are used within the HTML cell of your template.  
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Using Display Message 

To create a link in your plain-text or AOL content that directs readers to the display 
message program, add one of the following:  

http://www.whatcounts.com/bin/display_msg?id=%%SUBSCRIBER_ID_TAG%% 
http://www.whatcounts.com/dm?id=%%SUBSCRIBER_ID_TAG%% 
http://whatcounts.com/bin/display_msg?id=%%SUBSCRIBER_ID_TAG%% 
http://whatcounts.com/dm?id=%%SUBSCRIBER_ID_TAG%% 

When your campaign is launched the tag %%SUBSCRIBER_ID_TAG%% will automatically get 
replaced with an encoded version of the subscribers ID and campaign ID - both of which 
are used to dynamically recreate the page.  If you'd like to see an example of this 
feature, click here. This page will always display the same content for the same 
subscriber.  

Note: This feature will not work during list testing because campaigns are only created 
when lists are run.  If you'd like to experiment with its use, create a new list and 
associate it with one of your existing templates.  Then, use the batch subscribe feature 
to sign up and then run the new list.  

Customer Referral Program 

To help promote our company and platform we have made it easy for you to include a 
powered-by WhatCounts logo and link in your outbound email or on your web site.  

 

Using the Powered By Logo 

Include one of the following pieces HTML code to display a clickable WhatCounts logo in 
your newsletter or on your web site:  

To link to the "powered-by" page:  

<a href="http://whatcounts.com/p?r=whatcounts&c=powered"> 

  <img src="http://www.whatcounts.com/images/poweredbywc.gif"> 

</a> 

To link to the main WhatCounts site: 

<a href="http://www.whatcounts.com"> 

  <img src="http://www.whatcounts.com/images/poweredbywc.gif"></a> 
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4. Articles 

You’ve already learned that templates allow you to create and store a diverse amount of 
information that can be emailed to your customers or audiences.  Articles extend this 
capability by providing you a template-neutral place in which to create and edit your 
content. 

If you’ve got several templates, there might be some information that’s repeated in each 
of them.  Perhaps it’s a company logo, address or copyright notice.  You could place this 
information into each template, but if the information changes, you’d have to edit it in 
multiple places. 

Articles let you keep one copy of information that can be applied in multiple places – 
most often inside templates.  Articles were modeled after articles in journalism, but their 
use is more flexible.  They contain sub-elements such as decks, titles, callouts, author 
fields, etc. – but what you put into these sub-elements, and how you use the 
information, is totally up to you. 

 
Figure 20: Articles menu 

Creating New Articles 

To create a new article, select Content > Articles > Create New Article.  Once you 
have created articles, you can see a list of them by going to Content > Articles > 
View. 

You will also see a link on that page labeled Add new article.  Click that to create a 
new article.  You’ll see a screen similar to the following. 
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Figure 21: Edit Article page 

Name your article.  It’s best to use a one word name (using underscores if necessary) 
that’s descriptive and will allow you to recognize the purpose of the article and what it 
contains.  Paste or type your information into the body area and press the “Create” 
button to save your work.  Your browser will be redirected to the Articles screen again.  
This time, you should see the Name and Description of the article you just created. 

Editing Articles 

To edit an article, select it from the article list.  You’ll see a screen that looks the same 
as the one you saw when you first created the article.  This time, however, the action 
button will be labeled “Update.” 

There’s more to an article than what you see through the default create or update 
screens.  When you’re at the article list, click on the Switch to Advanced mode link 
and then select one of your articles.  This time several previously hidden fields will be 
revealed, allowing you to store more information. 

The Edit Article page allows you to set the following parameters in advanced mode: 

Field Definition 

Article Name Textbox to define the name of the Article. 

Title Textbox to define the title of the Article. 

Description Textbox to describe the Article in the Articles list. 

Deck Textbox to define a sub-title or blurb for the Article. 

Callout Textbox to define a summary for the Article. 
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Body Textbox to define the main content of the Article. 

Author Name Textbox to define the author’s name. 

Author Email Textbox to define the author’s email address. 

Author Bio Textbox to provide more information about the author. 

Folder Listbox to select to which Folder the Article is assigned. 

Groups Checkbox options to define to which Group the Article 
belongs. 

Wrap text (for editing only) Checkbox to display the content of the Body textbox as 
wrapped to facilitate editing. 

Cancel Button to cancel creating the Article and return to the 
Articles page. 

Create Button to save the Article. 

Using Articles within Email Templates 

You can include Article content in your templates by using special Article tags and 
scripting.  For example, the following code will display the body of the Article:  

%%article "article name"%% 

You can also use logic with Article tags.  For example, if you want to include the article 
body only when the variable val is equal to 1, then use the following code: 

%%if val = "1" then includearticle "article name"%%  

You can include sub-elements of your articles using a slightly different naming 
convention which is modeled after the way parameters are specified in web pages.  The 
following code will display the designated element of the article, where article name is 
the name of the article and element is one of the supported Article tags: 

%%article “name=article name&type=element”%%  

For a list of Article tags and elements, see Appendix A: Article Tags. 

Note: Article names are case sensitive, so be sure to enter them 
properly. 
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Using the Microsite™ Viewer 

Utilizing the WhatCounts articles feature is a convenient way for you to organize content 
and keep it separate from any particular template.  Many customers have begun using 
articles because they offer them a convenient way in which to edit their material without 
having to worry about HTML coding.  

Still, we've heard some of them ask for help creating Micro sites because the content 
they wanted to deliver to their users couldn't fit, design-wise, within their newsletter 
format.  Maybe you've been wondering the same thing.  You've got a newsletter and you 
want to have several short capsule summaries of much longer content appear.  The 
conventional solution was to link off to static web pages on your site - or micro sites that 
we helped you create.  This solution works - but it's cumbersome and introduces 
multiple places where you'd have to edit your content.  

The Microsite Viewer, in essence, creates pages for you using your articles and your 
templates completely dynamically, and on demand.  

Here's how it works 

You create a template that represents the "container" for your page by placing HTML 
inside it (within the HTML cell).  Give it any name you like.  

You create an article that you want to have displayed within that page.  

Inside your newsletter template you place the tags that enable elements from your 
article to displayed (specifically things like its title and callout).  

For the template that will display your full article you place these same tags as well as 
one for the body of your article (examples below).  

You also place a special link inside your newsletter template that points to the new 
Microsite Viewer.  

The Microsite Viewer can be accessed through http://whatcounts.com/bin/msv.  If your 
organization has established DNS aliases that allow you to use your own domain, you 
can replace whatcounts.com in the above link with the Base URL you have already set 
up.  
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Program Arguments (Usage) 

The Microsite Viewer takes several arguments which tell it which template to use and 
which article to pour into the template.  Here's the list:  

Flag or 
Argument 

Description and Usage 

id, u or user 

(optional) 

This is the subscriber ID that's specially coded.  You can assign it in 
your newsletters by using the tag %%SUBSCRIBER_ID_TAG%%.   

a, article or 
article_name 

This is the name of the article you want to display inside the 
template.  It should match the name that appears in the article list 
exactly.  To include spaces you should using the plus (+) character.  
So, if your article was named Test Article you might set it using 
a=Test+Article.   

t, template or 
template_name 

(optional) 

This is the name of the template that content will be poured into.  It 
should match the name that appears in the template list exactly.  To 
include spaces you should using the plus (+) character.  So, if your 
template was named Test Template you might set it using 
t=Test+Template.  Remember, you can use one template for many 
of your articles.  This is easier for you and it keeps your messaging 
and design model consistent.   

aid 

(optional) 

This is the id of the article that be used.  Most customers don't 
reference articles by their id, but you can.  To see the different 
article numbers, hover you mouse over their names in the article 
list.   

tid 

(optional) 

This is the id of the template that content will be poured into.  Most 
customers don't reference templates by their id, but you can.  To see 
the different template numbers, hover you mouse over their names 
in the template list.  The article number will be shown in the status 
bar of your browser. 

r or realm 

(optional) 

This is your customer code or realm and helps the program 
determine where to find your article.  It's used when the Microsite 
Viewer is being used in anonymous mode.   

Putting it to Use 

If you've got a really long article that you want to include in your email newsletter, 
here's how we recommend you go about that - taking advantage of the article feature 
inside your email template and the Microsite Viewer to enable your reader to see the 
whole thing.  

• Create your email template and include the callout (capsule summary) of your 
article using a tag similar to: %%article "name=Test Article&type=callout%%.  This 
will display just the callout of your article in your newsletter.  
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• At the end of that, include a link to display the full article using the Microsite 
Viewer using a anchor tag similar to one of the following (make sure it's all on 
one line in your HTML):  

<a 
href="http://whatcounts.com/bin/msv?id=%%SUBSCRIBER_ID_TAG%%&a=Te
st+Article&t=Test+Template">Read More...</a>  

<a 
href="http://whatcounts.com/bin/msv?a=MSV+Test&r=whatcounts">Read 
More...</a>  

The first sample above shows how the Microsite Viewer can take subscriber information 
(%%SUBSCRIBER_ID_TAG%%) to determine your customer code.  It also allows the viewer to 
display personalized information inside your article.  

The second method of using the viewer is in anonymous mode.  The example shows the 
program displaying an article named "MSV Test" for the realm WhatCounts.  You can 
actually see the results at http://whatcounts.com/bin/msv?a=MSV+Test&r=whatcounts.  
Notice that when this particular article is displayed it utilizes a default template.  

Your email reader will see your article's callout (capsule summary) followed, in our 
example, with the link labeled Read More.  If they click on this link the Microsite Viewer 
will be run inside a browser window and display your article using their specified 
template.  

What Goes Where? 

Be sure to read about articles and how they are used in our online help, located in the 
drop-down menu under Customer Center.  In particular, the way different elements from 
a single article can be extracted within your templates (like the callout, for example).  

Inside the template you'll create for Microsite Viewer (not the template for your 
newsletter), use the following tags to display elements from that article anywhere you 
like:  

Tag Description 

%%$article_name%% Displays the article's name wherever this tag appears.  
This probably isn't very useful as the name is really a 
way for you to identify your article, not to display 
information to your readers.  But hey, we're flexible.   

%%$title%% or 

%%$article_title%% 

Displays the article's title wherever this tag appears.   

%%$article_description%% Displays the article's description.   

%%$dek%% or 

%%$deck%% 

Displays the article's deck wherever this tag appears.   
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%%$callout%% or 

%%$article_callout%% 

Displays the article's callout.  You may or may not want 
to use this in your article as it will likely be used as the 
teaser to the article inside your email.   

%%$body%% or 

%%$article_body%% 

Displays the article's body wherever this tag appears.   

%%$author_name%% Displays the article author's name wherever this tag 
appears.   

%%$author_email%% Displays the article author's email address wherever this 
tag appears.   

%%$author_bio%% Displays the article author's bio wherever this tag 
appears.   

In addition to all the above tags, you can also include personalization tags since every 
page that's displayed by the Microsite Viewer gets dynamically associated with a 
particular user (via the %%SUBSCRIBER_ID_TAG%% tag).  So, you can include things like:  

%%$email%%  

%%$first%%  

%%$last%%  

You can also include custom tags and the built-in tags to display date and time. 

Protected Form-based Emailing 

Have you ever wanted to create a form that collects data and emails it to you or 
someone within your organization?  Maybe you need a request form for products or 
technical support?  

Although it may sound easy, platforms like WhatCounts place restrictions on that type of 
form processing for security reasons.  A form that allowed you to put in any destination 
email address, fill out your message, and have it sent, could easily be turned into the 
equivalent of an open email relay.  Although anonymous email forms aren't allowed for 
this reason, we have created similar functionality using a feature called Email Alias. 

The Email Alias feature is easy to use and works by collecting data from your form and 
pouring the results into a template that you specify prior to emailing.  That way, you can 
control the look and feel of the message delivered.  

• Create an Email Alias by going to http://whatcounts.com/bin/alias_manager, 
choosing a name and entering one or more email addresses in the Macro field. 

• Create a form you'll use to collect your information. 

• Create a template that will be used to pass on that information. 

• Test it!  



WhatCounts User Manual 

 - 52 - 

Copyright © 2005 WhatCounts, Inc..  his document contains proprietary information that constitutes trade secrets and is not to be shared, copied, 
disclosed, or otherwise compromised without the prior written consent of the management of WhatCounts, Inc. 

Sample Form 

In the sample HTML form code below, notice the input names in bold.  You will want to 
change the values of all of these inputs to match things like your realm name, what you 
want to use as a “from” address, and the template your data should be merged into 
before sending.  

<form action=http://whatcounts.com/bin/alias_email method=post> 

<input type=hidden name=alias value="sales team"> 

<input type=hidden name=realm value="yourrealm"> 

<input type=hidden name=from value="<someone@yourcompany.com>" 

<input type=hidden name=subject value="Sales Opportunity "> 

<input type=hidden name=template value="Demo Request"> 

<input type=hidden name=html value="1"> 

<input type=hidden name=goto 

  value="http://www.yourcompany.com/thankyou.html"> 

<table> 

<tr> 

  <td>Your name:</td> 

  <td><input type=text name=custom_name size=32></td> 

</tr> 

<tr> 

  <td>Your email address:</td> 

  <td><input type=text name=custom_prospect_email size=32></td> 

</tr> 

<tr> 

  <td>Product you are looking for?</td> 

  <td> 

 <textarea name=custom_product cols=50 rows=10></textarea> 

  </td> 

</tr> 

<tr> 

  <td colspan=2 align=center><br> 

    <input type=submit value="Send Information"></td> 

</tr> 

</table> 

</form> 
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Inputs 

The following are the standard inputs you must set in order to have the form work for 
your purposes: 

Input Name Description 

alias The alias to use to send the form (previously defined through the 
Alias Manager). 

from The “from” address used when the template is emailed. 

goto A fully qualified URL that will serve as a landing page after the form 
is processed. 

html Set this to "1" for HTML or "0" for plain text. 

realm Set this value to the name of your realm.  Using this convention 
allows different customers of the platform to utilize the same alias. 

subject Controls the subject of the template that is sent after the form is 
completed. 

template The name of the template into which form data will be merged prior 
to emailing. 

Of course, you will also need to add inputs to your form to collect data.  If you are using 
standard WhatCounts inputs, use the same names you would in a template.  (See 
Appendix A for details.)  

If you are using custom fields, you don’t need to first create the fields in WhatCounts as 
is normally the case.  Just use any name you’d like, as long as it is preceded by custom_.  
The purpose of using alias_email is mainly to pass on information, rather than collect it 
in a subscriber record. 

Sample Template 

By specifying a template, it's easy for you to control how the message to your alias 
recipient(s) will appear.  Templates for this feature are created and managed the same 
way you create and use templates for regular email.  

<html> 

<body> 

A request for a demo has been received from %%$name%% 
(%%$prospect_email%%). 

<br>The product being sought is: %%$product%% 

</body> 

</html> 
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The above template incorporates all of the fields that were included in the original form.  
As with other forms you have used in WhatCounts, any fields that are not standard to 
WhatCounts (like %%$email%% for email address) need to be preceded in your form by 
“custom_”.  However, when using that field in your template, simply encapsulate the 
names within %%$ and %%.  You do not need to use “custom_” in a template.  This is the 
same way you would use a custom field in the template for any email campaign. 

Security 

Since the Email Alias feature relies upon email addresses stored inside a database and 
not within the HTML form, this resource is considered moderately secure and unlikely to 
be the source of email abuse.  

It is recommended that you add JavaScript to your form to provide some degree of form 
and field validation. 
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5. Subscribers 

Subscribers are individuals who have applied to receive content from a particular list or 
lists.  When a customer signs-up for a list, a record is created to store their email 
address, as well as any other information they provide.  In addition, for each list that a 
customer requests to receive, a subscription record is also created to associate the 
subscriber with each list. 

The WhatCounts model is very similar to how magazine subscriptions are managed.  For 
example, when you subscribe to several magazines, each one is addressed and arrives 
at your home.  There is one address where the magazines are delivered.  You and your 
home address would constitute the subscriber record, and the various magazines you 
receive would represent your subscriptions. 

 

Figure 22: A Subscriber and Subscription Records 

Adding and Removing Subscribers 

There are several ways to add subscribers to your lists.  In the Lists section of this 
training manual you learned about creating a subscription form.  In this section you’ll 
learn how to import subscribers into your system from files created by your database or 
contact management program. 

Subscriber Import Wizard 

The WhatCounts Subscriber Import Wizard allows you to import data from a comma-
separated-values (CSV) format file.  This format is extremely common and easy to 
create.  Fields within each row of these files are enclosed within quotation marks, and 
individual fields are separated by commas.  For example the following, might represent 
an entry for a subscriber named “Mary Richards.” 

“Mary”, “Richards”, “mrichards@whatcounts.com” 

Subscription 2 Subscriber 

Subscription 1 

Subscription 3 
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Using the Subscriber Import Wizard is a three-step process.  The first step asks you to 
identify the source of your data.  That would be a CSV file located on your own computer 
or one on your network. 

There are three options available on the first screen of the Import Wizard: 

First record contains 
field headers 

If checked, WhatCounts will recognize that the first row 
of data in your file contains header fields used only to 
identify the contents of each column.  You’ll see these 
labels in step 2 of the wizard process, but they will not 
be added to your list. 

Import if users even if 
they have previously 
opted-out 

If checked, this option tells WhatCounts to ignore the 
fact that a subscriber is on the Opt-Out list and import 
them in anyway. 

Note:  This option should only be selected in rare cases 
like testing, or if you are importing hard bounced email 
addresses back on to a list. 

Ok to update subscriber 
record if it exists 

If checked, this options tells WhatCounts to safely 
overwrite subscriber information (name, address, etc.) 
if a record already exists. 

When you click continue, you will proceed to the field-mapping stage.  This is where you 
tell WhatCounts which fields to associate with the data from your file.  Your data are 
stored in rows, each with the same format.  So, each column in your file represents one 
field.  In the “Mary Edwards” sample line mentioned previously, the first field 
represented the subscriber’s first name, the second their last name, and the third and 
final, their email address. 

WhatCounts allows you to arrange your data any way you like – and that’s why the field 
mapping stage is so important. 

The last step in the wizard asks you to identify which list to import your data into.  Once 
you identify the list and select continue, the wizard will run and, you can safely continue 
on with other work.  The import wizard works automatically, in the background.  When 
it’s done, you’ll be sent an email message with the results of the import process.  At any 
time during the import, you can also check the subscriber counts for your list.  You 
should see the numbers rise steadily as the import proceeds. 

You’ll find the following information on the “Subscriber Import Complete” email: 

Total records processed: Lines found by the Import Wizard in your *.csv file 

New subscribers added: Subscribers new to your realm, not just this list. 

Subscribers updated: Duplicate subscriber records in the *.csv file, or 
subscribers who already existed in that realm. 

Subscribers ignored: If “Ok to update subscriber record if it exists” is 
unchecked, any pre-existing subscriber records who 
were also in the *.csv file being imported would be 
ignored. 
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Subscribers opted out: Subscribers on your *.csv file who had previously opted 
out of that list. 

Errors (records not 
processed): 

Any records that were not imported for some reason.  
Usually indicates a bad email address (i.e. 
@whatcounts.com). 

A list of 20,000 subscribers should import in approximately 10 minutes.  Import speed 
depends heavily upon the amount of custom data being associated with each subscriber 
and other activity going on in the system at the time. 

Batch Subscribing and Unsubscribing 

If there’s ever a need to subscribe a handful of people at one time, without going 
through the whole list import process, you can use the batch subscribe feature.  It’s 
found under the Subscribers drop-down menu. 

 
Figure 23: Batch Subscribe page 

Subscribing one or more individuals through this interface is straightforward.  Enter or 
paste a group of email addresses separated by commas, spaces or semi-colons and 
mark the list or lists you want them subscribed to.  If you want to include a column from 
Excel, just select that column of data, copy it to your clipboard and paste into the batch 
import screen. 



WhatCounts User Manual 

 - 58 - 

Copyright © 2005 WhatCounts, Inc..  his document contains proprietary information that constitutes trade secrets and is not to be shared, copied, 
disclosed, or otherwise compromised without the prior written consent of the management of WhatCounts, Inc. 

After pasting or typing in your email addresses, select one or more lists to subscribe 
them to and, for each list, select the format you’d like to assign them.  If your list is 
utilizing the formatting “sniffing” feature, you can safely set your subscribers to receive 
“plain text” and rely upon the multipart MIME feature to deliver the appropriate format 
of content to them. 

After you’ve selected the lists or lists to subscribe them to, press the Subscribe button to 
begin the process. 

It’s recommended that for lists greater than a hundred or so, that you use the import 
wizard.  Also, through this interface you can only enter in subscriber’s email addresses 
(though you can always update their individual records at a later time). 

Similar to the batch subscription process, the batch unsubscription process allows you to 
remove subscriptions for one or more individuals.  Use the interface the same way – 
only this time select the lists you’d like the subscribers removed from. 

Exporting Subscribers 

If you’d like to get a data dump of all your subscribers, you can do so through the 
export wizard.  Reached via the Subscribers drop-down menu, the Export Subscribers 
wizard makes it easy to create a data file of your subscribers.  Through the wizard you 
can specify which fields to include as well as the format.  The two choices are comma-
separated-values (CSV) or XML. 

Using the wizard is a two step process.  The first step requires you to identify the list 
you’d like to export from, the type of segmentation to apply (this will be discussed 
later), and the format for your data file. 

If you would like, you can also export subscribers from all the lists in your realm.  To do 
this, select “All Lists” from the list drop-down in the Export Subscribers wizard.  
Selecting the “Consolidate subscription information” checkbox means that each email 
address will only show up on your list once – regardless of the number of lists to which 
that individual is subscribed. 

After selecting your list, segmentation, and format, you’re presented with a screen that 
displays the number of people that will be exported and allows you to select what 
subscriber fields, in addition to email address, you’d like to export. 

Like the import wizard, the export process is capable of functioning in the background.  
So, once you start it, you don’t need to wait for it to complete.  When it’s done you’ll be 
alerted by an email message. 
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You can download you exported data file through the WhatCounts File Manager which 
can be accessed through the Content drop-down menu.  If the progress screen is left 
displayed, your browser will automatically be redirected to the File Manager upon 
completion of the export. 

File Manager 

The file manager displays a list of files that you can view, download, FTP, or delete.  To 
view a file, select it with your mouse.  It should display in your browser’s window.  Some 
files can’t be display in your browser and must be downloaded. 

To download a file select it using your right mouse button and choose the option labeled 
Save Target As.  A dialog box will appear that will allow you to select a download 
location for the file.  For Macintosh users, refer to your browser’s documentation for 
information related to saving files in this manner. 

Searching for Subscribers 

To locate a specific subscriber, use the Search for Subscriber feature located under the 
Subscribers drop-down menu.  Enter in as much information as possible.  Entering an 
exact email address is fastest. 

 
Figure 24: Subscriber Search page 

If you wanted to find everyone that has a common address (or belongs to the same 
company), you could enter partial information.  For example, to show everyone that has 
an address from whatcounts.com you could enter “@whatcounts.com” in the email field and 
make sure the Exact address checkbox was unmarked. 

If multiple records are found, you’ll be shown a list from which to choose.  If only one 
record is found you’ll be immediately redirected to the User Details page with that 
user’s information prepared for you to view or edit. 
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Editing Subscriber Records 

The search feature reveals a list of subscribers.  To edit a record for one of them select 
their email address.  You’ll be taken to the User Details page and be able to change 
anything about that individual – including their Subscribed lists. 

There are four tabs in each subscriber record: User Information, Subscribed Lists, Opt 
Out, and Custom Data. 

 
Figure 25: User Details - Edit Subscriber page 

The User Information tab displays any of the default field information you have collected 
about this subscribe.  If that subscriber has either opened an HTML email or clicked on a 
tracked link, we will also attempt to include information like their IP Address, as well as 
browser and email client information. 

The Subscribed Lists tab will show all the lists in your realm.  Any boxes that are 
checked indicate that the subscriber is subscribed to that particular list.  We will also 
include the date and time of subscription, be it through a subscription form, import, or 
Batch Subscribe.  Any lists the subscriber has opted out of will be marked in red. 

The Opt Out tab is similar to the Subscribed Lists tab, but it details the lists that 
subscriber has opted out of.  It will include checks in the boxes of the lists for which the 
subscriber has opted out, and will also include a date and reason for the opt-out.  Any 
lists the subscriber is currently a member of will be indicated in bold. 

If you would like to opt a subscriber out of all lists – current and future – in your realm, 
check the “Global Opt Out” box on this tab and hit UPDATE.  You can also select the 
“Globally Opt Out” link at the bottom of any tab in the subscriber’s record. 
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Finally, the Custom Data tab lists all the custom fields that have been created in your 
realm.  If you have collected any custom information for this subscriber, it will be shown 
here. 

Note: Switching tabs in a subscriber record will automatically save 
any changes made on that tab.  Alternatively, you can 
select the UPDATE button at the bottom of the User Details 
screen. 

Examining Subscriber Events 

On the User Details page there’s a link labeled Show Events.  If you select this you’ll 
be shown all the events associated with that particular user.  If they’ve read any of your 
HTML email or clicked on any of the links you’ve sent them – you’ll see it revealed here.  
Naturally, this information is only available for lists that have had tracking enabled. 

Profile Management 

Your subscribers will undoubtedly wish to make changes to their settings from time to 
time.  This may mean changing their email address, personal information, and/or 
subscriptions.  With the Profile Management tools described here, you can control how 
much of your subscriber’s information is revealed for them to change.  

The WhatCounts Profile Management tool was designed with security in mind.  Every 
change a subscriber makes requires confirmation through an automated email 
exchange.  

Initial Setup 

To enable Profile Management, you should first specify what information subscribers are 
allowed to see and change.  This is performed through the Subscriber Information 
Management (SIM) interface.  To access the settings for your realm, go to: 
http://www.whatcounts.com/bin/subscriber_information_management 

When the Subscriber Information Management interface opens, select the checkboxes 
next to the items you would like your subscribers to be able to see and change.  There 
are separate sections for Subscriber Data, Custom Data, and Lists.  Next to each field 
you'll also find a “Friendly Name” and a “Description.”  Use these to assign names and 
descriptions you'd like your subscribers to see.  These may differ from the internal 
names you've given to your Lists and Custom Fields.  
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How Subscribers Change Their Profiles 

A link for Profile Editing can be placed directly into your message content - whether it's 
HTML, plain text or another format.  To provide a Profile Editing link for your readers 
within a template, simply insert the following code into your template:  

<a href="http://whatcounts.com/bin/sie?id=%%SUBSCRIBER_ID_TAG%%"> Edit 
Profile</a>  

Note: If you have established a Base URL, you can replace 
whatcounts.com in the above link with your Base URL.  The 
rest of the link should remain the same. 

When your readers click this link, they will be taken to a web page where they can edit 
the information you have setup.  

Allowing Web-based Changes 

Sometimes you'll want to give your readers the chance to edit their profiles directly from 
your web site.  A good example of this might be someone who wants to change their 
email address without a current message from you to initiate the Profile Editing process.  
The SIE (Subscriber Information Editor) has a mode that will automatically email 
someone a message containing a link they can use to start the editing process. 

To use it, simply create a form similar to the example below and place it on your 
website.  Be sure to replace [yourrealm] with your actual realm name.  

<form action="http://whatcounts.com/bin/sie" method=post> 

<input type=hidden name=cmd value="genkey"> 

<input type=hidden name=realm value="yourrealm"> 

Email: <input type=text name=email"> 

<input type=submit> 

</form>  

After a subscriber enters their email address into the form and presses the SUBMIT 
button, the SIE program will generate an email message and send it to the subscriber.  
The email message will contain a link that will allow the subscriber direct access to a 
form where they can edit their profile.  
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Custom Page Styles and Landing Pages 

The Profile Management system allows you to use your own page style for the editing 
form as well as being able to specify custom landing or "thank you" pages.  If you would 
like the Profile Edit pages to carry your branding “look and feel,” you can create HTML 
pages for the stages of the Profile Edit process, upload them to your web site, then enter 
the URL for the pages you have created in the SIM interface: 
http://www.whatcounts.com/bin/subscriber_information_management 

You can also create templates in WhatCounts to use for these pages.  If you are using a 
template, simply enter the ID of the template next to the appropriate item in the SIM 
interface. 

Note: To determine a template’s ID, open any template and look 
at the address bar of your browser.  The value after “&id=” 
is your template’s ID. 

The following are pages that can be defined through the Subscriber Information 
Management interface: 

Content Envelope / 
Wrapper 

Defines the location of a template or HTML page to use.  
This envelope wraps around the content throughout the 
Profile Edit process to control the overall look and feel. 

If you want to specify a template defined within our 
system enter its template ID number.  Otherwise, enter 
the URL where your page is located. 

Use the %%BODY%% tag in your template or HTML page to 
define where the content the wrapper surrounds should 
be placed on the page. 

Profile Edit Form The Subscriber Information Management system 
automatically generates a form to use based on your 
selections in the SIM interface.  If you'd like to control 
the look and feel of the form you can define your own 
template to use here. 

As with the Content Envelope / Wrapper, enter the 
template ID if you want to specify a template defined 
within our system, otherwise use a URL. 

Note: If your form contains fields that have not been 
configured in the SIM interface they will be ignored. 

Landing Page Defines the page a subscriber will be sent to once they 
have submitted their update request. 

Confirmation Landing 
Page 

Defines the page a subscriber will be sent to on a 
successful confirmation. 
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Custom Profile Edit Form 

There may be cases where you’ll want to create your own Profile Edit form, rather than 
use the one generated by WhatCounts.  The reason for creating your own form could be 
a desire to change the layout or edit the input types.  The inputs in the form generated 
by WhatCounts are all text inputs.  This can be problematic if you are trying to constrain 
your subscriber’s responses to a few select choices, like ‘y’ or ‘n’. 

Here's a skeleton of the code you'd need to create your own Profile Edit form: 

<form action="http://whatcounts.com/bin/sie" method="post"> 

<input type="hidden" value="%%EID%%" name="eid"> 

<input type="hidden" name="%%ENV%%">  

<input type="hidden" name="%%GOTO%%"> 

<input type="hidden" name="%%CONFIRM_GOTO%%"> 

<input type="hidden" value="0" name="skip_confirm"> 

[Profile Edit inputs] 

<input type="submit" value="Update" name="cmd"> 

<input type="submit" value="Cancel" name="cmd">  

</form> 

The inputs %%ENV%%, %%GOTO%%, and %%CONFIRM_GOTO%% will all be pulled from the values you 
entered in the SIM interface.  %%EID%% will generate an encoded ID tag for your 
subscriber.  The rest of your form will contain the fields you would like your subscriber 
to be able to change. 

Note: The inputs in your custom form must match what you have 
checked in the SIM interface as allowable for your 
subscribers to edit. 

You may recognize these tags from discussions of personalizing your templates.  These 
are the standard WhatCounts Subscriber Data tags. 

As is also the case with other forms you may have used with WhatCounts (like 
subscription forms) custom fields can be used in your Profile Edit form by naming your 
input %%$custom_[field name]%% (without the brackets).  Remember, field names are 
case sensitive, so you must use them in your form exactly as they were initially set up in 
Segmentation > Custom Fields. 

Let’s say you have a custom field called “Gender,” the input in your custom Profile Edit 
form would be: 

<input type=text name=“custom_Gender”> 

Notice the capital ‘G’ in ‘Gender’. 



WhatCounts User Manual 

 - 65 - 

Copyright © 2005 WhatCounts, Inc..  his document contains proprietary information that constitutes trade secrets and is not to be shared, copied, 
disclosed, or otherwise compromised without the prior written consent of the management of WhatCounts, Inc. 

Using Other Input Types 

One benefit of creating a Profile Edit custom form, is that you are not constrained to 
using only text inputs.  You can use any input you would like to include in your form: 
radio buttons, checkboxes, or drop-down (“select” lists).  Although you are free to 
choose your input, besides using a text field, the only way you can get a subscriber’s 
current value to display in a Profile Edit form would be to use a select list.  For example: 

<select name="custom_Gender"> 

<option value="%%$custom_Gender%%">%%$custom_Gender%%</option> 

<option value="">----------</option> 

<option value="male">Male</option> 

<option value="female">Female</option> 

</select> 

If you had a custom field called “Gender” and included this input in your Profile Edit 
form, the subscribers current gender value would be displayed at the top of the drop-
down menu.  If the subscriber did not currently have a Gender value in his or her 
subscriber record, the top option in the select list would be blank. 

Security Considerations 

The subscriber Profile Management resources were designed with the end user's security 
in mind.  After a Profile Edit form is submitted, the end-user receives a confirmation 
email.  Before any changes are made, the link within the confirmation message must be 
selected.  This certainly adds an extra step to the process for the end-user, but it makes 
it more secure and less likely to be abused.  

If you would like to disable this last step and allow your subscribers to make changes 
without a final confirmation step, you can do so by include the following to the end of 
your SIE link: &skip_confirm=1.  

Note: The skip_confirm feature will only work if it is enabled.  
Because of security concerns we don't automatically enable 
it for all customers.  Contact support@whatcounts.com to 
circumvent the confirmation process 
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6. Running and Testing Lists 

Testing your lists is probably the most important action you’ll perform when using the 
system.  It’s the best way to spot errors in your content or with how your list has been 
setup prior to deploying your campaign to all your subscribers. 

The old adage used in building “measure twice, cut once” can be applied to email as 
well, but changed to read “test, test again, test one more time, test even one more time 
if your job depends upon it, and then deploy.” 

Testing Lists 

To test a list, select Test List from the Lists drop-down menu.  Select the list you wish 
to test from List Name, and then select Test List.  In the Recipients(s) text box, 
enter in the email addresses of the individuals you’d like to receive your test message.  
Then, select the formats you’d like sent.   

By default the checkboxes for Multi-part, Plain text, and HTML are all selected.  This 
gives you an easy one-step way to send three versions of your content for review.   

When the Testing Notice box is checked, “[Testing]” will automatically be added to 
your email before the subject line you have entered.  This will allow you to easily 
identify your test emails. 

Note: Much of the functionality you may be using in your final 
email will not work in “Test List.”  These include FTAF 
(Forward To A Friend) as well as Display Message and 
Unsubscribe links.  (These features require a campaign to 
function.)  To verify that these items are working properly, 
you will need to run the list to yourself with a segmentation 
rule – thus creating a campaign.  Segmentation rules are 
discussed later in this document. 

One thing to note about multi-part messages is that if your email client is capable of 
displaying HTML, they’ll appear just like the HTML version.  To determine which format 
you actually received, check your email message headers.  In Outlook you can do this 
through the View menu for a message.  Select options to display your message’s 
headers and scroll down through the information until you see the line that starts with 
Content-type.  It will read text/html if the email was only sent in HTML or 
multipart/alternative for a multipart MIME message. 
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Running Lists 

The Run Wizard provides a walkthrough approach for deploying your campaigns.  From 
the Run Wizard, you can deploy a standard list or select to customize your list. 

Standard Mailing 

A standard mailing, or normal campaign, is similar to using the Run List option to deploy 
a campaign, but you have fewer choices.  For example, you cannot select a 
segmentation rule.  To deploy a normal campaign using the Run Wizard: 

1. Go to Lists > Run Wizard.  This will display the First Step, which will default to 
standard mailing. 

 
Figure 26: Run Wizard First Step 

2. Select the List Name and Template. 

3. Select a Format option.  The options include the following: 

“Send plain-text to everyone” and “Send HTML to everyone” will send the 
selected format all of your subscribers regardless of any preference they may 
have indicated when subscribing to your list. 
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“Send Multipart MIME to Everyone” takes the HTML and plain-text sections of 
your template and creates a “package” – the Multipart MIME message.  When a 
MIME message arrives at your subscriber’s email client, it is able to determine 
whether that client can render HTML.  If it can, that’s the portion of the MIME 
message your subscriber will see.  If their email client cannot render HTML, your 
subscribers will see the plain-text portion of the MIME message. 

“Subscriber Selected Format” sends email to subscribers based on the format 
that is selected in their subscriber record.  If you have no collected or imported a 
format preference for your subscribers, do not select this option.  If you do, your 
subscribers may all be sent plain-text, the default import format when no other 
selection is made. 

4. Click Continue.  This will display an overview of how the list will be sent. 

5. Click Send to run the list, click Back to change your options, or click Cancel to 
cancel the list run. 

Customized Mailing 

A customized mailing is more similar to using the Run List option to deploy a campaign, 
but it is presented in steps.  Also, the customized mailing allows you to enter content for 
any fillin values you defined in your template.  To deploy a customized campaign: 

1. Go to Lists > Run Wizard.  This will display the First Step. 

2. Select the List Name, Template and Format option. 

3. Select the option “I need to customize some of the mailing settings”. 

4. Click Continue.  This will display the Advanced Options. 
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Figure 27: Run Wizard Advanced Options 

5. Select the Segmentation rule. 

6. Optionally, you can name the campaign by entering a name in Campaign Alias. 

7. Click Continue.  This will display an overview of how the list will be sent. 

8. Click Send to run the list, click Back to change your options, or click Cancel to 
cancel the list run. 

 

View Tasks 

You can check on the progress of your campaign, or determine where it is in the queue.  
To do so, select Lists > View Tasks.  The Tasks and Scheduled Events page will 
display a list of the tasks currently being processed in the system, including campaigns, 
reports, imports and exports.  It also displays the tasks that have been scheduled to run 
up to 24-hours in the future.  Tasks that do not belong to your realm will be marked as 
“Anonymous.” 
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7. Calendar-based Publishing 

The WhatCounts system makes it easy to automate your email publishing tasks.  Using 
the built-in calendar, you simply select a day you want to publish and press the link 
labeled “Schedule Publishing Event Today.”  Today represents the calendar day 
displayed in a different color from the other days. 

 
Figure 28: Calendar page 

To change days, pick a different one with your mouse.  Be sure to click on the number 
for that day.  Clicking on a scheduled event displayed within a day’s “box” might confuse 
you as it will reset the current day to when it was entered. 

To change months, select and click on one of the blue arrows displayed near the month 
and year.  If you look at the URL displayed in your browser you will see the format used 
by this program.  You can manually enter in different days, months or year to move 
quickly to different dates. 

Besides scheduling single publishing events, you can schedule a list to publish on a 
recurring basis, such every hour or every day.  Similarly, you can select specific days on 
which to publish. 

To schedule a publishing event, select the day you would like your list to publish on 
using the calendar and press the link labeled “Schedule Publishing Event Today.”   
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On the screen that appears make the following selections: 

List name Select the list you want to deploy (publish). 

Template Select the content you want to be sent to that list. 

Segmentation Select any segmentation you want applied to that list for 
this campaign. 

Format option Select the format of the content that will be sent to your 
subscribers. 

Start Time Select the time you want the list to be sent. 

Frequency Select the frequency with which you would like this 
campaign sent.   

If the frequency of your publishing is high (such as 15 
minutes, 30 minutes. or hourly), you might want to 
uncheck the Notification option so you are not 
bombarded by confirmation messages. 

Notification Check this box to have a notice sent to you when your 
campaign in actually deployed. 

Once entered, the system will automatically start and send your list at the specified 
time.  If the Notification box was checked, you will receive an email message when the 
list has been sent, confirming that the action was performed. 

Sticky Campaigns 

If you’ve got a list that you’re scheduling to publish very often (such as daily or hourly), 
you might consider setting an option for that list so that the same campaign number is 
used over and over.  If you don’t do this, there will be a new campaign record created 
every time the list is run.  This may make analyzing the data in your reports very 
difficult. 

Consider a list scheduled to run every 15 minutes.  That would create a total of 96 
campaign records in one day, or 672 in a week.  It’s nothing the WhatCounts system 
can’t handle – but will you be able to efficiently utilize that much information? 

A list with the sticky campaign option selected will have a single campaign record.  All of 
the open and click-through events will be recorded for that one campaign – regardless of 
when they took place. 

Setting a list to have a sticky campaign is done on the ADVANCED tab of Edit List. 
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8. Custom Fields & Segmentation 

Custom fields allow the WhatCounts system to adapt to your information and the way 
you use it within your organization.  In essence, custom fields allow you to extend the 
WhatCounts database so that it stores data you’ve defined and associated with all your 
users or recipients. 

Suppose your organization has the notion of “membership”.  Some users are members, 
and some are not.  Now, suppose you’ve been keeping track of that information by 
storing a “Y” or an “N” in your database in a field named “membership_status” To 
extend that level of detail to the WhatCounts system you simply need to create a new 
custom field named “membership_status” and import that information into the system. 

Custom fields do more than simply store your information.  Whatever is stored within 
them can be merged into your templates.  So, if you did, in fact, create a custom field 
named “membership_status” and it contained either a “Y” or an “N”, you could do things 
like the following inside your templates: 

<H1>Welcome 

%%if membership_status = “Y” then print “member” else print “guest”%% 

Custom fields can also be used for performing segmentation, as you will soon seen, and 
allow you to direct very specific information to highly targeted audiences. 

Creating Custom Fields 

Access Custom Fields by selecting that item under the Segmentation drop-down.  
Custom fields can be one of the following types: 

• Number 

• Date 

• Text Field 

• Large Text Field 

Create the custom field type that best matches your intended use and the type of data 
you plan to store.  When choosing a name for custom field, it is best to select one word 
names.  You may also use an underscore to join words.  In the example above, 
“membership_status” would have been defined as a text field.  But, if your database 
represented members by the value 1, for example, and non-members with 0, you could 
choose “number” as the type for your custom field. 
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Note: The number custom field must be comprised of only 
numbers.  If you have alphabetical characters or symbols in 
a field, do not select type “number” as that will cause your 
data to be corrupt. 

The difference between Text fields and Large Text fields is that the latter is usually used 
for blurbs of comments.  While Text Fields are limited to 512 characters, Large Text 
fields have no limitations.  However, unlike Text fields, Large Text fields cannot be used 
with Segmentation rules. 

Creating Segmentation Rules 

You can segment your list into pieces for targeting certain subscribers.  Segmentation 
rules can be used to separate lists by: 

• membership status 

• purchase history 

• demographics (locale) 

Although the WhatCounts platform allows you to create as many lists as you like, it is 
common to have only one or a few lists and then take advantage of data structures to 
form important groupings, or segments. 

To create a custom Segmentation rule, click the Add New Segmentation Rule link on 
the Segmentation Rules page.  This will display the Edit/Add Segmentation Rule 
page. 

 
Figure 29: Edit/Add Segmentation Rule page 
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Field Names 

The field-name drop down will list all the built-in field names as well as any custom 
fields you’ve defined.  Custom fields will be designated by a leading asterisk (*) symbol. 

Comparison Operators 

Comparison operators select the test to perform against the selected field and the value 
you provide.  Operators are broken into three distinct groups: Text, Number, and Date. 

Operator Type  Operator Description 

Equals Is the field equal to the value?  This is a string 
comparison and may be case sensitive. 

Contains Does the field contain the value? 

Starts with Does the field begin with the value? 

Text 

Ends with Does the field end with the value? 

= Is the field equal to the value? 

!= Is the field not equal to the value? 

> Is the field greater than the value? 

>= Is the field greater than or equal to the value? 

< Is the field less than the value? 

Number 

<= Is the field less than or equal to the value? 

< Is the date less than the value? 

<= Is the date less than or equal to the value? 

> Is the date greater than the value? 

>= Is the date greater than or equal to the value? 

Date 

[yyyy-mm-dd] 

= Is the date equal to the value? 

Note: Unlike the other Date Comparison 
Operators, any value other than a date (like hours, 
minutes and seconds) will be ignored. 

Creating Custom Segmentation Rules 

If you find that the Segmentation Rule you would like to create is more in depth than 
the feature can handle, then you can create a custom query.  The custom query uses 
Wsql.  This allows more flexibility than what is available with standard Segmentation 
Rules.  It includes the ability to create complex rules using a combination of AND and OR 
statements. 
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To create a custom Segmentation rule: 

1. Click the Add New Custom Segmentation Rule link on the Segmentation 
Rules page.  This will display the Wsql Segmentation Rule page.   

 
Figure 30: Wsql Custom Segmentation Rule page 

2. Enter a name and description for the new rule in the Rule Name and 
Description boxes.   

3. Define a command in the Commands box and then click Validate to ensure that 
the query is formatted correctly.  If the command is correct, then a SQL 
statement will be generated.  If not, you will receive a warning with information 
about how to fix any mistakes.  

4. Once the command has been validated, select a list and then click Test Against 
to verify the query will retrieve the information you want.  

5. Click Create to save this rule, or click Cancel to return to the Segmentation list. 

Defining a Command 

A command is composed of at least one field and operator, and can also include one or 
more values.  Common formats for commands include: 

• field + operator     (ie: custom_interest not exists) 

• field + operator + value (ie: first beginswith ‘bob’) 

Other example commands include: 

• zipcode > 98000 and zipcode < 98100  

• (company = 'ace' or company = 'acme') and updated_date > '2001-01-01'  

Parentheses, like in the example above, are necessary if you are checking more than 
two fields.  This helps the query group operations.  Use double (") or single (') quotes 
surround text or date values.  Numerical values do not need any special designations. 
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Fields 

The Fields list displays the default fields that are available to query.  You can also query 
custom fields by preceding the field name with custom_.  For example, a custom field 
called “interest” would be “custom_interest” within a Wsql segmentation rule.  As with 
standard segmentation rules, large text fields cannot be used in Wsql segmentation 
rules. 

The following table describes each default field: 

Tag Sample or Description 

email Subscriber's email address 

first or first_name Subscriber's first name 

last or last_name Subscriber's last name 

company Subscriber's company name 

address or address_1 First line of subscriber's street address 

address_2 Second line of subscriber's street address 

city Subscriber's city 

state Subscriber's state 

zip Subscriber's zip/postal code  

country Subscriber's country  

phone Subscriber's phone number  

fax Subscriber's fax number 

created date Date subscriber record was created 

updated date Date subscriber record was updated 

Operators 

The following operators can be used in a Wsql segmentation rule: 

Operator Type  Operator Description 

contains Does the field contain the value? 

beginswith Does the field begin with the value? 

Text Only 

endswith Does the field end with the value? 

= Is the field equal to the value? 

<> Is the field not equal (!=) to the value? 

> Is the field greater than the value? 

Numbers, Dates & 
Text 

>= Is the field greater than or equal to the value? 
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< Is the field less than the value? 

<= Is the field less than or equal to the value? 

exists Is the field present and have data stored? 

not For use with another operator to make a statement 
negative. 

The following are all acceptable ways to format dates in your Wsql segmentation rule: 

Format Example 

yyyy-mm-dd '2004-08-26' 

mm-dd-yyyy '08-26-2004' 

yyyy/mm/dd '2004/08/26' 

mm/dd/yyyy '08/26/2004' 

yyyy.mm.dd '2004.08.26' 

mm.dd.yyyy '08.26.2004' 

Applying Segmentation Rules 

Now that you’ve learned to create segmentation rules, it’s time to understand what to 
do with them.  Using WhatCounts, you can apply segmentations to split up a list at run 
(deployment) time, when exporting, or when creating sampling groups. 

Running Lists 

Running (publishing) is, perhaps, the place where segmentation will most often be 
applied.  To utilize your segmentation rules for running lists, select Lists > Run List 
(Deploy Campaign).  On the first screen displayed, select the name of your 
segmentation rule.  The first segmentation option will always be “All subscribers,” but if 
you have created your own rules they will appear in the drop down. 

After selecting one of your own rules and pressing the RUN LIST button you’ll get a 
count of the number of subscribers that match your rule.  In all likelihood this will be 
less than the total number of people in the list. 

From this point forward, the run process is the same as a normal run, except you’ll only 
be sending to some sub-group or segment that matches the criteria you defined. 
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Running Lists for Testing 

Running segmentation rules is an ideal way to perform testing.  Although there are test 
functions built into WhatCounts, there are some features which can only be tested by a 
list being deployed.  Examples are non-anonymous polls, unsubscribe-related links, and 
the Forward-To-A-Friend (FTAF) feature.  So, to test these features we recommend you 
create one or more segmentation rules that narrow your lists deployment to just you or 
a small group of people you have chosen as “testers.’ 

To create a rule that just matches you, add a new segmentation rule with the field name 
‘Email Address’, set the Comparison Operator to “[Text] equals,” then enter your email 
address in ‘Value.’  

To create a rule that matches everyone in your company, set field name ‘Email Address,’ 
set the Comparison Operator to “[Text] ends with,” then enter your company’s domain 
name in ‘Value.’ 

Note: If you are creating a Segmentation Rule with more than one 
email address, be sure to select OR as the Condition Type.  

Exporting Lists 

Segmentation rules are also useful when exporting your lists.  Suppose you wanted to 
collect and then export information associated with just one type of user – such as 
someone designated as a “member”.  Using Export Subscribers, select the list, then the 
name of the segmentation rule that identifies this group and continue as you normally 
would.  Instead of exporting all the entries in a particular list, this time only those 
subscribers that match your segmentation rule will be exported. 

N-Way Sampling 

Email is a perfect medium for testing new ways to communicate with your customers.  
It’s fast and relatively inexpensive.  N-way sampling is a feature which can be used to 
split up your lists into equally sized pieces so that you can perform different tasks with 
the subscribers defined by those pieces. 

For example, if you had three offers you wanted to test against a small list of 3,000 
users, you could use the N-Way Sampling to create segmentation rules that could be 
used to accurately separate your list three ways.  You could then send each of your 
offers to each of these segmentation groups and compare the results. 
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The N-Way Sampling can split a list into n pieces (you define the value of n) in a linear 
or random fashion.  In the case of our test group of 3,000 users, a linear separation 
would go through the first 1,000 people and assign them the number 1, the second 
1,000 the number 2, etc.  If you selected to break your 3,000 user list in 3 pieces 
randomly, then each person in the list would receive a 1, 2 or 3 in a random manner. 

N-Way Sampling can split up an entire list, or one defined by a segmentation rule.  So, if 
you wanted to test an offer to three groups out of a one million person list, you might 
select a segmentation that first pulled out 100,000 users – perhaps those belonging a 
certain state or matching other criteria.  Then, the wizard would begin splitting up that 
sub-group n-ways. 

 
Figure 31: n-Way Sampling Wizard 
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9. Polls 

WhatCounts has the ability to manage polls that you can include in email messages or 
on your web site.  Polls are a great way to capture information from your user 
community – either for business or entertainment reasons. 

Like other features within the WhatCounts system, polls collect and display their results 
in real-time.  They can operate in two modes: registered or anonymous. 

An anonymous poll can be accessed by anyone, anytime.  Results are collected, but 
there is no mechanism available to prevent ballot stuffing.  Likewise, there is no way to 
know who is participating in the poll. 

Registered polls, on the other hand, can only be accessed by recipients of your email.  
Ballot stuffing is prevented because only the first entry is counted for each participant.  
You can also generate a list of everyone that participates in your poll. 

 

Figure 32: Polls list page 

Creating a Poll 

Creating a new poll is easy: go to Content > Polls > Create New Poll.   

 
Figure 33: Access the Polls Menu 
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This will display the Edit/Add Poll page: 

 

Figure 34: Edit/Add Poll page 

You will need to provide the following information: 

Poll name: Users will not see this information; provide a name 
that’s useful to you. 

Question: What would you like to ask? 

Active: Check this box to permit entries to the poll. 

Anonymous: Is the poll anonymous, or should it be only for 
registered users?  If you want only registered users to 
enter, leave this box unchecked. 

Landing Page: Where users will be directed after successfully 
answering the poll. 

Error Landing Page: Where users will be directed if there is a problem with 
their poll entry. 

Choices: Up to ten can be entered. 
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You can also have the results of your poll available for users to view.  The “Results” 
section at the bottom of the Edit/Add Poll screen allows you to control the look and feel 
of the results that will be displayed. 

Results Template: Select a template you would like to use to display the 
poll results.  If [No Template] is selected, the default 
WhatCounts template will be used. 

Results Image: This is the image from which you would like your 
Results bar chart constructed.  The default image is 
blue, 1x1 pixel.  You can use any image you want for 
the results image, but keep in mind – it will be 
stretched when the results are displayed.  Gifs that are 
1x1 pixels seem to work best. 

Results Font: Choose the font or fonts you would like used for the 
results text.  Make sure you choose some common fonts 
in case the subscriber’s system cannot display your 
preferred choice. 

Max Pixel Width: This defines the maximum pixel width (horizontal size) 
of the bars in the bar chart.  This defaults to 100 but 
you can make it larger or smaller as needed.  The 
minimum pixel size is 10. 

Show Stats: This toggles the display of statistical numbers next to 
the bar chart.  With this turned on, the chart displayed 
will include either the number of responses for that 
answer or it's percentage in relation to the whole.  By 
default, stats are turned on. 

Result as %: Instead of displaying the actual number of responses, 
select this option to have the results displayed as 
percentages instead.  This is especially useful if you 
expect a small number of responses to your poll. 

That’s all that’s required to create a new poll.  You may create as many polls as are 
required for your campaigns. 

Testing Your Poll 

After you select the CREATE button on the Edit/Add Poll screen, you will be returned to 
the list of Polls, click on the test icon (gear) for any poll in the list.  Your poll will be 
shown and you’ll be allowed to test it.  Entries will be recorded and you’ll be able to see 
the results when you’re done.  If you entered a Landing Page, you will be taken to that 
URL after selecting ENTER.  Otherwise, you will be sent to the WhatCounts default thank 
you page. 

Note: In order to test your poll in this manner, it must be an 
Anonymous poll.  If your poll will not be anonymous, you 
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can temporarily set the poll as anonymous for testing, or 
run the list to yourself using a segmentation rule and test 
your poll that way. 

To view the statistics for your poll, select the VIEW STATS icon next to your poll name 
on the main Polls screen.  To clear the poll results after you have finished testing, open 
the Poll and then click the Clear Data button. 

Adding a Poll to your Email 

WhatCounts has a wizard that will create the HTML for your poll automatically.  On the 
main Polls screen, select the Wizard icon next to your poll name.  The only selection you 
need to make in the Poll Wizard is whether your poll will be used in an email or on a web 
page.  (A poll in an email will use a form method of “GET” while one on a web page will 
use “POST”.) 

Select the “Continue” button and you will be brought to a screen containing the HTML for 
your poll.  Copy this HTML into your template, or add it to the HTML for your webpage.  
As long as the poll is marked as active, responses for your poll will be tallied by the 
system. 

Note: In order to use a poll on a web page, it must be 
anonymous. 

Viewing Poll Results 

Since poll results are collected and stored in real-time, you can see them whenever you 
wish.  Just click on the icon of the pie chart under View Stats for the any poll in the poll 
list.  You’ll see the question you entered for the poll along with the total number of 
responses and which answers were chosen.  The information is displayed graphically. 

To send this information to yourself via email, click on the link labeled Email summary.  
To send the information along with a list of participants, click the link labeled Email 
summary w/respondents.  (You will only be able to obtain a list of respondents for polls 
that are not anonymous.) 

To clear the poll results, open the Poll and then click the Clear Data button. 
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Creating a Poll Result Template 

You can create templates for use with your polls, allowing you to customize the look and 
feel of a poll results page to match your own site.  A Poll will use the default WhatCounts 
templates, or you can create personalized templates for each page by using 
customization tags.  For a list of the customization tags and example form and template 
code, see Appendix B: Poll Templates. 

Poll Results can be accessed by directing users to  

http://www.whatcounts.com/bin/poll_results?id=<poll id> 

Where <poll id> is specific to the poll you have created.  You can find your poll’s ID by 
checking the code generated by the Poll Wizard.  The line of code which includes the ID 
will look something like this: 

<input type=hidden name="id" value="217"> 

In order to have users directed to your Poll Results template immediately after they 
have entered your poll, use the link above as the landing page for your poll.  For 
example: 

http://www.whatcounts.com/bin/poll_results?id=217 
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10. Surveys 

The WhatCounts Survey Tool allows you to create Surveys or quizzes and then deploy 
them to your subscribers.  A Survey consists of three components: a start page, one or 
more question pages, and an end page. 

The Start Page introduces the survey, allowing you to define its purpose and nature.  
The End Page concludes the Survey, displaying final messages or results. 

Each Question Page is comprised of Questions and Options, or answers.  There is no 
limit to the number of pages in a survey or the number of questions per page.  For 
example, you can create a single page of 80 questions, or you can split the questions 
into logical groupings and assign them to any number of pages. 

Each question can have any number of options.  Questions may be required or optional, 
and an option can be set as a correct answer for quiz-like Surveys.  

Surveys are accessed from the WhatCounts Content menu.  To access the Surveys, go 
to Content > Surveys.  This will open the Surveys page.  

 
Figure 35: Access the Surveys 

The Surveys page displays a list of the existing Surveys.  It is the starting point to 
create a new Survey, as well as copy or edit existing Surveys. 

 
Figure 36: Surveys page 
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Creating a Survey 

To create a survey, you must fill out several settings, create the survey questions and 
options, and assign the questions to one or more pages. 

To create a new Survey, go to Content > Surveys.  In the Survey page, click the 
Create a new Survey link at the top of the list. 

To copy an existing Survey, click the Copy button in the Action column for the Survey 
you would like to copy.  This will make an exact copy of the Survey including all Pages, 
Questions, and Options.  However, next page information defined at the Option level will 
not be copied because the identifiers for the fields are no longer valid.  You must 
redefine the next page definitions for each Survey. 

Survey Settings 

The first step to creating a Survey is to define its general settings.  The Survey page 
allows you to name and describe a Survey, choose the beginning or ending templates, 
and define the color schemes for the optional progress bar.  It also provides a list of 
links to the Questions Pages and the corresponding Questions. 

 
Figure 37: Survey page 
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The Survey page provides a form that allows you to set the following parameters: 

Field Definition 

Name Textbox to define the name of the Survey.  

Description Textbox to describe the Survey.  This information can 
also be displayed in the Start page. 

Active Checkbox to define whether or not the Survey is active. 

Display Description Checkbox to control whether or not the Description is 
included in the Start page.  This requires that the 
appropriate tag be used in the start template. See Start 
Page Template for more information.   

Start Template Listbox to select the template in which the first page of 
the Survey is displayed. 

End Template Listbox to select the template in which the final page of 
the Survey is displayed. 

Progress Bar - ‘ON’ Color Textbox to define a hexadecimal color, and color box to 
display the color. This color indicates the Survey pages 
that have been completed.  

Progress Bar - ‘OFF’ Color Textbox to define a hexadecimal color, and color box to 
display the color. This color indicates the pages that 
have not been completed. 

Progress Bar - Display Listbox to select how much information is displayed as 
part of the progress bar. The options are: 

None – no information 

Display Text – the name of the page (ie: start, page, 
finish) 

Display Page Number – the page number 

Display Text and Page Number – the page name and 
number 

Progress Bar - Page Text Textbox to define the text that is displayed in the 
progress bar for each page.  The default text is ‘page’. 

Update Button to save any changes made to the Survey. 

Describing the Survey 

The Description field allows you to explain the purpose for the Survey and can be 
displayed on the start page of the Survey.  To display the description, first enter text in 
the Description field and then select Display Description.   

If you are not using the default Start Template, then ensure that your template includes 
the appropriate tag to display the description.  See Start Page Template for more 
information on how to do this.  



WhatCounts User Manual 

 - 88 - 

Copyright © 2005 WhatCounts, Inc..  his document contains proprietary information that constitutes trade secrets and is not to be shared, copied, 
disclosed, or otherwise compromised without the prior written consent of the management of WhatCounts, Inc. 

Activating a Survey 

Users will be unable to access a Survey unless it is active.  To activate a Survey, select 
Active.  A    icon will appear next to the Survey on the Surveys page.  

To de-activate a Survey, unselect the Active option.  A    icon will appear next to the 
Survey on the Surveys page. 

Selecting Templates 

Surveys will render with basic formatting by default.  If you wish to change the 
formatting of the Survey, you can create and set your own template.  

To render the Survey with a template, select a template from either the Start Template 
or End Template listbox.   

If you need to define a template, click the Create a New Template link and follow the 
normal template creation steps.  For more information on the available tags for Survey 
templates, see Survey Templates below. 

Defining the Progress Bar 

A progress bar is often helpful to let a user know what they have accomplished and what 
remains to be completed.  For the Survey, you can define how the progress bar will 
render. 

 
Figure 38: Example Progress Bar 

To set the colors of the progress bar, enter hexadecimal numbers in the Progress Bar - 
‘ON’ Color and ‘OFF’ Color textboxes.  For example, the ‘ON’ color may be shown in 
Orange (FF9900) and the OFF color may be Gray (C0C0C0). 

To determine what will be displayed on the progress bar, select an option from Display.  
For example, select Display Text and Page Number to show the title of each page and 
the page number in the progress bar.  

To define the text that will be displayed in the progress bar, enter the text into the Page 
Text field.  For example, you may want each page to be referred to as ‘Section’. The 
default text is ‘page’.   
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Question Pages Management List 

This Survey page also lists the currently defined Question Pages and their associated 
Questions.  You can go directly to a Question Page or Question by clicking the link to 
each in the list.   

 
Figure 39: Question Pages List 

You can also change the order or delete Question Pages in the list. Deleting or 
reordering a Question Page will cause the remaining Question Pages to renumber, 
ensuring that the number order remains sequential. 

Creating and Editing Pages 

To create a new Page, click the Create a New Page link at the bottom of the Survey 
page. 

To edit a Page, click the link to the Page from the Page column in the list. 

Ordering Pages 

To reorder a Page, click the arrow buttons in the Order column for the Page.  

• Click  to move the Page to the top of the list as the first Page. 

• Click  to move the Page to the bottom of the list as the last Page. 

• Click  to move the Page up one. 

• Click  to move the Page down one. 

Deleting Pages 

To delete a Page, click the  button in the Delete Page column for the Page. 

While deleting pages is a valuable tool, it is also dangerous. Deleting a Page will also 
delete all associated Questions and Options.  Deleting a Page cannot be undone.  Before 
deleting a Page, verify that it does not contain any information that you wish to keep. 
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Survey Pages 

Survey Pages are very simple containers that allow you to define a template to use 
when displaying the page and to define Questions for the page.  A Page must be defined 
before Questions can be added to a Survey.  This is done by clicking the Create a New 
Page link at the bottom of the Survey page and then defining the Page settings. 

 

Figure 40: Survey Page # page 

The Survey Page # page allows you to set a template for the Page and define 
Questions as well as copy the Page to another Survey. 

Defining a Page Template 

Each Survey Page can be rendered in a different Template.  By default, every Survey 
Page will use the Default template defined in the WhatCounts platform.   

To change the template, select a predefined template from the Template listbox.  This 
list will include all templates that are defined in your customer realm.  You can also 
create a new template by clicking the Create a New Template link.  After selecting a 
template, click Update to save the settings. 

Copying a Page 

You can copy a Page, along with its related Questions and Options, to another Survey. 
However, next page definitions will not be carried over. 

To copy a Page to another Survey, select the Survey from the Copy Page to Survey 
listbox, and then click Copy.  When the copy is complete, the Survey to which the 
Questions Page was copied will display the Survey page. 
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Question Management List 

Each Survey Page # page lists the Questions defined for the Page.  You can go directly 
to a Question by clicking the link to each in the list.   

 
Figure 41: Question List 

You can also change the order of Questions or delete Questions from the list. Deleting or 
reordering a Question will cause the remaining Questions to renumber, ensuring that the 
number order remains sequential. 

Creating and Editing Questions 

To create a new Question, click the Create a New Question link at the bottom of the 
Survey Page # page. 

To edit an existing Question, click the link to the Question from the Question column in 
the list. 

Ordering Questions 

To reorder a Question, click the arrow buttons in the Order column for the Question.  

• Click  to move the Question to the top of the list as the first Question. 

• Click  to move the Question to the bottom of the list as the last Question. 

• Click  to move the Question up one. 

• Click  to move the Question down one. 

Deleting Questions 

To delete a Question, click the  button in the Delete column for the Question. 

Deleting a Question will also delete all associated Options.  Deleting a Question cannot 
be undone.  Before deleting a Question, verify that it does not contain any information 
that you wish to keep. 



WhatCounts User Manual 

 - 92 - 

Copyright © 2005 WhatCounts, Inc..  his document contains proprietary information that constitutes trade secrets and is not to be shared, copied, 
disclosed, or otherwise compromised without the prior written consent of the management of WhatCounts, Inc. 

Survey Questions 

Once you have created a Page, you can define Questions to fill the page.  This is done 
by clicking the Create a New Question link at the bottom of the Survey Page # page 
and then defining the Question settings.   

A Page can contain as many or as few Questions as you would like. 

 
Figure 42: Survey Question page with Option textbox 

The Survey Question page provides a form that allows you to set the following 
parameters: 

Field Definition 

Question Textbox to define the text of the Question. 

Type Listbox to select the form type to display the Question 
and its Options. Possible types are: 

Checkbox  
Radio Button 
Select/Option List (Drop Down)  
Select/Option List (Scrolling)  
Ranking Matrix/Table 
Text Box  
Text Area Field  
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Required Checkbox to define that the user must choose an Option 
for this Question before proceeding to the next page. 

Page Listbox to select on which Page the Question will appear.  

Align Form Field Listbox to select how the form field will be aligned next to 
the Option text.  Possible alignments are: 

Left – The text will appear to the left of the control. 

Right – The text will appear to the right of the control. 

Align Options Listbox to select how checkbox or radio button Options 
will be aligned in the form.  Possible alignments are: 

Horizontal –Options will appear in a row next to each 
other. 

Vertical – Options will appear in a column. 

Textbox/Select Size Textbox to define the width of a textbox field (if Text Box 
is selected) or the number of rows displayed in a select 
list (if Select/Option List (Scrolling) is selected) 

TextArea Rows Textbox to define the height of a textarea field by 
number of rows if Text Area Field is selected.  
(Recommended 5–10) 

TextArea Cols Textbox to define the width of a textarea field by number 
of columns if Text Area Field is selected.  (Recommended 
50-70) 

Ranking Range Textbox to define the number of radio buttons displayed 
to rank preference if Ranking Matrix/Table is selected.  
The default range is 10 and must be greater than 1. 

Ranking Width Textbox to define the width of the table if Ranking 
Matrix/Table is selected.  The default width is 80%, and 
must be 25% to 100%. 

Ranking “least” Text Textbox to define the description of a low ranking 
preference if Ranking Matrix/Table is selected.  The 
default text is << least. 

Ranking “most” Text Textbox to define the description of a high ranking 
preference if Ranking Matrix/Table is selected.  The 
default text is most >>. 

Options/Answers Textbox to define the Options or answers associated with 
the Question.  This textbox appears when a Question is 
first created and is replaced by an Option management 
list once at least one Option has been defined. 

Copying a Question 

You can copy a Question, along with its related Options, to another Survey; however, 
next page definitions will not be carried over.  This will create a new Page containing the 
Question and Options in the destination Survey.   
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To copy a Question to another Survey, select the Survey from the Copy Question to 
Survey listbox, and then click Copy.  When the copy is complete, the Survey to which 
the Question was copied will display the Survey page. 

Option Management List 

The Survey Question page lists the Options defined for the Question. You can go directly 
to an Option by clicking the link to each in the list.   

You can also change the order of Options or delete Options from the list. Deleting or 
reordering an Option will cause the remaining Options to renumber, ensuring that the 
number order remains sequential. 

 
Figure 43: Option List 

The Survey Question page lists the following information for each Option: 

Column Definition 

Answer Radio button to select this Option as the ‘correct’ answer 
to the Question. 

Order Button to arrange the order of the Options. 

Option The Options as text links to each Option’s settings. 

Next Page The id number of the page to go to if this Option is 
selected during the Survey 

Delete Button to delete the current Option. 

Table 1: Option List Details 

Creating and Editing Options 

When you first define a Question, the Options/Answers textbox will appear at the 
bottom of the screen.  You can define multiple Options by entering each Option on its 
own line.  Click Update to accept these changes. 

After the initial setup, the Options you have defined will appear in a list from which you 
can further select and modify each Option. 



WhatCounts User Manual 

 - 95 - 

Copyright © 2005 WhatCounts, Inc..  his document contains proprietary information that constitutes trade secrets and is not to be shared, copied, 
disclosed, or otherwise compromised without the prior written consent of the management of WhatCounts, Inc. 

To create a new Option after the initial setup, click the Create a New Option link at the 
bottom of the Survey Question page. 

To edit an existing Option, click the link to the Option from the Option column in the 
Option list. 

Defining an Answer 

To define an Option as the correct answer to a Question, select the radio button in the 
Answer column for the Option. 

To define a Question with no correct answer, select the [no answer] radio button 
beneath the Option Management List. 

This setting will be used when determining how many Questions the user had correct 
when the Survey is completed. If no Option is specified as the answer, or [no answer] 
is selected, then any answer is correct and will be counted as such. 

Ordering Options 

To reorder an Option, click the arrow buttons in the Order column for the Option.  

• Click  to move the Option to the top of the list as the first Option. 

• Click  to move the Option to the bottom of the list as the last Option. 

• Click  to move the Option up one. 

• Click  to move the Option down one. 

Deleting Options 

To delete an Option, click the  button in the Delete column for the Option. 

Deleting an Option cannot be undone.  Before deleting an Option, verify that it does not 
contain any information that you wish to keep. 
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Survey Question Options 

Each Question can have any number of possible Options.  An Option can be defined by 
clicking the Create a New Option link at the bottom of the Survey Question page and 
then defining the Option settings. 

 
Figure 44: Survey Option page 

On the Survey Option page, you can define the Option text to display, whether or not to 
display an optional textbox, and the next page to jump to if this Option is selected.  

Defining the Option 

Each Question must have at least one Option defined, even if it is a blank textbox.  To 
define the text for an Option, enter text into the Option textbox.  Click Update to save 
the settings. 

Using the Optional Text Box 

To collect more information for Radio Button and Checkbox type Questions, select the 
Display Optional Text Box checkbox. 

For example, if the Question is “Do you like Questions? If not Why?” and the options are 
Yes and No radio buttons, you can choose to have an additional textbox display next to 
the No radio button. 

Defining the Next Page 

You may want to allow a user to jump to a different Page depending on how they answer 
a particular Question.  To allow this, select the page from the Next Page listbox. 

For example, if the Question is “Do you own a home?” and the answer is No, you can 
choose to have the user skip the rest of the Questions on a page that may refer to 
owning a home by moving on to the next page of the Survey. 
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Testing the Survey 

You can run the Survey from the Surveys list to verify its functionality and format.  To 
run the Survey, click the  button from the Take Survey column in the list. 

Adding a Survey to an Email 

Anyone who receives a link to a Survey can take the Survey.  Surveys are essentially 
anonymous and are accessed via an encrypted key.  However, a users’ subscriber id or 
email address can be associated with the user by including either as part of the 
encryption key. 

Use the following format to include a link to the Survey in your email campaign: 

http://www.whatcounts.com/bin/usurvey?key=[id]&sid=%%SUBSCRIBER_ID_TAG%% 

Determining the Survey Key 

The [id] portion in the link should be replaced by the Survey key.  To determine this 
key: 

1. Go to Content > Surveys. 

2. Right click on the Take Survey button next to the Survey in the list page. 

3. Select Copy Shortcut. 

4. Paste the shortcut into a document (such as in Notepad).  It will appear 
something like this: 

javascript:launchURL('/bin/usurvey?key=C0128F2DAC9E35658C5442EF7FAB5B33',
640,480,1,1,'Review') 

5. Copy the value after "key=". 

6. Add the key value to the URL to create the link to your Survey.  For example: 

http://www.whatcounts.com/bin/usurvey?key=C0128F2DAC9E35658C5442EF7FAB5B3
3&sid=%%SUBSCRIBER_ID_TAG%% 

Sending the Survey Link 

In order to access the Survey, users must know the URL.  You can send the URL via an 
email campaign simply by adding it to the content of your Template.   
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Before deploying the URL, ensure that the link works by running a test campaign and 
clicking the link from the resulting email.   

If you plan to send the link in a Plain Text campaign, test the URL by copying and 
pasting it from the email message to ensure accessibility.   

Viewing Survey Results 

Once the Survey has been distributed, you can view the results.  To view the Survey 
results, click the  button from the View Stats column in the list. 

Customizing Survey Templates 

The Survey Tool uses three templates to format the pages in a Survey: a start page 
template, a Question page template, and an end page template.  A Survey will use a 
default WhatCounts template, or you can create personalized templates for each page 
using by customization tags.  For a list of the customization tags and example template 
code, see Appendix B: Survey Templates. 
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11. Blogs 

The WhatCounts Blog system provides an interface and tool very similar to some of the 
most popular blogging products on the market today.  At its heart, the WhatCounts 
blogging system is a way to create, edit and manage content.  This content can be: 

• used to display content on a web page, like a normal blog 

• included inside email templates so that they can be distributed via email  

• distributed through a syndication model like RSS 

A blog is a collection of entries.  You can create as many blogs as you like with as many 
entries within each blog.  Each entry is typically one or more paragraphs of text.  Blog 
entries can contain HTML which allows embedded images and links to other web-based 
content. 

Entries can then have comments associated with them.  This feature allows your blog to 
support some level of interaction with your readers.  Whether or not you allow 
comments to be made is left up to you to decide. 

The blogging system allows you to capture blog content and place it directly into your 
email templates.  The interface is intended to be utilized entirely within the WhatCounts 
system and has no external components or interfaces.  The risk of abuse from external 
forces is limited, providing a high measure of security.  Blog security profiles are 
respected through this interface.  So, if your blog has certain access requirements you 
may be required to provide credentials with your request.  IP addresses are 
automatically delivered to the interface, should they be required. 

The blog feature is complex and addressed in several sections: 

• Configuring Blogs includes the creation and editing of blogs and their 
properties, as well as testing the blog to ensure correctness. 

• Setting Blog Security describes how to create security policies. 

• Creating Blog Templates describes how to create or customize a template in 
which to display your blog. 

• Emailing Blog Content describes how to include blog entries in your campaigns. 

• Blogging includes using the blog features, such as posting entries and 
comments, in the actual Blog. 
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Accessing Blogs 

Blogs are accessed from the WhatCounts Content menu.  To access the Blogs, go to 
CONTENT > BLOGS > VIEW.  This will open the Blogs page. 

 
Figure 45: Access the Blogs Menu 

The Blogs page displays a list of the existing Blogs.  It is the starting point to create a 
new Blog, as well as to view or edit existing Blogs.   

 
Figure 46: Blogs Page 

From this page you can access an existing blog, post and entry to an existing blog, or 
create a new blog. 
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The Blogs page lists the following details for each Blog: 

Column Definition 

Blog Name The name of the Blog as a text link to each Blog’s 
settings and content. 

Most Recent Entry The date of the last entry posted to the Blog. 

Entries Total number of entries in the Blog. 

Total Comments Total number of comments in the Blog 

Comments If the Comments are enabled for the Blog, a  icon will 
appear in this column. 

Visible If the Blog is enabled for external access, a  icon will 
appear in this column. 

Private If the Blog security is set to Private, a  icon will appear 
in this column. 

Stats Button to view the Blog statistics. 

View Button to view the Blog. 

Table 2: Blogs List Details 

Creating/Configuring a Blog 

Blog creation and editing is performed through a simple tabbed interface.  The 
properties of a blog include general information, such as the blog name, as well as 
specific details to allow comments and images and provide blog security. 

To create a very basic new blog:  

1. Go to CONTENT > BLOGS > CREATE NEW BLOG.  This will display the 
Edit/Add a Blog page.  This page allows you to name the blog as well as 
navigate through several tabs where you can set the Blog properties.  Most of 
this information is not required to create a basic Blog. 
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Figure 47: Edit Blog Page 

2. Enter a name for the blog in the Name field.  This is the name that will be 
displayed using the %%blog.title%% tag in the Blog Page template (see Blog 
Templates for more information.) 

3. Click Create to save the Blog.  

The new blog will appear in the Blog List, and only the blog creator will be able to post 
entries. 

To make the blog more accessible, secure, and interesting, you can also set more 
advanced properties during the blog creation process.  To do this, select the tab that 
manages the properties you would like to edit, and make your changes.  These tabs 
include: 

• General – Basic Blog properties 

• Comments – Blog entry comment rules 

• Access – Options to access the blog 

• Security – Rules for accessing and posting entries 

• Tracking – Options to track click-throughs and trackbacks 

• Merging – Rules to merge content 

• Media – List of available media files 
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General 

The General tab allows you to specify basic Blog information, such as the description and 
how the blog is displayed. 

 
Figure 48: Edit Blog General Tab 

Description This field allows you to define the purpose of the blog.  
It can be displayed in your Blog using the 
%%blog.description%% tag. 

Template The Template listbox will list all default system 
templates, public templates created in other realms, and 
any templates created in the current realm.   

To see an example of a template, select it and then click 
the Preview link or button.  You can also add a new 
template or edit an existing template by clicking the 
Edit/Add Template link. 

Date Format You can define the way you would like the dates to 
display for blog entries by entering special characters.  
Default: yyyy-MM-dd HH:mm:ss z    

Image URL Blog templates support an image using the 
%%blog.picture%%.  You can define the URL in this field.   

Workflow Select this option to approve an entry before it is 
posted.  Enter one or more addresses, separated by a 
comma, in the text field.  When a new blog entry is 
submitted, an approval message will be sent to the 
address(es) indicated, allowing the entry to be reviewed 
before it is posted to the Blog. 
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Comments 

The Comments tab allows you to specify the whether or not the Blog will allow 
comments and in what manner. 

 
Figure 49: Edit Blog Comments Tab 

Comments To allow viewers to add comments to blog entries, select 
this option. 

Trackback Trackback allows you to track where viewers are clicking 
a link to view your blog entries.  To collect trackback 
statistics, select this option. 

Date Format You can define the way you would like the dates to 
display for blog comments by entering special 
characters.  Default: yyyy-MM-dd HH:mm:ss z    

Workflow Select this option to approve a comment before it is 
posted.   

Registration Viewers can either post comments anonymously or they 
must be registered.  If viewers are required to register, 
then you can also choose to require that the registration 
is approved.   

Anti-Robot When viewers register to post comments, you can also 
require them to verify that the registration is real, not 
an attack by an auto-registration robot.  When this 
option is selected, the viewer will be presented with an 
image that displays a variety of numbers and letters.  
The user must type in the correct numbers and letters 
to complete the registration. 
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Access 

The Access tab displays a list of URLs from which your blog can be accessed and allows 
you to send a message with a link to your blog.   

 
Figure 50: Edit Blog Access Tab 

URLs The multiple access URLs allow you to choose how you 
would like the URL to appear in a browser address bar.  
You can select any of the URLs to represent the link to 
your Blog.  Click any of the links to test that the Blog 
opens as expected. 

Invite a Friend Clicking the link will display a pop up window.  In this 
window you can specify an email address to send a 
message, as well as edit or change the Subject line and 
content of the message. 



WhatCounts User Manual 

 - 106 - 

Copyright © 2005 WhatCounts, Inc..  his document contains proprietary information that constitutes trade secrets and is not to be shared, copied, 
disclosed, or otherwise compromised without the prior written consent of the management of WhatCounts, Inc. 

 
Figure 51: Blog Link Sending form 

Security 

The Security tab allows you to specify the security access level for the Blog and for 
posting Blog entries. 

 
Figure 52: Edit Blog Security Tab 
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Blog Access When a Blog is created, anyone with access to the URL 
can view it.  To limit access, you can set the access level 
to Private and then select a Policy from the drop down 
list.   

Creating Entries For a basic Blog, only the original creator can add Blog 
entries.  To allow other users to post entries, you can 
set the access level to a specific Policy selected from the 
drop down list. 

To edit or create a new access policy, click the Edit/define policies link.  This will display 
the Blog Security Policies page.   

Tracking 

The Tracking tab allows you to specify if click-throughs are tracked. 

 
Figure 53: Edit Blog Tracking Tab 

Links Click-through tracking is supported for URLs included in 
Blog entries.  To collect click-through statistics, select 
this option. 

Merging 

The Merging tab allows you to select content from other blogs to merge into your blog. 

 
Figure 54: Edit Blog Merging Tab 
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Media 

The Media tab allows you to upload files or folders to the Blog section of the Media 
Manager for use in your blog. 

 
Figure 55: Edit Blog Media Tab 

The Media tab works in the same manner as the Media Manager.  To upload a file: 

1. Next to the File name text box, click Browse to find and select the file. 

2. Click the Upload File icon  to upload the selected file. 

The uploaded file will appear in the file list below, displaying the size of the file and the 
date it was uploaded.  To view the file, select the link in the File Name column.  To 
delete a file, click the  button in the Delete column for the file.  

Though the file is stored in the Media Manager, you will need to modify the Media 
Manager URL to ensure the path is correct.  The path will be similar to the following: 

http://media.whatcounts.com/[realm_name]/_blog/[blog_id]/[file_name] 

Where [realm_name] is the name of your realm, [blog_id] is the id number of the blog, 
and [file_name] is the name of the file that you uploaded. 

Maintaining Blog Configuration 

Once you have created a blog, you may find that you need to edit the properties or 
delete the blog from the system. 

Editing a Blog 

To edit an existing Blog or view the current settings: 
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1. Go to CONTENT > BLOGS > VIEW to view the list of blogs.   

2. Click the name of the Blog from the Blog Name column in the list.  This will open 
the Edit/Add a Blog page, displaying the blog properties. 

3. Edit the blog and then click Update to save the changes. 

Deleting a Blog 

To delete a Blog: 

1. Go to CONTENT > BLOGS > VIEW to view the list of blogs.   

2. Click the name of the Blog from the Blog Name column in the list to open the 
Edit/Add a Blog page. 

3. Click Delete to delete the blog, its content, and statistics. 

Warning: Deleting a blog will remove it as well as its associated 
content and statistics, from the database.  Any links to the 
blog will no longer work, so be sure to update any active 
templates or web pages that call or reference the blog. 

Testing the Blog 

After you select the Create button on the Edit/Add a Blog page, you will be returned 
to the list of Blogs.  Before you make your blog public, be sure to check that the layout 
and formatting are as you expect.   

To view or test the Blog, click the  button from the View column in the list.  Your blog 
will be displayed in a new window.  This is the actual working blog.  Navigate through 
any links that have been included and ensure your blog is setup correctly.   

You can also view your blog from the Edit/Add a Blog page when you edit your blog by 
clicking the  button near the bottom, left of the page.  However, any changes you 
have made will not be reflected until you click Update to save your changes. 

Viewing Blog Statistics  

The Blog feature provides graphs of statistics related to your Blog.  This includes the 
total visits, the top referrers, the top domains of visitors, the number of hits through 
RSS feeds, and information about click-throughs.   

To view the Blog statistics: 
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1. Go to CONTENT > BLOGS > VIEW. 

2. In the row of the Blog you wish to view, click the  button from the Stats column.  
This will display the Blog Statistics page. 

 
Figure 56: Blog Statistics page 

The top of the Blog Statistics page displays some basic information about the blog.  
The name of the blog is followed by several links: 

• View displays the blog in a new window 

• Configure opens the blog settings in the Edit/Add a Blog page 

• Post New Entry opens the Entry Wizard.   

Also listed are the name of the template that the blog is displayed in, the date the blog 
was created, and the date of the last post. 

Statistics and Charts 

The blog statistics are displayed in several charts with the option to see the last 24 
hours, seven days, two weeks, or last month.  In addition, you can view which links 
have been clicked and how many times.  To access each chart or graph, click the related 
link.  

Overview Select Overview to display a line graph of the total 
number of visits to the blog in the selected period. 
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Top Referrers Select Top Referrers to display a pie chart of domains 
from which viewers accessed the blog in the selected 
period. 

Top Domains Select Top Domains to display a bar chart of the total 
number of visits per domain in the selected period.  

RSS Select RSS to display a line graph displaying the total 
number of visits to the blog from an RSS feed in the 
selected period. 

Click-Throughs Select Click-Throughs to display the URLs defined in 
your blog and the total number of clicks each has 
generated in the selected period. 

Raw Data Report 

In addition to viewing the statistics in several charts, you can also create a report file.  
To create a report of the statistics: 

1. Click the Download raw data of this blog link.  This will display the Download 
Blog Tracking Raw Data page. 

2. In the Duration field, enter at least a From date in the format ‘yyyy-mm-dd’.  If 
you would like to report up to the current date and time, then leave the To date 
blank, otherwise, enter an ending date in the field. 

3. Select the Format you would like the save the file as.  The default is .csv, or 
comma separated. 

4. Click GO to create the file.  You will be prompted to approve the file creation and 
the next page will indicate the format of the file name and the fields in the 
resulting file. 

5. The file will be created and saved to the File Manager.  Go to CONTENTS > FILE 
MANAGER and select the blog data folder to access the file. 

Emailing Blog Content 

Blog content can be pulled into regular email templates and used as a way to connect 
collections of related information with email readers.  If you are familiar with the 
WhatCounts articles, blogs offer similar functionality.  Since blogs are collections of 
entries, you can think of their use within email templates as a way of include many 
related articles. 

The tag %%blog “<blog_name>”%%, where <blog_name> is the name of the blog, is all that is 
required to insert a blog into an email template.  The content will be inserted using the 
template you have associated with the blog.   
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For example, the following tag added to a template will insert the blog named “MyBlog” 
when the template is sent in a campaign: 

%%blog “MyBlog”%% 

Note: You may wish to limit the number of entries that are 
inserted into your template, especially because blogs can 
contain a great deal of content.  Caution should be applied 
when inserting blogs, and testing is strongly advised since 
you do not want to email a message that is too large. 

Permalink 

In the event that you do not have the blog’s name, you can instead specify its permalink 
ID (PID) using the attribute “pid=<permalink_id>”: 

%%blog “pid=<permalink_id>”%% 

For example, the following tag would insert the blog with PID #7752631F0E26F51D: 

%%blog “pid=7752631F0E26F51D”%% 

Advanced Blog Attributes 

Since a blog may not be appropriate for direct insertion into email, you can include 
additional information, or attributes, with the tag to specify other formatting options.  To 
use advanced attributes, you must first explicitly define the name of your blog using the 
attribute “name=<blog_name>”: 

%%blog “name=<blog_name>”%% 

A blog with the specified name from the current realm will be used.   

Templates 

The “look & feel” of your blogs, entries and comments are controlled by templates that 
you create and maintain on the WhatCounts platform.  The templates control how blog 
content appears when viewed on a web page.  When used within an email template you 
may want your blog content to appear differently.  You can create and specify 
alternative templates for formatting blogs in email. 

You can select alternate templates for your blog using the template attributes.  A 
template can be designated by the template name, ID number, or family. 

The template can be designated as follows: 
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Attribute and Option Description 

template=<template_name> Displays the blog in the template of template_name. 

template_id=<template_id> Displays the blog in the template of template_id. 

template_family 
=<template_family> 

Displays the blog in the template of template_family.  
This allows different entry types to share a common 
template. 

Use the above attributes to display the blog: 

%%blog “name=<blog_name>&template=<template_name>”%% 

%%blog “name=<blog_name>&template_id=<template_id>”%% 

%%blog “name=<blog_name>&template_id=<template_id>”%% 

For example, the following tag would insert the blog named “MyBlog” formatted by the 
template “email”: 

%%blog “name=MyBlog&template=email”%% 

Elements 

You can insert specific elements from your blog by specifying an element in the blog tag.  
Blogs have several key fields that can be inserted into your content.  By default, the 
entire blog and its related entries are inserted by the blog tag.  Use the attribute 
“element=<element>” to include specific components of the blog:  

%%blog “name=<blogname>&element=<option>”%% 

For example, the following tag would insert the blog name “MyBlog”, the date the blog 
was created, and a list of the recent entries: 

%%blog “name=MyBlog&element=created&element=recent_entries”%% 

The following elements can be specified: 

Option Description 

created Displays the date the blog was created. 

entries Displays the blog entries. 

recent_entries Displays a list of recent entries, similar to a table of 
contents. 

entry_count Displays the number of entries visible. 

Realms 

In the case of parent and children realms, you may wish to display content from an 
alternate realm.  Use the attribute “realm=<realm_name>” to include content from a 
specific realm: 
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%%blog “name=<blogname>&realm=<realm_name>”%% 

For example, the following tag would insert the blog name “MyBlog” and from the realm 
“MyRealm”: 

%%blog “name=MyBlog&realm=MyRealm”%% 

A Permalink also contains realm information and can be used alone. 

Security 

If a security policy is associated with your blog, you may be required to provide 
additional information to validate users.  This can be done by explicitly specifying the 
user name and password to access a specific blog.  Use the attributes 
“user=<user_name>” and “pwd=<password>” to include this information: 

%%blog “name=<blogname>&user=<user_name>&pwd=<password>”%% 

For example, the following tag would insert the blog name “MyBlog” and allow the user 
“Mary” with the password “mypass” to access the blog: 

%%blog “name=MyBlog&user=Mary&pwd=mypass”%% 

Debug Mode 

If a blog cannot be found, or the security attributes are not sufficient to gain access, the 
blog command will render an empty space in the template instead of entries.  If you are 
testing the interface, you can include the “&debug=1” attribute to display error and 
diagnostic information which may help you determine the reason why the blog is not 
rendering.  

For example, the following tag would insert the blog name “MyBlog” and allow the user 
“Mary” with the password “mypass” to access the blog.  If the security permissions fail, 
then an error will be displayed instead: 

%%blog “name=MyBlog&user=Mary&pwd=mypass&debug=1”%% 

Blog Entry Attributes 

When blog entries are displayed, you can specify how you would like them to appear, 
such as the order in which they should be sorted.  You can also limit the entries to 
display only a certain number or up to a certain time frame. Like advanced attributes, 
you must explicitly define the name of your blog using the command “name=<blog_name>”. 
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Limit by Number 

Blogs can contain many more entries than you would like to include in your email 
content.  You can limit the number of entries that are displayed by using the 
“count=<number>” command. 

%%blog “name=<blogname>&count=<number>”%% 

For example, the following tag would insert the blog named “MyBlog” and the five most 
recent entries: 

%%blog “name=MyBlog&count=5”%% 

You can also include other tag commands to control sorting and formatting.   

The “limit=<number>”t command can also be used to control the number of entries 
included in the email. 

Limit by Date 

You can limit which entries are inserted into the template using the 
“<date_attribute>=<option>” attributes and options.  You can use it to specify blog 
entries for a particular day or a date range. 

%%blog “name=<blog_name>&<date_attribute>=<option>”%% 

For example, the following tag would insert the blog named “MyBlog” and display only 
the entries that were added in the current month of June: 

%%blog “name=MyBlog&date=june”%% 

The following tag would insert the blog named “MyBlog” and display only the entries that 
were added on the 27th day of March in the year 2005: 

%%blog “name=MyBlog&day=27&month=3&year=2005”%% 

The date_attribute can be defined using one of the following attributes: 

Attribute Description 

year=<year> Displays entries inserted during the designated year. 

month=<month> Displays entries inserted during the designated month. 

day=<day> Displays entries inserted during the designated day. 

date=<date> Displays entries inserted during the designated date.  In 
the absence of complete date information the current 
day, month, and year is assumed.   
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The date_attribute supports the following options.  In the absence of complete date 
information, the current day, month and year is assumed: 

Option Description 

<year> Displays entries inserted during the designated year.   

For example: year=2005 

<month> Displays entries inserted during the designated month. 

For example: month=3 

<day> Displays entries inserted during the designated month.  

For example: day=27 

yesterday Displays entries inserted yesterday. 

For example: date=yesterday 

thisweek Displays entries inserted during the current week. 

For example: date=thisweek 

thismonth Displays entries inserted during the current month. 

For example: date=thismonth 

<date> Displays entries inserted during the designated month.   

For example: date=june 1, 2004 or date=june, 2004 

<range> Displays entries inserted during the designated date 
range.  The hyphen (-) character is used to separate the 
two ranges, of which there must always be two 

For example: date=june-july or date=june1-june5 

Sort Override 

Blog entry sorting is normally controlled by the blog’s settings as defined through the 
blog editor.  To override these settings you can use the “sortby=<option>” command. 

%%blog “name=<blogname>&sortby=<option>”%% 

For example, the following tag would insert the blog named “MyBlog” and sort the 
entries by date, with the most recent entry first: 

%%blog “name=MyBlog&sortby=date”%% 

The sortby command supports the following options: 

Option Description 

date Sort entries by date, with the most recently created first. 

%%blog “name=MyBlog&sortby=date”%% 
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date_desc Sort entries by date, with the most recently created last. 

%%blog “name=MyBlog&sortby=date desc”%% 

alphabetical Sort entries alphabetically by entry title. 

%%blog “name=MyBlog&sortby=alphabetical”%% 

alphabetical_desc Sort entries reverse alphabetically by entry title. 

%%blog “name=MyBlog&sortby=alphabetical desc”%% 

ranking Sort entries based upon their ranking as defined through 
the UI. 

%%blog “name=MyBlog&sortby=ranking”%% 
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12. Research and Analysis 

The Research tab in the WhatCounts user interface is the entry point for the real-time 
analytical reporting.  It’s here that you’ll go to obtain open and click-through tracking 
information as well as bounce and opt-out data. 

Campaign List 

Whenever you run one of your lists you are creating a campaign.  The only exception to 
this is when a list has been defined to use a sticky campaign number.  In this case, only 
a single campaign is created the first time the list is run.  The WhatCounts system 
records the start time for each campaign run and that information is shown in the 
campaign list.  To view the Campaigns list, go to Research > View Campaigns.   

 
Figure 57: Campaigns list page 

By default, the list shows the last five campaigns run.  You can change how many 
entries are shown by selecting a different value in the appropriate drop-down list.   

To obtain more detailed information for a particular campaign, click on its name.  This 
will display the Campaign Details page. 
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Figure 58: Campaign Details page 

Open Rates 

The first screen of the detailed campaign view will show the total number of pieces read 
as well as calculating the open rate.  The open rate only represents the number of HTML 
recipients that opened your message.  As there is no way to calculate open rate on text 
messages, it may or may not represent the actual number of people that read your 
content. 

Additionally, the preview window of Microsoft’s Outlook email clients will trigger the open 
detection system of WhatCounts giving you, perhaps, a false positive indication of your 
campaigns effectiveness. 

Click-Through Data 

Click-through statistics are also available on the first screen, where open rates are 
described.  To see which of your message’s links were actually clicked, and which were 
the most popular, select the Click-throughs tab. 

Here you’ll see a list of links with the most popular ones shown first.  For each entry 
you’ll see the total number of times the link was clicked, the total number of unique 
users for each link, the percentage of time that link was clicked relative to all the 
messages sent as well as relative to all the other links. 
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Click-through statistics are a great way to gauge the effectiveness of your campaigns.  
They can’t be fooled by Outlook’s preview window and WhatCounts can track them for 
plain-text and AOL messages in addition to HTML. 

Detailed Click-through Tracking 

It is possible to actually see which of your subscribers clicked on a particular link.  To do 
so, click on the number under the unique column in the click-through report. 

If the number of unique users is high, you’ll be warned that displaying the information 
could take a while.  The actual amount of time depends upon your connection speed and 
the number of subscribers.  Displaying 1,000 names, for example, could take several 
seconds – even with a fast connection.  The delay is largely related to your web browser 
having to draw 1,000 rows in a table.  It’s simply a lot of data. 

How you use this data is entirely up to you and your organization.  WhatCounts suggests 
that you use it wisely and consider the bond you have with your customers to be one of 
trust.  This feature wasn’t designed for “Orwellian” or spying purposes.  Instead, it was 
designed to give you some greater visibility into the effectiveness of your email 
messaging initiatives. 

Bounces 

Select the Bounces tab to get more detailed information about the number of bounces 
received as a result of your campaign.  Click the DETAILS link next to the number of 
hard or soft bounces for more information about the bounces. 

Hard Bounces A hard bounce is a message that couldn't be delivered due to a 
mailbox or system no longer existing.  There's usually no recovery 
from this type of event and the system will automatically 
unsubscribe the "bounced" user.   

Soft Bounces A soft bounce is a message that couldn't be delivered due to a 
mailbox being temporarily full or a message being sent from the 
user's system indicating they're on vacation, or some similar, 
informational-type response.  A soft bounce will never turn into a 
hard, and those subscribers will not be removed from your list.   

Manual Opt-Outs This value indicates the number of recipients of your message that 
manually opted-out or unsubscribed.  The total number of 
unsubscribes usually equals the total number of manual opt-outs 
plus the total number of hard bounces.   

Note: Bounce statistics can only be accumulated if you are using a 
WhatCounts bounce address for your list. 
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Top Domains 

The Top Domains tab shows you the domains that make up the majority of opens and 
click-throughs for your campaign. 

Compare 

The Compare tab shows the open and click-through rates for the last few similar 
campaigns.  Also on the Campaign Detail screen are the following links: 

• HTML – Displays a “snapshot” of the HTML content that was sent out for this 
campaign. 

• Plain-Text – Displays a “snapshot” of the plain-text content that was sent out for 
this campaign. 

• Flex-URLs – Allows you to change any of the URLs in the email that was sent out 
to your subscribers.  To change a URL, select the Flex-URLs link and choose the 
URL you would like to change.  A text box will open with the current URL.  
Change it to whatever you wish and hit UPDATE.  The next time someone selects 
this URL in your email (even if they had selected it previously), they will be 
redirected to the new location. 

Archive Viewer 

You can view an archived copy of any campaign that has been sent.  In the Campaign 
Overview page, click Archive Links to display the Archive Viewer page.   

Archive Viewer Link Generator 

The first set of links can be used to display the content from the selected email 
campaign in either HTML or Plain-Text format.  You can either select the Plain-Text link, 
or explicitly specify plain-text content by adding one of the following to the end of the 
HTML URL:  

• &html=0  

• &format=p  

• %format=t  
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Most Recent Campaign Link 

The next set of links can be used to display the most recent campaign for the list 
corresponding to the selected campaign.  These links will always display the most recent 
campaign.  It can be used elsewhere, such as in web pages or other email messages, to 
access a copy of the most recent campaign.  

You can filter out test deployments so they will never be shown by specifying a minimum 
number of recipients.  To do this, add “&min=number” to the end of the URL, where number 
equals the minimum number of recipients.  For example: Adding “&min=100” would 
instruct the archive viewer to find the last campaign for the specified list which was sent 
to at least 100 recipients: 

http://whatcounts.com/bin/archive_viewer?id=935343FFF&min=100  

If you would like to allow readers to access past versions of your campaign, you can add 
an optional element to specify the position.  To do this, add “&position=number” to the 
end of the URL, where number equals the relation in deployment time and date of the 
campaign to the current campaign.  For example: Adding “&position=2” would show the 
second most recent issue and “&position=3” would show the 3rd most recent. 

http://whatcounts.com/bin/archive_viewer?id=935343FFF&min=100&position=2 

Flex URLS 

If you have run a campaign and discover that a link is going to the wrong URL, you can 
fix the link to point to the correct location.  This can be done using Flex URLs.   

Flex URLs are only available for campaigns that have click-through tracking enabled.  
Only links that are tracked will appear in the Flex URLs list.  Any links that are part of 
the Tracking Exclusions will not be changeable, and this includes the unsubscribe link, as 
well as any links that include the tag %%SUBSCRIBER_ID_TAG%%. 

Accessing and Editing Flex URLs 

To access Flex URLs for a specific campaign: 

1. Go to RESEARCH > VIEW CAMPAIGNS. 

2. Select the campaign from the Campaigns list. 

3. In the Campaign Overview page, click the Flex URLs link to display the 
Campaign URLs page, which includes a list of all the tracked URLs in the 
campaign.  
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To fix a URL, click the full URL from the URL list and then make a change in the 
Updated textbox.   

Click Update to save the changes, or Cancel to return to the Campaign URLs page. 

The next time a recipient clicks the updated URL in your campaign, they will be directed 
to the new location. 

Testing Flex URLs 

To test a URL to ensure it works, click the  button next to the URL in the Flex URL list.  
This will open the link in a new browser window. 

Report Wizard 

There will be times when you want to be able to select specific campaigns to compare 
open and click-through statistics.  The Report Wizard is the perfect utility to perform this 
function.  By completing a few simple steps you can create a report that compares 
multiple campaigns with one another. 

Criteria On this page of the Report Wizard, you will make 
selections that will narrow down the campaigns you'd 
like to compare.  You can use any or all of the selection 
criteria.   

Note: Campaigns previously marked as hidden will not 
be shown. 

Select This screen will display the campaigns that match the 
criteria you have entered.  Select the campaigns you 
would like to compare, then hit the CONTINUE button. 

Custom Data This screen will display all of the Custom Fields in your 
realm as well as the possible event types.  Select the 
items you would like included in your report. 

Options The final screen in the Report Wizard allows you to 
select how your data will be presented.  You can choose 
to have a copy of the report sent to you via email or 
save copies in both HTML and CSV to the Reports folder 
of the File Manager area.  If you'd like to provide a 
custom name for the files, you can do so by entering 
text in the field labeled Report Name. 
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Event Wizard 

The Event Wizard allows you to create a list of email addresses of subscribers who 
engaged in various events of your campaign(s).  For example: opens, click-throughs, 
subscribes, or unsubscribes.  This report differs from the one generated through the 
Report Wizard as the report will include the email addresses of specific subscribers.  The 
Report Wizard, on the other hand, includes only general statistics without specific 
subscriber information. 

Criteria On this page of the Event Wizard, you will make 
selections that will narrow down the campaigns from 
which you'd like to pull subscriber events.  You can use 
any or all of the selection criteria.   

Note: Campaigns previously marked as hidden will not 
be shown. 

Select This screen will display the campaigns that match the 
criteria you have entered.  Select the campaigns from 
which you'd like to pull subscriber events, then hit the 
CONTINUE button. 

Data This screen will display the Subscriber Data and Custom 
Fields in your realm as well as all Tracking Events.  
Select the items you would like included in your report. 

Delivery The final screen in the Event Wizard allows you to select 
how your data will be delivered.  You can choose to 
have a copy of the report saved to the File Manager, 
Add Subscribers to a pre-existing list, or create one with 
the data that result from this process.  Select the 
CONTINUE button to start the creation of your report or 
new list.  You will receive an email when the process is 
complete. 

Friendly URLs  

Friendly URLs are labels to help you easily identify click-through URLs in your 
campaigns.  URLs can often be very long and hard to recognize when displayed in a 
report.  To make a URL more easily recognizable, you can assign a label to it and then 
display the Friendly URL in your reports. 

Friendly URL labels can be entered manually on a URL-by-URL basis or can be 
automatically labeled based on pattern recognition.  For example, if you have several 
URLs to a site called MySite that start with the pattern http://www.mysite.com, you can 
setup a Friendly URL pattern to automatically label all matching URLs as MySite. 
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Friendly URLs are only available for campaigns that have click-through tracking enabled.  
Any links that are part of the Tracking Exclusions will not support Friendly URLs.  This 
also includes the unsubscribe link, as well as any links that include the tag 
%%SUBSCRIBER_ID_TAG%%. 

Accessing and Editing Friendly URLs Manually  

Friendly URLs can be accessed through either a specific template or a specific campaign.  
This allows you to either set the Friendly URLs ahead of time through the template so 
that all campaigns run with the template will use the same friendly names, or you can 
specify friendly names on a campaign by campaign basis. 

From a Template 

Before you can edit Friendly URLs in a template, you must create and save the template 
first.  This is necessary in order for the database to recognize the URLs in the template 
before displaying them in the URLs page.   

To access Friendly URLs for a specific template: 

1. Go to CONTENT > TEMPLATES > VIEW TEMPLATES. 

2. Select the template from the Templates list. 

3. In the Edit/Create Template page, click the View URLs icon or link 

 to display the URLs page, which includes a list of the fully qualified 
URLs found in the Template and any exclusions associated with those URLs.   

Te set a Friendly URL, enter a label in the Name column next to the URL and then click 
Update Names.  The page will refresh and the new label will be saved. 

Any URLs that are part of the Tracking Exclusions will appear with a red X  icon in the 
Exclude column.  If you attempt to label a URL that is excluded, the page will refresh 
and the label will not be saved. 

To cancel any changes, just click the Back button on your browser or the template link 
above the list. 

From a Campaign 

To access Friendly URLs for a specific campaign: 

1. Go to RESEARCH > VIEW CAMPAIGNS. 
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2. Select the campaign from the Campaigns list. 

3. In the Campaign Overview page, click the Flex URLs link to display the 
Campaign URLs page, which includes a list of all the tracked URLs in the 
campaign.  

To set a Friendly URL, enter a label in the Friendly Name column next to the URL and 
then click Update Names.  The page will refresh and the new label will be saved. 

To cancel any changes, just click the Back button on your browser or navigate away 
from the page. 

Creating Friendly URL Patterns 

Friendly URLs can be set globally within a realm by creating URL patterns.  The patterns 
you create allow your campaigns to automatically match URLs to a preset Friendly 
Name.  Each pattern includes the type of match it will be, the text to match, and the 
name of the Friendly URL 

To create Friendly URL patterns: 

1. Go to RESEARCH > FRIENDLY URLS.  This will display the Friendly URLs 
page.  Each row represents a defined pattern. 

2. Select a match type from the Type list box.  A type can be one of the following: 

• EQUALS – the URL is the same as the defined Text 

• STARTS WITH – the first portion of the URL matches the defined Text 

• CONTAINS – within the URL, the defined Text can be found 

• ENDS WITH – the last portion of the URL matches the defined Text 

3. Define the text to compare against in the Text box.  This can be a full or partial 
URL, as well as any combination of words or names that you would find in a URL.  
For example: 

• http://www.mysite.com 

• https:// 

• /folder/filename.extension 

• .asp 

4. Enter the new URL label, or Friendly URL, in the Name text box.   

5. Click Update to save the pattern.  You can also enter more than one pattern at a 
time, and just click Update after all the patterns have been entered. 
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Each row in the Friendly URLs page represents a defined pattern.  Though the page 
shows only three rows by default, as soon as the three are filled and updated, three new 
empty rows will be added at the end of the list. 

Reporting with Friendly URLs 

The main purpose of Friendly URLs is to make viewing report results much easier.  To 
display Friendly URLs in your reports, you first need to have defined the Friendly URL.  
You can then run a report as you normally would.  All URLs that have been labeled will 
appear next to the URL that it refers to, allowing you to quickly determine the purpose 
or content of the URL. 

Event Chart 

The Event Chart allows you to see a graphical representation of tracking events from 
one particular list or your entire realm over an eight day period of time.  To access the 
Event Chart, select that option from the RESEARCH drop-down.  Select the Event Type, 
and select the List name from Show events for list listbox. 

A bar chart will be displayed with statistics for the last eight days.  The Event Chart can 
also be seen directly from the Campaign Details screen by selecting the pie charts next 
to opens or click-throughs on the Campaign Overview tab. 

History 

The History feature in WhatCounts is similar to what you’ll find in your browser.  
However, instead of simply tracking where you've been, the WhatCounts History feature 
tracks actions performed by you or other users in your realm.  This might include editing 
lists and templates, deploying campaigns, or searching for subscribers.  

To view your realm's recent history, click on the History item under the Customer Center 
drop-down.  

Your Own History 

Wouldn't it be convenient if the system could keep track of what you've been doing and 
present you with shortcuts so you could quickly initiate common tasks?  Tired of 
navigating our menus as you edit templates and articles repeatedly?  
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If you answered “yes” to these questions you'll want to enable the My History feature.  
To do so, simply select the My Profile item from the Customer Center drop-down.  Then, 
mark the checkbox labeled Enable the My History feature.  A new menu item will appear 
in the Customer Center drop-down titled My History.  From the My History you'll be able 
to see all the things you've been doing.  Simply select any of those items to quickly 
repeat a task.  

Note: Only tasks we have deemed good candidates for safe, 
automated repeating are presented in the My History menu.  
For example, we purposefully don't include things like 
deleting lists or templates as those activities should be 
tackled with care. 

Create New User 

If you have Administrator access, you can easily create accounts for other individuals in 
your office who you would like to use the WhatCounts system.  For security reasons, it is 
preferable to have individual accounts for users rather than creating a generic, shared 
account.  Another reason it’s good to have an account for each user is that reports and 
notices of task completion (like subscriber imports or list runs) are emailed to the 
address of the individual who is logged in. 

To add a new user, select the Create New User option from the CUSTOMER CENTER 
drop-down.  At minimum, you should enter an email address, phone number, and first 
and last name for each user.  You will also need to select a permission level that is 
appropriate for the access you would like that individual to have. 

Permissions Description 

Administrator Anyone with the admin permission level can create, edit and delete 
lists, templates and subscriber records.  They can also view all research 
material and modify user accounts through this page.  An Administrator 
has complete access to the data within your realm. 

Editor An Editor is allowed to modify template content and run list tests.  They 
can also view Research information.  However, they can't create, 
update, delete lists or deploy campaigns. 

Support This is the permission level you might give to a support person in your 
company - someone you would want to allow to search for and update 
subscriber records and perform web-based batch subscribe and 
unsubscribe actions.  Someone with support rights can not, however, 
create, modify or delete lists or templates.  Nor can they access your 
research information. 
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Monitor We like to call this the "boss" permission level.  It basically means 
anyone you want to have access to your live research data - but 
without giving them access to your lists, templates, subscriber records, 
etc.  They get to keep track of your campaigns without being 
dangerous. 

Visitor This is the lowest level of account-based access to the site.  It basically 
affords the user permission to view online help and access the 
customer care features. 

After you have entered in all the appropriate information, select the CREATE button.  As 
long as the “Send welcome e-mail” box is checked, your subscriber will receive an email 
within the next few minutes with all the information necessary for them to log into your 
realm. 
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13. Advanced Topics 

Using “Get” and “Smartget” to Pull External 
Content 

The template language has two special tags designed to help you pull external content 
into your template at List Test or Run time.  These tags will grab data from any URL you 
provide.  However, it does this only when the list is first tested or run, regardless of the 
number of messages being generated.  Put another way, these template tags do their 
work at the beginning of a publishing run.  They don’t impact the content on a per-
message basis. 

These special tags are “get” and “smartget” and they operate similarly.  The only 
difference between the two is that the “smart” version attempts to correct relative URLs 
it finds in the external content.  It works for relative URLs found in style sheet tags, 
image tags and backgrounds within tables.  Of course, it’s always recommended that the 
HTML content you use for your email campaigns contain only valid, absolute URLs. 

Syntax 

The syntax for both the “smartget” and “get” commands are as follows: 

%%get http://somehost.com%% 

%%smartget http://somehost.com%% 

The URL (http://somehost.com) should be a valid, publicly available page that could just 
as easily be pulled up and examined in your web browser.  The URL used with “get” or 
“smartget” can also be surrounded with quotes. 

Embedding Tags 

Sometimes it’s desirable to have variable data in the URL.  This could be the date or 
other variables you’ve set.  If you would like to include these variables in your URL, you 
can do so simply by surrounding the variable names with double hash marks (##).  
These are used when variables need to be expanded inside an existing tag, which uses 
double percent signs (%%) as delimiters. 

Here’s an example where the current month is used within a URL: 

%%smartget http://somehost.com?month=##$builtin.month##%% 
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Limitations 

These tags are useful for bringing in external content (plain-text, HTML, or other data), 
but there are limitations.  For one, they operate only at the beginning of a List Run, as 
noted earlier.  So, if you were hoping to pull in some external content for each message 
generated, these tags would not work for you.  For that type of application, you’ll want 
to explore the “cacheget” tag, which is explained in the next section. 

Both “Get” and “Smartget” can be nested.  In other words, the content that is retrieved 
using these commands can, themselves, contain additional tags to pull external content.  
Nesting can be performed up to eight (8) levels. 

Practical Uses 

If you were wondering about some of the practical uses of these tags, consider the 
following scenarios: 

• Embedding a common header or footer into every message 

• Embedding common opt-out content into every message 

• Embedding content, current news or information from an external Content 
Management System 

In fact, it’s the last example that is most often used.  Many clients use these tags to 
interface their Content Management Systems with the WhatCounts platform.  In many 
cases, the connection is completely automatic.  Templates point to content on the 
client’s system and calendar events automate publishing tasks.  Activate the Workflow 
mechanism within a List and you have a highly reliable and automated way of emailing 
users from content you control. 

Using “Cacheget” to Pull External Content 

For applications that require a higher degree of per-message dynamic personalization, 
“cacheget” may be the template tag for you.  Unlike the “get” and “smartget” tags, the 
“cacheget” tag was designed to pull its content for each message generated during a list 
run.  Of course, there is a catch, and that’s why the word cache is part of the command. 

The “cacheget” tag is designed for applications that require delivering a few unique 
pieces to many individuals.  Due to resource constraints, this isn’t a one-to-one 
mechanism.  In other words, it’s not possible to deliver messages using unique content 
pulled from an external source for each and every email.  But, for applications that 
require some personalization, on a broader basis, the “cacheget” command should work 
nicely. 
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Note: Broadcaster customers can pull unique content from 
external sources on a per-message basis if they like.  This 
functionality is restricted for ASP customers because of the 
enormous resource load it can place on the system(s). 

Syntax 

The format for this command is a little more complex than the simpler “get” commands, 
but the model is one you may be familiar with as it utilizes the same convention that’s 
applied to URLs – basically a “name=value” model. 

%%cacheget “commands”%% 

Where “commands” can be one or more of the following: 

Tag Description 

timeout This is the timeout value - in seconds - that should be 
applied to the URL.  When a particular entries “times 
out” the system will automatically refresh the cache by 
going out and obtaining a new copy of the content.  If it 
hasn’t timed out, then content is pulled from an in-
memory cache.  The default value is 300 seconds (5 
minutes). 

Example: timeout=300. 

fix_relative Modify the content so that relative URLs are updated 
with protocol and host information.  Relative URLs within 
stylesheet directives, image tags, anchor tags, and table 
cells will be corrected.  The number 1 is used to signify 
“yes” or “on”. 

Example: fix_relative=1 

wrap Wrap the content at the specified character length.  
Wrapping occurs on word boundaries.  This command is 
useful for paginating plain-text.  The effect on HTML is 
benign, so there’s no reason to use this command with 
HTML content.  The number 1 is used to signify “yes” or 
“on”. 

Example: wrap=1 

url Specify the URL to load.  Can include personalization 
elements using the double hash (##) convention (see 
examples below).  Example: url=http://www.yahoo.com. 
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Examples 
%%cacheget “timeout=300&url=http://www.yahoo.com”%% 

In this example, we’re setting the cache timeout to 5 minutes (300 seconds is 5 
minutes) and the URL (content) to http://www.yahoo.com.  

%%cacheget “wrap=65&url=http://yoursite.com/info.txt”%% 

In this example, we’re setting the URL to point to a document named “info.txt” on the 
website “yoursite.com” and then telling the command to wrap the content it obtains at 
approximately 65 characters per line.  This feature is most useful for plain-text.  You can 
set any value for line wrapping, but lines are broken (wrapped) only on word 
boundaries.  

%%cacheget “fix_relative=1&url=http://www.yahoo.com”%% 

In this example, we’re telling the command to fix any relative URLs within the content it 
pulls.  A relative URL is one that does not contain complete directory information (i.e. <a 
href= “../info.txt”>) and will not work within email.  So, fixing them by appending 
host names is important. 

%%cacheget “url=http://mysite.com/ads%3Fzip%3D##$zip##”%% 

In this example, we’re telling the command to pull content from the URL 
http://mysite.com via a program named “ads.”  We’re also passing in the zip code of the 
recipient so that the program can deliver personalized or targeted content. 

Note the presence of %3F in the URL.  This is actually how a question mark (?) is 
represented when specially coded so as not to interfere with other delimiters.  Also note 
that %3D is used in place of the equal (=) sign.  This encoding convention ensures that 
the characters inside the URL are not confused with other “name=value” pairs used by 
the tag. 

Practical Uses 

If you were wondering about some of the practical uses of the “cacheget” tag, consider 
these scenarios and examples: 

• Embedding advertising specific to a recipient’s zip code or state. 

• Embedding content, current news or information from an external Content 
Management System with personalization based upon demographic or geographic 
profile information associated with recipients. 

The advertising scenario is a good one because many newsletters representing 
commercial interests have some desire to embed advertising or marketing information.  
Targeted advertising is far more effective than advertising that’s not focused at a 
specific type of viewer or population. 
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Here’s how you might setup a template to pull targeted advertising information: 

• Create your regular email template 

• Determine how you’ll target your advertising.  Is it by demographic 
characteristics like gender, age, or income?  Perhaps it’s by geographic 
characteristics like zip code, state, or country?  Maybe you’re planning on using 
both? 

• Are your selection criteria exact enough to cover your audience without being too 
specific?  In other words – does your model fit into the few-to-many scenario 
best addressed by the “cacheget” feature?  For example, trying to deliver ads by 
passing the email address of the recipient to your ad server probably wouldn’t 
work.  It would represent a one-to-one model and would not be resource 
efficient. 

• Test your template by creating one or more users with differing selection settings 
associated with them (via custom fields) and then send test messages to them. 

The “cacheget” command can be used to pull any type of content – be it text, HTML, 
image tags – you name it.  As always, some experimentation and testing is 
recommended before you attempt a large deployment. 

Image-based Advertising 

If your advertising requirements call for delivering image-based ads with unique URLs, 
you don’t have to use the “get” family of commands to pull content.  You can simply 
embed personalization elements into your template that will be part of the generated 
content delivered to your users. 
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14. Appendix A –Tags and 
Elements 

To improve the effectiveness of your e-mail campaigns and to personalize your content, 
you can use special template tags.  These tags work in all template formats and forms.  
The following sections describe and define the different tags supported by WhatCounts.  

Subscriber Information Tags 

The following table describes tags that can be used to insert information from the 
subscriber record into your content: 

Tag Description 

%%$email%% Displays the subscriber’s e-mail address.  It is useful 
when used in conjunction with the %%UNSUB_HREF%% tag as 
in:  

<A HREF="%%UNSUB_HREF%%">Unsubscribe %%EMAIL%%</a> 

%%$first%% Displays the subscriber’s first name. 

%%$last%% Displays the subscriber’s last name. 

%%$company%% Displays the subscriber’s company. 

%%$address%%  OR  
%%$address_1%% 

Displays the first line of the subscriber’s street address. 

%%$address_2%% Displays the second line of the subscriber’s street 
address. 

%%$city%% Displays the subscriber’s city. 

%%$state%% Displays the subscriber’s state. 

%%$zip%% Displays the subscriber’s zip/postal code. 

%%$country%% Displays the subscriber’s country. 

%%$phone%% Displays the subscriber’s phone number. 

%%$fax%% Displays the subscriber’s fax number. 
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Custom Tags 

If you have defined custom fields, you can use them within your templates as tags.  
Custom Tags work in the same manner as the subscriber information tags to insert 
custom information from the subscriber record into your content.  To do this, you must 
encapsulate the name of the field within %%$ and %%.  For example, the proper format to 
use a custom field named customer_id within a template would be: %%$customer_id%%.   

The following table shows some examples of custom tags: 

Tag Description 

%%$customer_id%% Displays the subscriber’s custom information for 
the field customer_id. 

%%$age%% Displays the subscriber’s custom information for 
the field age. 

%%$gender%% Displays the subscriber’s custom information for 
the field gender. 

Subscriber Action Tags 

The following table describes template tags that can be used to insert information that 
can be used to carry out actions for a subscriber, such as unsubscribe from a list. 

Tag Description 

%%UNSUB_HREF%% Automatically places a specially encoded URL into your 
content when the list is run that allows readers to 
unsubscribe from a particular list.   

To use this in HTML, encapsulate the tag within <A HREF> 
as in:  

<A HREF="%%UNSUB_HREF%%">Unsubscribe</a>  

To use this in plain-text, enter:  

%%UNSUB_HREF%% 

WCIDV2: 
%%SUBSCRIBER_ID_TAG%% 

Identifies subscribers during bounce management.  If 
WhatCounts cannot rely upon the subscriber’s e-mail 
address for proper identification, this tag is used.   

To use this in HTML, enter the following:  

<!-- WCIDV2:%%SUBSCRIBER_ID_TAG%% -->  

To use this in plain-text, enter:  

WCIDV2:%%SUBSCRIBER_ID_TAG%%  



WhatCounts User Manual 

 - 137 - 

Copyright © 2005 WhatCounts, Inc..  his document contains proprietary information that constitutes trade secrets and is not to be shared, copied, 
disclosed, or otherwise compromised without the prior written consent of the management of WhatCounts, Inc. 

Built-in Tags  

Built-in tags are not specific to individual recipients but can be useful in automating 
certain tasks like entering dates.  The following table describes the built-in template 
supported by WhatCounts. 

Tag Description Result  

%%$builtin.date%% Displays the date and time. 07/01/03 
3:50 

%%$builtin.day%% Displays the day of the month. 1 

%%$builtin.day_padded%% Displays the day of the month in 
2-digit format. 

01 

%%$builtin.month%% Displays the month in numerical 
format. 

7 

%%$builtin.month_padded%% Displays the month in 2-digit 
numerical format. 

07 

%%$builtin.monthname%% Displays the name of the month 
in title case. 

July 

%%$builtin.monthname_uc%% Displays the name of the month 
in all uppercase. 

JULY 

%%$builtin.monthname_lc%% Displays the name of the month 
in all lowercase. 

july 

%%$builtin.monthname_short%% Displays the abbreviation of the 
month in title case. 

Jul 

%%$builtin.monthname_short_uc%% Displays the abbreviation of the 
month in all uppercase. 

JUL 

%%$builtin.monthname_short_lc%% Displays the abbreviation of the 
month in all lowercase. 

jul 

%%$builtin.year%% Displays the year in 4-digits. 2003 

%%$builtin.weekday%% Displays the day of the week in 
title case. 

Monday 

%%$builtin.weekday_uc%% Displays the day of the week in 
all uppercase. 

MONDAY 

%%$builtin.weekday_lc%% Displays the day of the week in 
all lowercase. 

monday 

%%$builtin.weekday_short%% Displays the abbreviation of the 
day of the week in title case. 

Mon 

%%$builtin.weekday_short_uc%% Displays the abbreviation of the 
day of the week in all uppercase. 

MON 

%%$builtin.weekday_short_lc%% Displays the abbreviation of the 
day of the week in all lowercase. 

mon 
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%%$builtin.juliandate%% Displays the numerical day of the 
year (1-366). 

188 

%%$builtin.hour%% Displays the current hour in 12 
hour increments (1-12). 

12 (hour) 

%%$builtin.hour_24%% Displays the current hour in 24 
hour increments (1-24). 

24 (hour) 

%%$builtin.minutes%% Displays the current minutes (00-
59). 

59 (min) 

%%$builtin.seconds%% Displays the current seconds (00-
59). 

59 (sec) 

%%$builtin.AMPM%% Displays the time of day, AM/PM. AM 

Evaluation Tags 

Evaluation tags allow you to modify information that is either defined in the subscriber 
record or in the template.  The following table describes how the evaluation tags work, 
and uses the following variables in the examples: first=Mary, n1 = 10, n2 = 20. 

Tag Description Result 

%%eval upper $first%% Displays the field all upper case. MARY 

%%eval lower $first%% Displays the field all lower case. mary 

%%eval proper $first%% Displays the field title case. Mary 

%%eval length $first%% Displays the number of 
characters in a field. 

4 

%%eval add $n1 $n2%% Adds the given values (n1 + n2) 
and displays the result. 

30 

%%eval sub $n2 $n1%% Subtracts the second given values 
from the first (n2 – n1) and 
displays the result. 

10 

%%eval min $n1 $n2%% Compares the values and displays 
the lowest of those given. 

10 

%%eval max $n1 $n2%% Compares the values and displays 
the greatest of those given. 

20 

%%eval mult $n1 $n2%% Multiplies the given values (n1 x 
n2) and displays the result. 

200 

%%eval div $n2 $n1%% Divides the given values (n2 / n1) 
and displays the result. 

2 

%%eval rand $n1 $n2%% Displays a random number 
chosen from the given values. 

14 
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Article Tags 

Article Tags allow you to include elements of an article in other content.  The following 
table describes tags that can be used to insert information from an article, such as the 
entire body or a title.  Article names are case sensitive, so be sure to enter them 
properly.   

Tags Description 

%%article "a_name"%% Displays the body of the Article, where a_name is the name 
of the Article. 

%%article "name= 
a_name&type=a_element"%% 

Displays the called out element of the article, where 
a_name is the name of the Article and a_element is the 
element to display. 

The following table defines the elements of an article for use with the article tags. 

Elements Description 

title Article title 

description Any descriptive information you may have associated with 
your article 

deck Similar to a subheading 

callout Article callout or summary 

body Body copy - the content itself 

author_name Author's name 

author_email Author's email address 

author_bio Author's bio 
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15. Appendix B – Example Forms 
and Templates 

The following sections provide examples of code for forms and templates used in the 
WhatCounts platform.  These examples will help you understand how your code should 
be formatted in order to display correctly in your web pages and email campaigns. 

Polls 

The Poll Tool uses one template to display the results of the Poll in a Landing Page.  You 
can also customize the Poll form and create an error landing page. 

Poll Form 

When the Poll form is generated using the Poll Wizard it will not contain customized 
formatting.  You can customize the format of the Poll once you have placed the 
generated code into your web page or email Template.  

Example Web Poll Form: 

An example Poll for the web may use the following code.  Notice the form method is 
"POST": 

<form action="http://whatcounts.com/bin/poll" method="POST"> 

<input type=hidden name="id" value="5"> 

  <table width=200 border=1> 

    <tr><td><P>Which Poll do you prefer?</td></tr> 

    <tr><td><P><input type=radio name="a" value="1">Web</td></tr> 

    <tr><td><P><input type=radio name="a" value="2">Email</td></tr> 

    <tr><td><P><input type=radio name="a" value="3">Neither</td></tr> 

    <tr><td align=center><input type=submit value="Enter"></td></tr> 

  </table> 

</form> 
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Example Email Poll Form: 

An example Poll for email may use the following code.  Notice the form method is "GET": 

<form action="http://whatcounts.com/bin/poll" method="GET"> 

<input type=hidden name="id" value="5"> 

  <table width=200 border=1> 

    <tr><td><P>Which Poll do you prefer?</td></tr> 

    <tr><td><P><input type=radio name="a" value="1">Web</td></tr> 

    <tr><td><P><input type=radio name="a" value="2">Email</td></tr> 

    <tr><td><P><input type=radio name="a" value="3">Neither</td></tr> 

    <tr><td align=center><input type=submit value="Enter"></td></tr> 

  </table> 

</form> 

Landing Page Results Template 

The Poll Landing Page uses the Results template to display the results of the poll in a bar 
chart.  A Results template supports the following tags: 

Tag Description 

%%$poll_name%% The name of the poll 

%%$poll_description%% The description/question asked by the poll 

%%$poll_totalresponses%% The total number of responses received by the poll 

%%$poll_id%% The id of the poll 

%%$results%% The chart containing poll results 

Example Code: 

An example Results template may use the following code: 

<html> 

<head> 

<title>%%$poll_name%%</title> 

</head> 

<body bgcolor=“#CCCCCC”> 

<table> 

<tr> 

<td>%%$poll_description%% 

<table border=“1”> 

<tr><td>%%$results%%</td></tr> 
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</table> 

Number of Responses: %%$poll_totalresponses%% 

</td> 

</tr> 

</table> 

</body> 

</html> 

Error Landing Page 

The Poll Error Page does not use a specific Template, but is available to display a 
message indicating that some type of error occurred after the Poll selection was 
submitted.  

Example Code: 

An example Poll Error Page may display a message using the following code:   

<p>An error has occurred with this Poll.  Please go <a 
href=“javascript:history.go(-1)”>back</a> and try again.</p> 
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Surveys 

The Survey Tool uses three templates to format the pages in a Survey: a start page 
template, a Question page template, and an end page template.   

Start Page Template 

The Start Page introduces the Survey.  A Start Page template supports the following 
tags: 

Tag Function 

%%SURVEY_NAME%% The name of the Survey. 

%%SURVEY_PROGRESS%% The progress bar indicating the current page and how 
much of the Survey remains. 

%%SURVEY_DESCRIPTION%% The description of the Survey. 

Note: This will only display if you select the Display 
Description checkbox on the Survey settings page. 

Example Code: 

An example Start Page template may use the following code: 

<html> 

  <head> 

    <title>My Survey Start Page</title> 

  </head> 

  <body> 

    <table> 

      <tr><td><td></tr> 

      <tr><td>%%SURVEY_PROGRESS%%</td></tr> 

      <tr><td>%%SURVEY_NAME%%</td></tr> 

      <tr><td>%%SURVEY_DESCRIPTION%%</td></tr> 

    </table> 

  </body> 

</html> 
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Question Page(s) Template 

The Question Page template is re-used for each Question page defined.  The Question 
Page template supports the following tags: 

Tag Function 

%%SURVEY_NAME%% The name of the Survey. 

%%SURVEY_PROGRESS%% The progress bar indicating the current page and how 
much of the Survey remains. 

%%QUESTIONS%% The Question or Questions and options defined for each. 

%%MESSAGE%% A conditional tag to display any error messages that 
may occur, such as when all required Questions have 
not been answered. 

%%PAGE_NUM%% The number of the current page. 

%%PAGES%% The number of pages in the Survey. 

If you create a custom template, you can also define the style settings for Questiontext 
and optiontext to control how Question and Option text are displayed on the form.   
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Example Code:  

An example Question Page template may use the following code: 

<html> 

<head> 

  <title>Survey: %%SURVEY_NAME%%</title> 

  <style> 

    .Questiontext {font-family: Verdana; font-size: 10px} 

    .optiontext {font-family: Verdana; font-size: 10px; color: #808080} 

  </style> 

</head> 

<body> 

  <table> 

    <tr><td>%%PAGE_NUM%% of %%PAGES%%</td></tr> 

    <tr><td>%%SURVEY_PROGRESS%%</td></tr> 

    <tr><td><h2>%%SURVEY_NAME%%</h2></td></tr> 

    <tr><td>%%MESSAGE%%</td></tr> 

    <tr><td> 

      <form method=post action="/bin/usurvey"> 

        <input type=hidden name="page_num" value=%%PAGE_NUM%%> 

        %%QUESTIONS%% 

        <p> 

        <input type="submit" name="cmd" value="Next"> 

      </form> 

    </td></tr> 

  </table> 

</body> 

</html> 
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End Page Template 

The End Page summarizes the results of the Survey and can include any closing 
messages.  The End Page template supports the following tags: 

Tag Function 

%%SURVEY_NAME%% The name of the Survey. 

%%SURVEY_PROGRESS%% The progress bar indicating the current page and 
how much of the Survey remains. 

%%QUESTIONS_ANSWERED%% The number of Questions answered. 

Note: This number may not be the same as the 
total number of Questions defined for the Survey if 
all Questions are not required to complete the 
Survey. 

%%QUESTIONS_ANSWERED_CORRECTLY%% The number of Questions answered correctly. 

Note: If a Question does not have a defined 
answer, then any answer is considered to be 
correct and is included as part of this number. 

Example Code:  

An example End Page template may use the following code: 

<html> 

  <head> 

    <title>My Survey End Page</title> 

  </head> 

  <body> 

    <table> 

      <tr><td>%%SURVEY_PROGRESS%%</td></tr> 

      <tr><td>%%SURVEY_NAME%%</td></tr> 

      <tr><td>Thank you for taking our Survey.<td></tr> 

      <tr><td>You answered %%QUESTIONS_ANSWERED%% Questions.</td></tr> 

      <tr><td>You have %%QUESTIONS_ANSWERED_CORRECTLY%% right.</td></tr> 

    </table> 

  </body> 

</html> 



WhatCounts User Manual 

 - 147 - 

Copyright © 2005 WhatCounts, Inc..  his document contains proprietary information that constitutes trade secrets and is not to be shared, copied, 
disclosed, or otherwise compromised without the prior written consent of the management of WhatCounts, Inc. 

Forward to a Friend (FTAF) 

The FTAF Tool allows customization of the FTAF submission form.  You can also 
customize the envelope in which the forwarded message is sent, as well as the landing 
pages. 

Custom Form 

The Custom Form contains information that allows the original recipient to include a 
message when forwarding the original content.  The Custom form requires at least the 
following hidden input fields: 

Field Name Required Value Function 

id %%SUBSCRIBER_ID_TAG%% The id of the original recipient. 

goto %%GOTO%% The landing page for the original recipient 
after the message is sent. 

 

The Custom form also supports the following fields: 

Field Name Function 

email or email_# The email address of the friend to receive the message, 
where # is a number from 1 to 32 when multiple email 
addresses are allowed. 

subject The subject of the forwarded message. 

message The id of the original recipient. 

Example Code for one Friend:  

An example FTAF Custom form may use the following code to forward to one email 
address.  Notice the form method is "POST": 

<form action="http://whatcounts.com/bin/ftaf" method="post">  

  <input type="hidden" name="cmd" value="send">  

  <input type="hidden" name="id" value="%%SUBSCRIBER_ID_TAG%%">  

  <input type="hidden" name="goto" value="%%GOTO%%"> 

  <table> 

    <tr> 

      <td>Subject:</td> 

      <td> 
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        <input type="text" name="subject" size="30"  

          value="A friend wanted you to see this"> 

      </td> 

    </tr> 

    <tr> 

      <td>Send to:</td> 

      <td><input type="text" name="email" size="30"></td> 

    </tr> 

    <tr> 

      <td valign="top">Message:</td> 

      <td><textarea name="message" cols="30" rows="4"></textarea></td> 

    </tr> 

    <tr> 

      <td colspan="2" align="right"> 

        <input type="submit" name="submit" value="Send"> 

      </td> 

    </tr> 

  </table> 

</form>  

Example Code for several Friends:  

An example FTAF Custom form may use the following code to forward to up to 32 email 
addresses.  Notice the form method is "POST": 

<form action="http://whatcounts.com/bin/ftaf" method="post">  

  <input type="hidden" name="cmd" value="send">  

  <input type="hidden" name="id" value="%%SUBSCRIBER_ID_TAG%%">  

  <input type="hidden" name="goto" value="%%GOTO%%"> 

  <input type="hidden" name="multi_extended" value="1"> 

  <table> 

    <tr><td colspan="4">Forward your message to a Friend</td></tr> 

    <tr> 

      <td align="right" width="80">Subject:</td> 

      <td width="220"><input type="text" name="subject" size="30" 

        value="A friend wanted you to see this"></td> 

      <td colspan="2">&nbsp;</td> 

    </tr> 

    <tr> 

      <td colspan="4">Send to:</td> 

    </tr> 
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    <tr> 

      <td align="right" width="80">Friend #1: </td> 

      <td width="220"><input type="text" name="email_1" size="30"></td> 

      <td align="right" width="80">Friend #2: </td> 

      <td width="220"><input type="text" name="email_2" size="30"></td> 

    </tr> 

    <tr> 

      <td align="right" width="80">Friend #X: </td> 

      <td width="220"><input type="text" name="email_x" size="30"></td> 

      <td align="right" width="80">Friend #32: </td> 

      <td width="220"><input type="text" name="email_32" size="30"></td> 

    </tr> 

    <tr> 

      <td valign="top" width="80">Message:</td> 

      <td colspan="3"> 

        <textarea name="message" cols="65" rows="4"></textarea> 

      </td> 

    </tr> 

    <tr> 

      <td colspan="4" align="right"> 

        <input type="submit" name="submit" value="Send"> 

      </td> 

    </tr> 

  </table> 

</form> 
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Envelope Page 

The Envelope page contains information that allows the original recipient to include a 
message when forwarding the original content.  The Envelope requires at least the 
following tags: 

Tag Function 

%%$message%% The message written by the recipient. 

%%BODY%% The body of the original message. 

Example Code:  

An example Envelope page may use the following code, including a Subscription form: 

<table> 

  <tr>  

    <td>%%$message%%</td>  

  </tr> 

  <tr>  

    <td> 

   <p>Enter your email address and Subscribe!</p> 

   <form action="http://www.whatcounts.com/bin/listctrl" 

   method="post"> 

     <input type=hidden name="slid" value="380001007412285174"> 

     <input type=hidden name="cmd" value="subscribe"> 

     <input type=hidden name="goto" value=""> 

     <p>E-Mail: <input type=text name=email size=25> 

        <input type=radio name=format value="plain">Plain-text 

        <input type=radio name=format value="html" CHECKED>HTML</p> 

     <input type=submit value="Subscribe"> 

   </form> 

    </td>  

  </tr> 

</table>  

%%BODY%%  



WhatCounts User Manual 

 - 151 - 

Copyright © 2005 WhatCounts, Inc..  his document contains proprietary information that constitutes trade secrets and is not to be shared, copied, 
disclosed, or otherwise compromised without the prior written consent of the management of WhatCounts, Inc. 

Landing Page 

The FTAF Landing Page does not use a specific Template, but is available to display 
confirmation that the message was forwarded.  

Example Code: 

An example FTAF Landing Page may display a message using the following code:   

<p>Thank You!  Your message had been forwarded to your friend!</p> 

Error Landing Page 

The FTAF Error Page does not use a specific Template, but is available to display a 
message indicating that some type of error occurred attempting to forward the message.  

Example Code: 

An example FTAF Error Page may display a message using the following code:   

<p>An error has occurred attempting to forward your message to a friend.  
Please go <a href=“javascript:history.go(-1)”>back</a> and try again.</p> 
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Blogs 

The Blog Tool uses one template to display the blog, entries, and comments.  However, the 
single template is broken into three separate pieces. 

Blog Page 

The Blog Page template is used to display the main blog components, such as the title, 
description, and links.  A Blog Page template supports the following tags: 

Tag Description 

%%$blog.title%%  -OR- 

%%$blog.name%% 

The title of the Blog. 

%%$blog.description%% The description of the Blog. 

%%$blog.entries%% The Blog entries, formatted according to the Entry 
template elements.  The number and ordering are 
defined in the blog properties. 

%%$blog.picture%%  -OR- 

%%$blog.image%% 

An image associated with the Blog in the blog 
properties. 

%%$blog.url%%  -OR- 

%%$blog.href%% 

The URL to link to the Blog. 

%%$blog.created%% The date the Blog was created, formatted according 
the time/date settings specified in the blog 
properties. 

%%$blog.id%% The Blog id, a unique number stored within the 
database. 

%%$blog.recent_entries%% A list of recent entries. 

%%$blog.calendar%% A calendar to select entries by date. 

%%$blog.rss_link%%  -OR- 

%%$blog.rss_href%% 

A link to access an RSS feed of the Blog. 

%%$blog.next_entry_link%% If a single entry is displayed, a link to navigate to 
the next entry, if it exists. 

%%$blog.next_entry_name%% If a single entry is displayed, the name of the next 
entry, if it exists. 

%%$blog.previous_entry_link%% If a single entry is displayed, a link to navigate to 
the previous entry, if it exists. 

%%$blog.previous_entry_name%% If a single entry is displayed, the name of the 
previous entry, if it exists. 
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%%$main_link%% The URL to link to the main Blog page. 

%%$blog.create_link%% A link to create a new entry, if permissions are met. 

%%$blog.create_wizard_link%% A link to create a new entry using the Post New 
Entry wizard, if permissions are met.  This is the 
preferred method if you have created entry 
definitions. 

Example Template Code: 

An example Blog Page template may use the following code, which is a copy of the Basic 
Orange used on the WhatCounts site.  It is presented with inline comments. 

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN"> 

<html> 

 

<!-- BEGIN HEADER --> 

<head> 

 

<!-- TITLE: Blog title is included using the %%$blog.title%% 
tag.  Though not required, it provides the web-based reader 
with the name of your blog in their browser’s title bar.--> 

  <title>%%$blog.title%%</title> 

 

<!-- RSS SUPPORT: The following link tags allow you to drag the 
blog URL directly into most newsreaders.  This is possible 
because the links use the %%$blog.url%% tag and append &cmd=rss 
to the URL.  This tells the blogging system to deliver RSS 2.0 
content in XML instead of HTML. --> 

  <link rel="alternate" type="application/rss+xml" title="RSS 1.0" 
href="%%$blog.url%%&cmd=rss" /> 

  <link rel="alternate" type="application/rss+xml" title="RSS 2.0" 
href="%%$blog.url%%&cmd=rss" /> 

 

<!-- CSS SUPPORT: The following is straight CSS, with specific 
tags for blogs, entries, calendar and comments. The calendar 
tags are special in that the blogging system will ALWAYS use 
these very specific names.  Most of the other element/class 
names can be changed, but blog_calendar, blog_calendar_day, 
etc. must be defined within your style sheet (internal or 
embedded) for calendars to display properly. --> 

  <style type="text/css" media="screen"> 

  <!-- 

  a, a.visited  

  { 

    color: #ff9900; 
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  } 

 

  .blog_title 

  { 

    background-color: #FF9418; 

    margin:0px; 

    padding-left:5px; 

    padding-top:10px; 

    padding-bottom: 2px; 

    font-family: Tahoma, Helvetica, sans-serif; 

    font-weight: bold; 

    font-size: 30pt; 

    color:#FFF; 

  } 

 

  .blog_description 

  { 

    background-color: #FF9418; 

    margin:0px; 

    padding-left:5px; 

    padding-bottom: 5px; 

    font-family: Tahoma, Helvetica, sans-serif; 

    font-weight: bold; 

    font-size: 15pt; 

    color:#FFF; 

  } 

 

  .entry_title 

  { 

    font-family: Tahoma, Helvetica, sans-serif; 

    padding-left: 5px; 

    padding-bottom: 2px; 

    font-weight: bold; 

    font-size: 15pt; 

    color: #000; 

  } 

 

  .entry_body 

  { 

    background-color: #FFFFFF; 



WhatCounts User Manual 

 - 155 - 

Copyright © 2005 WhatCounts, Inc..  his document contains proprietary information that constitutes trade secrets and is not to be shared, copied, 
disclosed, or otherwise compromised without the prior written consent of the management of WhatCounts, Inc. 

    margin:0px; 

    padding-left:5px; 

    font-family: Tahoma, Helvetica, sans-serif; 

    font-size: 10pt; 

    color:#333; 

    border-color: #DDDDDD; 

    border-width: 1px; 

    border-style: solid; 

  } 

 

  .entry_updated 

  { 

    margin:0px; 

    padding-left:5px; 

    padding-bottom: 5px; 

    font-family: Tahoma, Helvetica, sans-serif; 

    font-size: 8pt; 

    color:#333; 

  } 

 

  .blog_calendar 

  { 

    font-family: Tahoma, Helvetica, sans-serif; 

    font-size: 8pt; 

    color: #000; 

  } 

 

  .blog_calendar_day 

  { 

    font-family: Tahoma, Helvetica, sans-serif; 

    font-size: 8pt; 

    color: #000; 

  } 

 

  .blog_calendar_today 

  { 

    font-family: Tahoma, Helvetica, sans-serif; 

    font-size: 8pt; 

    color: #000; 

    border-style: dotted; 
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    border-width: thin; 

  } 

 

  .blog_calendar_selected_day 

  { 

    font-family: Tahoma, Helvetica, sans-serif; 

    font-size: 8pt; 

    color: #000; 

    font-style: bold; 

    border-width: thin; 

  } 

  --> 

  </style> 

</head> 

<!-- END HEADER --> 

 

<!-- BEGIN BODY --> 

<body bgcolor="FF9418" marginheight="0" marginwidth="0" leftmargin="0" 
topmargin="0" > 

 

<!-- BEGIN MAIN TABLE --> 

<center> 

<table width="90%" bgcolor="FFFFFF" cellpadding=0 cellspacing=0> 

  <tr> 

    <td> 

 

<!-- BLOG HEADING: Blog title (%%$blog.title%%) and description 
(%%$blog.description%%) are displayed using the tags and 
related CSS classes. --> 

      <div class="blog_title">%%$blog.title%%</div> 

      <div class="blog_description">%%$blog.description%%</div> 

    </td> 

  </tr> 

  <tr> 

    <td> 

      <center> 
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<!-- BLOG CONTENT: The Basic Orange template uses a table to 
display content with one column for entries and comments, and a 
second column for accessory items, such as links and the 
calendar. --> 

      <!-- BEGIN CONTENT TABLE --> 

      <table width=99%> 

        <tr> 

          <!-- BEGIN ENTRY COLUMN (LEFT) --> 

          <td valign=top align=left>%%$blog.entries%%</td> 

          <!-- END ENTRY COLUMN (LEFT) --> 

 

          <!-- BEGIN ACCESSORY COLUMN (RIGHT) --> 

          <td width=200 valign=top> 

            <center> 

 

<!-- BLOG IMAGE: You can include an image by setting the URL in 
your blog properties and then referencing it in the blog 
template using the tag %%$blog.picture%%.  You can reference 
other external images and media as well.  We use template logic 
below to wrap comment tags around the image tag in case an 
image has not been defined.  This allows the system to 
gracefully handle situations in which the image may or may not 
exist. --> 

            %%if blog.picture = "" then print "<!--"%%<img 
src="%%$blog.picture%%" border=0><BR>%%if blog.picture = "" then print "-
->"%% 

 

<!-- DISPLAY SINGLE ENTRY: If only a single entry is displayed, 
then a link will render to return to the front page.  This 
label will always read "Return". --> 

            <font face="Trebuchet MS,Verdana,Helvetica" color=333333 
size=2>   

            %%if blog.home_page != "" then printData blog.home_page%% 

            %%if blog.home_page != "" then print "<BR><BR>"%% 

 

            <B>Recent Entries</b> 

            <BR> 

 

<!-- DISPLAY RECENT ENTRIES: A list of all recent entries will 
be displayed here using the %%$blog.recent_entries%% tag.  The 
formatting will be defined by the CSS. --> 

            %%$blog.recent_entries%% 

            <BR> 
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<!-- CREATE NEW ENTRY: To enable a link to create a new entry, 
include the %%$blog.create_link%% tag.  It is secure and will 
automatically be empty if you are not logged in. --> 

            %%$blog.create_link%% 

            <P>&nbsp;</p> 

            <P>&nbsp;</p> 

 

<!-- CALENDAR: To display the calendar for the current or 
selected month, include the %%$blog.calendar%% tag.  The 
formatting will be defined by the CSS. --> 

            %%$blog.calendar%% 

            <P>&nbsp;</p> 

            <P>&nbsp;</p> 

 

<!-- RSS SUPPORT LINK: To include an explicit reference to the 
RSS feed, include the %%$blog.rss_href%% tag wrapped within an 
<a href></a> tag, as follows. --> 

            <a href="%%$blog.rss_href%%"> 

            <img src="/images/blogs/xml_button_26x10.gif" border=0></a> 

            </font> 

          </td> 

          <!-- END ACCESSORY COLUMN (RIGHT) --> 

           

        </tr> 

      </table> 

      <!-- END CONTENT TABLE --> 

 

      </center> 

    </td> 

  </tr> 

</table> 

</center> 

<!-- END MAIN TABLE --> 

</html> 
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Blog Entry 

The Blog Entry template is used to display each entry.  A Blog Entry template supports 
the following tags: 

Tag Description 

%%$entry.updated%% The date the Entry was created or last updated, 
formatted according the time/date settings specified in 
the blog properties. 

%%$entry.title%% The title of the Entry. 

%%$entry.body%% The content, or body, of the Entry. 

%%$entry.edit_link%% A link to edit an Entry, if permissions are met. 

%%$entry.edit_label%% A pre-defined Entry label. 

Example Template Code: 

An example Blog Entry template may use the following code, which is a copy of the 
Basic Orange used on the WhatCounts site.  It is presented with inline comments. 

<!-- BEGIN ENTRY TABLE --> 

<table width="100%" border="0" cellpadding="0" cellspacing="0"> 

  <tr bgcolor="#EEEEEE" valign="top"> 

    <td width="6"> 

<img alt="" src="/images/blogs/public/rounded_grey_corner_tl.gif"></td> 

 

    <td bgcolor="#EEEEEE"> 

<!-- ENTRY TITLE: The title of your entry appears here using 
the %%$entry.title%% tag. --> 

      <div class="entry_title">%%$entry.title%%</div> 

    </td> 

     

    <td width="6"> 

<img alt="" src="/images/blogs/public/rounded_grey_corner_tr.gif"></td> 

  </tr> 

 

  <tr bgcolor="#EEEEEE"> 

    <td width="6"></td> 

 



WhatCounts User Manual 

 - 160 - 

Copyright © 2005 WhatCounts, Inc..  his document contains proprietary information that constitutes trade secrets and is not to be shared, copied, 
disclosed, or otherwise compromised without the prior written consent of the management of WhatCounts, Inc. 

<!-- ENTRY INFO: The %%$entry.updated%% tag displays the 
submission date and time.  The %%$entry.permalink%% tag allows 
readers to link directly to the entry. --> 

    <td> 

      <div class="entry_updated">%%$entry.updated%% | 
%%$entry.author_name%% | %%$entry.permalink%% %%if entry.edit_link != "" 
then print "|"%% %%$entry.edit_link%%</div> 

    </td> 

     

    <td width="6"></td> 

  </tr> 

 

  <tr> 

    <td bgcolor="#EEEEEE" width="6"></td> 

 

<!-- ENTRY BODY: The content of the entry is displayed using 
the %%$entry.body%% tag.--> 

    <td> 

      <div class="entry_body">%%$entry.body%%</div> 

    </td> 

     

    <td width="6" bgcolor="#EEEEEE"></td> 

  </tr> 

 

  <tr bgcolor="#EEEEEE" valign="top"> 

    <td width="6"> 

<img alt="" src="/images/blogs/public/rounded_grey_corner_bl.gif"></td> 

    <td bgcolor="#EEEEEE"></td> 

    <td width="6"> 

<img alt="" src="/images/blogs/public/rounded_grey_corner_br.gif"></td> 

  </tr> 

</table> 

<!-- END ENTRY TABLE --> 

 

<P>&nbsp;</p> 
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Blog Comment 

The Blog Comment template is used to display each comment.  A Blog Comment 
template supports the following tags: 

Tag Description 

%%$comment.created%% The date the Comment was created or last updated, 
formatted according the time/date settings specified in 
the blog properties. 

%%$comment.title%% The title of the Comment, if one has been included. 

%%$comment.body%% The content, or body, of the Comment. 

%%$comment.edit_link%% A link to edit a Comment, if permissions are met. 

%%$comment.name%% The Comment author’s name. 

%%$comment.email%% The Comment author’s email address. 

%%$comment.ip%% The Comment author’s IP address. 

 


